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法律资讯 
警告提示系统 

为了您的人身安全以及避免财产损失，必须注意本手册中的提示。人身安全的提示用一个警告三角表示，仅与财产

损失有关的提示不带警告三角。警告提示根据危险等级由高到低如下表示。 

危险  
表示如果不采取相应的小心措施，将会导致死亡或者严重的人身伤害。 

警告  
表示如果不采取相应的小心措施，可能导致死亡或者严重的人身伤害。 

小心  
表示如果不采取相应的小心措施，可能导致轻微的人身伤害。 

注意  
表示如果不采取相应的小心措施，可能导致财产损失。 

当出现多个危险等级的情况下，每次总是使用最高等级的警告提示。如果在某个警告提示中带有警告可能导致人身

伤害的警告三角，则可能在该警告提示中另外还附带有可能导致财产损失的警告。 

合格的专业人员 
本文件所属的产品/系统只允许由符合各项工作要求的合格人员进行操作。其操作必须遵照各自附带的文件说明，特

别是其中的安全及警告提示。 由于具备相关培训及经验，合格人员可以察觉本产品/系统的风险，并避免可能的危

险。 

按规定使用 Siemens 产品 
请注意下列说明： 

警告  
Siemens 产品只允许用于目录和相关技术文件中规定的使用情况。如果要使用其他公司的产品和组件，必须得到 
Siemens 推荐和允许。正确的运输、储存、组装、装配、安装、调试、操作和维护是产品安全、正常运行的前

提。必须保证允许的环境条件。必须注意相关文件中的提示。 

商标 
所有带有标记符号 ® 的都是西门子股份有限公司的注册商标。本印刷品中的其他符号可能是一些其他商标。若第三

方出于自身目的使用这些商标，将侵害其所有者的权利。 

责任免除 
我们已对印刷品中所述内容与硬件和软件的一致性作过检查。然而不排除存在偏差的可能性，因此我们不保证印刷

品中所述内容与硬件和软件完全一致。印刷品中的数据都按规定经过检测，必要的修正值包含在下一版本中。 
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前言 

SINAMICS 文档  
SINAMICS 文档分为以下几个类别： 

● 通用文档/产品样本 

● 用户文档 

● 制造商/服务文档 

其它信息 
通过访问以下网址，您可以： 

● 订购文档/查看印刷品一览 

● 进入下载文档的链接 

● 在线使用文档（搜索手册或信息） 
http://www.siemens.com/motioncontrol/docu 

如果您对技术文档有疑问（例如：建议或修改），请发送一份电子邮件到下列地址： 
docu.motioncontrol@siemens.com 

我的文档管理器 
如何在西门子文档内容的基础上创建自定义文档，与自己的机床文档相匹配，请访问以下

链接： 
http://www.siemens.com/mdm 

培训 
通过以下链接可获取有关 SITRAIN 的信息 - 西门子为自动化产品、系统和解决方案制定

的培训： 
http://www.siemens.com/sitrain 

常见问题 
常见问题（FAQ）请点击产品支持，然后点击右侧的“支持”： 
http://support.automation.siemens.com 

SINAMICS 
SINAMICS 的相关信息请参见以下网址： 
http://www.siemens.com/sinamics 

http://www.siemens.com/motioncontrol/docu
mailto:motioncontrol@siemens.com
http://www.siemens.com/mdm
http://www.siemens.com/sitrain
http://support.automation.siemens.com
http://www.siemens.com/sinamics
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适用范围与其文档/工具（示例）  

表格 1 适用范围和可供使用的文档/工具 

适用范围 文档/工具 

定位 SINAMICS S 销售文档 

设计/配置 • 选型工具 SIZER 

• 电机选型手册 

决定/订购 SINAMICS S120 产品样本 

• SIMOTION、SINAMICS S120 及生产机械电机

（产品样本 PM 21） 

• SINAMICS 和用于单轴驱动的电机（产品样

本 D 31） 

• SINUMERIK & SINAMICS  
机床设备（产品样本 NC 61） 

• SINUMERIK 840D sl 1B 型 
机床设备（产品样本 NC 62） 

安装/装配 • SINAMICS S120 控制单元和扩展系统组件手册 

• SINAMICS S120 书本型功率单元手册 

• SINAMICS S120 装机装柜型功率单元手册 

• SINAMICS S120 AC 驱动手册 

• SINAMICS S120M 分布式驱动技术手册 

调试 • 调试工具 STARTER 

• SINAMICS S120 入门指南 

• SINAMICS S120 调试手册 

• SINAMICS S120 CANopen 调试手册 

• SINAMICS S120 功能手册 

• SINAMICS S120 Safety Integrated 功能手册 

• SINAMICS S120/S150 参数手册 

使用/操作 • SINAMICS S120 调试手册 

• SINAMICS S120/S150 参数手册 

维护/维修 • SINAMICS S120 调试手册 

• SINAMICS S120/S150 参数手册 

文档目录 • SINAMICS S120/S150 参数手册 
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目标使用人群 

本文档供使用 SINAMICS 驱动系统的机器制造商、调试人员和维修人员使用。 

优点 

本文档介绍了 SINAMICS S120 调试和维修的必要信息、步骤和操作。 

标准功能范畴 

本文档描述的功能范畴可能和实际提供的驱动系统的功能范畴有偏差。 

● 在驱动系统中可能会执行本文档中未提及的功能。 但这并不表示在交付系统时必须提

供这些功能以及相关的维修服务。 

● 本文档中也可能会描述驱动系统上不存在的功能。 提供的驱动系统的功能请参见订货

资料。 

● 机床制造商增添或者更改的功能，必须由机床制造商进行说明。 

同样，为使文档简明清晰，本文档并不包含所有产品类型的所有信息， 也不能考虑到订

货、销售和维护的每种实际情况。 

技术支持 

各个国家技术咨询的电话号码请访问下列网址，点击其中的联系方式： 

http://www.siemens.com/automation/service&support 

欧盟符合性声明 

欧盟 EMC 指令的符合性声明请访问网址： 

http://support.automation.siemens.com 

在网页中输入关键词 15257461 或联系您所在地区的西门子办事处。 

欧盟低压指令的符合性声明请访问网址： 

http://support.automation.siemens.com 

在网页中输入关键词 22383669 。 
 

 说明 
在符合运行条件的状态下以及在干燥的运行环境中，SINAMICS S 系列设备满足低压指令

2006/95/EC。 
 

http://www.siemens.com/automation/service&support
http://support.automation.siemens.com
http://support.automation.siemens.com
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 说明 
SINAMICS S 系列设备符合相关 EMC 欧盟符合性声明的要求并且遵守选型手册中的 
EMC 安装规程（订货号为 6FC5297-0AD30-0⃞P⃞），EMC 指令 2004/108/EC。 

 

 说明 
本调试手册描述的状态是设备的标准状态，保持此状态即可确保可靠运行，并且不超出 
EMC 限值。 
如不符合本调试手册的要求，应采用适当的措施，如通过测量来确定或验证设备可靠运行

并且不超出 EMC 限值。 
 

韩国的 EMC 限值 

 

在韩国，产品需要遵循的 EMC 限值相当于标准 EN 61800-3 针对转速可调电气驱动系统

的 C2 类 EMC 限值，也相当于 EN 55011 规定的组别 1 的 A 级限值。在采取适宜的附加

措施后，产品可以符合 C2 类或组别 1 的 A 级限值。为此需要采取附加措施，比如使用

附加的抗射频滤波器（EMC 滤波器）。 
其他一些确保正确 EMC 安装的措施在本手册或选型手册中的“ EMC 安装指南”一节中详

细说明。 
无论如何都要始终注意设备上贴附的标签，标签上的说明对符合标准至关重要。 

备件 

备件信息请访问以下网址： 
http://support.automation.siemens.com/WW/view/de/16612315 

检测证书 

SINAMICS 组件的 Safety Integrated 功能一般是由独立机构进行认证的。 您可从西门子

办事处获取最新的已认证组件的清单。目前尚未完成的认证请咨询西门子联系人。 

http://support.automation.siemens.com/WW/view/de/16612315
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符号含义 

 

符号 含义 

 

 

 

保护地(PE) 

 

 

 

接地（例如：M 24 V） 

 

 

 

功能地 
等电位连接 

表示方法 

本资料中使用以下的标识方法和缩写： 

故障和警告的表示方法（示例）： 

 

• F12345 故障 12345（英语：Fault） 

• A67890 报警 67890（英语：Alarm） 

参数的表示方法（示例）： 

 

• p0918 可调参数 918 

• r1024 显示参数 1024 

• p1070[1] 可调参数 1070，下标 1 

• p2098[1].3 可调参数 2098，下标 1，位 3 

• p0099[0...3] 可调参数 99，下标 0 到 3 

• r0945[2](3) 驱动对象 3 的显示参数 945，下标 2 

• p0795.4 可调参数 795，位 4 
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ESD 注意事项 

静电敏感元件（ESD）是可能会被静电场或静电放电损坏的单个元件、集成电路、模块或

设备。  
 

注意 

 
由电场或静电放电引起的损坏 
电场或静电放电可能会损坏单个元件、集成电路、模块或设备，从而导致功能故障。 

• 仅允许使用原始产品包装或其他合适的包装材料（例如：导电的泡沫橡胶或铝箔）包

装、存储、运输和发运电子元件、模块和设备。 

• 只有采取了以下接地措施之一，才允许接触元件、模块和设备： 
– 配带了防静电腕带 
– 在带有导电地板的防静电区域中穿着防静电鞋或配带防静电接地带 

• 电子元件、模块或设备只能放置在导电性的垫板上（带防静电垫板的工作台、导电的

防静电泡沫材料、防静电包装袋、防静电运输容器）。 
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安全注意事项 
 

危险  
接触带电部件会引发生命危险 
接触带电部件会导致死亡或重伤。 

• 只有专业人员才允许在电气设备上作业。 

• 在所有作业中必须遵守本国的安全规定。 
通常有六项安全步骤：  
1. 做好断电的准备工作，通知各环节相关人员。 
2. 关闭设备。 

– 断开设备电源。 
– 请等待至警告牌上说明的放电时间届满。 
– 确认导线与导线之间和导线与接地线之间无电压。 
– 确认辅助电压回路已断电。 
– 确认电机无法运动。 

3. 识别所有其他危险的能量源，例如：压缩空气、液压或者水。 
4. 隔绝或者中和所有危险的能量源，例如，通过闭合开关，接地或短接，或者关闭阀

门。 
5. 确保不会再次接通这些能量源。 
6. 确保设备已经完全闭锁并选择了正确的设备！ 
结束作业后以相反的顺序恢复设备的就绪状态。 
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危险  
电击危险，危险的轴运动 

• 只有在确认了装有本文档所述设备的机器符合欧盟机械指令后，才允许开始启动调

试。 

• 只有具有相应资格的人员才允许对 SINAMICS 设备和三相交流电机进行调试。 

• 该人员必须参考产品的用户技术资料，了解并遵守其中的危险和警告说明。 

• 在电气设备和电机运行时，电气电路中总是存在危险的电压。 

• 设备运行时，轴运动也可能会带来危险。 

• 因此必须在电气设备断电状态下开展所有工作。 

• 只有根据 IEC 61800-5-1 的规定测试了 SINAMICS 设备和 FI 保护装置的兼容性后，

才允许将带有三相交流电机的 SINAMICS 设备通过选择性通断、全电流敏感的故障

电流保护装置连接到供电网络。 
 

警告  
设备操作不规范 

• 正确的运输，专业的存放、安装和装配，以及谨慎的操作与维护，是本设备和电机能

够正常安全运行的前提条件。 

• 对于一些特殊规格型号的设备和电机，还应参考样本和供货说明。 

• 此外，除了随附的用户技术文献中的危险和警告提示，还必须遵守各个国家、地区以

及设备特定的规定和要求。 

• 在 0 V 到 48 V 的所有接口和端子上，只允许按照 EN60204-1 的规定使用安全低压

（PELV = Protective Extra Low Voltage：保护性特殊低压）进行连接。 

• 电机表面温度可能超过 +100 ℃ 。 

• 因此，那些对温度敏感的部件，例如电缆和电气元件不允许紧靠电机或者固定在电机

上。 

• 装配时应注意连接电缆 
– 不能损坏 
– 不能处于受拉状态并且 
– 不能被转动部件缠住。 
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警告  
未设置安全功能时会发生危险的轴运动 
在使用书本型、紧凑书本型、装机装柜型和机柜型电机模块上的脉冲封锁端子以及使用

装机装柜型和模块型功率模块上的的脉冲封锁端子时，必须对安全功能 Safe Torque Off
（STO）进行参数设置（Safety Integrated 基本功能或扩展功能）。 
具体步骤在两本功能手册中均已说明（SINAMICS S120 驱动功能手册和 SINAMICS 
S120 Safety Integrated 功能手册）。 

 

注意 
 

不按照规定进行电压例行测试会导致财产损失 

• 带三相交流电机的 SINAMICS 设备已经根据 IEC 61800-5-1 进行了电压例行测试。 
在照 EN 60204-1 第 18.4 章的规定进行工业机械上的电气设备耐压试验时，必须拆

下或拔出 SINAMICS 设备的所有连接，避免设备受损。 

• 按照随附的电路图连接电机。 如不遵守规定，会导致电机损毁。 
 

 说明 
低压指令 
在符合运行条件的状态下以及在干燥的运行环境中，带有三相交流电机的 SINAMICS 设
备满足低压指令 2006/95/EC。 

 

 



前言  
  

 调试手册 
12 开机调试手册, (IH1), 01/2013, 6SL3097-4AF00-0RP3 



 

调试手册 
开机调试手册, (IH1), 01/2013, 6SL3097-4AF00-0RP3 13 

目录 

 

 前言 ..................................................................................................................................................3 

1 调试准备 .........................................................................................................................................17 

1.1 调试的前提条件 .................................................................................................................. 18 

1.2 SINAMICS S 调试的检查表 ................................................................................................ 19 

1.3 PROFIBUS 组件................................................................................................................. 23 

1.4 PROFINET 组件 ................................................................................................................. 24 

1.5 DRIVE-CLiQ 布线规则........................................................................................................ 25 
1.5.1 DRIVE-CLiQ 诊断............................................................................................................... 25 
1.5.2 DRIVE-CLiQ 布线的强制规定 ............................................................................................. 26 
1.5.3 DRIVE-CLiQ 布线建议........................................................................................................ 32 
1.5.4 有关可控制的驱动数量的说明............................................................................................. 35 
1.5.4.1 系统采样时间和可控制驱动数量 ......................................................................................... 35 
1.5.4.2 DRIVE-CLiQ 的优化 ........................................................................................................... 39 
1.5.4.3 采样时间的缺省设置 ........................................................................................................... 40 
1.5.5 在调试工具 STARTER 中修改离线拓扑.............................................................................. 42 
1.5.6 模块化的设备方案： 离线修改设定拓扑结构 ...................................................................... 43 
1.5.7 拓扑示例：采用矢量控制的驱动 ......................................................................................... 46 
1.5.8 拓扑示例：采用矢量控制的并联电机模块 ........................................................................... 48 
1.5.9 拓扑示例：采用 V/f 控制（矢量控制）的驱动 .................................................................... 49 
1.5.10 拓扑示例：采用伺服控制的驱动 ......................................................................................... 50 
1.5.11 拓扑示例：功率模块 ........................................................................................................... 51 

1.6 接通/关闭驱动系统.............................................................................................................. 53 

2 调试 ................................................................................................................................................57 

2.1 调试过程 ............................................................................................................................. 57 

2.2 调试工具 STARTER ........................................................................................................... 59 
2.2.1 STARTER 概述 .................................................................................................................. 59 
2.2.1.1 调用 STARTER .................................................................................................................. 59 
2.2.1.2 操作界面说明...................................................................................................................... 60 
2.2.2 调试工具 STARTER 中的重要功能..................................................................................... 61 
2.2.3 激活在线操作： 通过 PROFIBUS 操作 STARTER............................................................. 67 
2.2.4 激活在线操作：STARTER 接入以太网............................................................................... 68 
2.2.5 激活在线操作： 通过 PROFINET IO 操作 STARTER ........................................................ 74 

2.3 在调试工具 STARTER 中创建项目..................................................................................... 81 
2.3.1 离线创建项目...................................................................................................................... 81 
2.3.2 在线创建项目...................................................................................................................... 85 



目录  
  

 调试手册 
14 开机调试手册, (IH1), 01/2013, 6SL3097-4AF00-0RP3 

2.4 书本型伺服控制的首次调试 .................................................................................................89 
2.4.1 任务.....................................................................................................................................89 
2.4.2 组件布线（示例） ...............................................................................................................91 
2.4.3 调试示例中的信号流............................................................................................................92 
2.4.4 使用 STARTER 进行调试（示例）......................................................................................93 

2.5 书本型矢量 V/f 控制首次调试 ..............................................................................................99 
2.5.1 任务.....................................................................................................................................99 
2.5.2 组件布线（示例） .............................................................................................................100 
2.5.3 调试示例中的信号流..........................................................................................................101 
2.5.4 使用 STARTER 进行调试（示例）....................................................................................102 

2.6 装机装柜型矢量控制首次调试............................................................................................110 
2.6.1 任务...................................................................................................................................110 
2.6.2 组件布线（示例） .............................................................................................................112 
2.6.3 调试示例中的信号流..........................................................................................................113 
2.6.4 使用 STARTER 进行调试（示例）....................................................................................114 

2.7 模块型矢量交流驱动设备的首次调试.................................................................................123 
2.7.1 任务...................................................................................................................................123 
2.7.2 组件布线（示例） .............................................................................................................124 
2.7.3 使用 BOP 进行快速调试（示例）......................................................................................124 

2.8 模块型伺服交流驱动设备的首次调试.................................................................................129 
2.8.1 任务...................................................................................................................................129 
2.8.2 组件布线（示例） .............................................................................................................130 
2.8.3 使用 BOP 进行快速调试（示例）......................................................................................131 

2.9 并联功率部件的调试..........................................................................................................134 

2.10 设备学习............................................................................................................................140 

2.11 编码器的选择和配置..........................................................................................................142 

2.12 直线电机开机调试的提示...................................................................................................152 
2.12.1 直线电机调试的概述..........................................................................................................152 
2.12.2 调试： 带有初级部件的直线电机 .......................................................................................155 
2.12.3 调试： 带有多个相同初级部件的直线电机.........................................................................159 
2.12.4 电机热保护 ........................................................................................................................160 
2.12.5 测量系统............................................................................................................................163 
2.12.6 直线电机的测量检查..........................................................................................................166 

2.13 调试内装式转矩电机 SIMOTICS 类型 1FW6.....................................................................169 
2.13.1 调试的安全提示 .................................................................................................................169 
2.13.2 调试检查表 ........................................................................................................................172 
2.13.3 换向设置的一般提示..........................................................................................................175 
2.13.4 设置电机和编码器的参数...................................................................................................176 
2.13.5 设置温度传感器和检查温度传感器 ....................................................................................191 
2.13.6 确定换向角偏移 .................................................................................................................196 



 目录 
  

调试手册 
开机调试手册, (IH1), 01/2013, 6SL3097-4AF00-0RP3 15 

2.13.6.1 检查换向角偏移 ................................................................................................................ 197 
2.13.6.2 使用测量仪器检查换向角偏移........................................................................................... 198 
2.13.7 特殊情况-并联 .................................................................................................................. 209 
2.13.8 优化控制 ........................................................................................................................... 210 

2.14 SSI 编码器的调试说明...................................................................................................... 211 

2.15 作为绝对值编码器的 2 极旋转变压器的调试说明.............................................................. 215 

2.16 SINAMICS 组件的温度传感器 .......................................................................................... 216 

2.17 基本操作面板 20(BOP20)................................................................................................. 227 
2.17.1 使用 BOP20 (Basic Operator Panel 20)进行操作 ............................................................. 227 
2.17.1.1 BOP20 概述 ..................................................................................................................... 227 
2.17.1.2 BOP20 的显示和操作 ....................................................................................................... 231 
2.17.1.3 故障和报警的显示............................................................................................................. 236 
2.17.1.4 通过 BOP20 控制驱动 ...................................................................................................... 237 
2.17.2 BOP20 的重要功能........................................................................................................... 238 

3 诊断 ..............................................................................................................................................241 

3.1 通过 LED 进行的诊断 ....................................................................................................... 242 
3.1.1 控制单元 ........................................................................................................................... 242 
3.1.1.1 CU320-2 的 LED 状态说明 ............................................................................................... 242 
3.1.1.2 CU310-2 的 LED 状态说明 ............................................................................................... 249 
3.1.2 功率单元 ........................................................................................................................... 255 
3.1.2.1 调节型电源模块（书本型） .............................................................................................. 255 
3.1.2.2 基本型电源模块（书本型） .............................................................................................. 256 
3.1.2.3 书本型 SLM 5 kW 和 10 kW ............................................................................................. 257 
3.1.2.4 书本型 SLM 16 kW ~ 55 kW............................................................................................. 258 
3.1.2.5 单电机模块/双电机模块/功率模块 ..................................................................................... 259 
3.1.2.6 书本型制动模块 ................................................................................................................ 260 
3.1.2.7 紧凑书本型非调节电源模块 .............................................................................................. 261 
3.1.2.8 紧凑书本型电机模块 ......................................................................................................... 262 
3.1.2.9 装机装柜型 ALM中的控制接口模块 .................................................................................. 263 
3.1.2.10 装机装柜型 BLM 中的控制接口模块 ................................................................................. 264 
3.1.2.11 装机装柜型 SLM 中的控制接口模块 ................................................................................. 265 
3.1.2.12 装机装柜型电机模块中的控制接口模块 ............................................................................ 267 
3.1.2.13 装机装柜型功率模块中的控制接口模块 ............................................................................ 268 
3.1.3 附加模块 ........................................................................................................................... 270 
3.1.3.1 24 V 电源模块 .................................................................................................................. 270 
3.1.3.2 机柜安装式编码器模块 SMC10 / SMC20.......................................................................... 270 
3.1.3.3 机柜安装式编码器模块 SMC30 ........................................................................................ 271 
3.1.3.4 机柜式编码器模块 SMC40................................................................................................ 272 
3.1.3.5 CANopen 通讯板 CBC10 ................................................................................................. 272 
3.1.3.6 以太网通讯板 CBE20 ....................................................................................................... 273 
3.1.3.7 电压传感模块 VSM10....................................................................................................... 275 
3.1.3.8 DRIVE-CLiQ 集线器模块 DMC20..................................................................................... 276 



目录  
  

 调试手册 
16 开机调试手册, (IH1), 01/2013, 6SL3097-4AF00-0RP3 

3.1.4 端子模块............................................................................................................................277 
3.1.4.1 端子模块 TM15..................................................................................................................277 
3.1.4.2 端子模块 TM31..................................................................................................................278 
3.1.4.3 端子模块 TM120................................................................................................................278 
3.1.4.4 端子模块 TM150................................................................................................................279 
3.1.4.5 端子模块 TM41..................................................................................................................280 
3.1.4.6 端子模块 TM54F 自 FW2.5 SP1 起 ...................................................................................281 

3.2 通过 STARTER 进行的诊断 ..............................................................................................283 
3.2.1 函数发生器 ........................................................................................................................283 
3.2.2 跟踪(Trace)功能 ................................................................................................................287 
3.2.2.1 单次跟踪............................................................................................................................287 
3.2.2.2 多次跟踪............................................................................................................................290 
3.2.2.3 StartUp 跟踪......................................................................................................................291 
3.2.2.4 重要报警和参数一览..........................................................................................................292 
3.2.3 测量功能............................................................................................................................293 
3.2.4 测量插口............................................................................................................................295 

3.3 诊断缓冲器 ........................................................................................................................300 

3.4 未调试轴的诊断 .................................................................................................................303 

3.5 故障和报警信息 .................................................................................................................306 
3.5.1 故障和报警概述 .................................................................................................................306 
3.5.2 故障和报警缓冲器 .............................................................................................................308 
3.5.3 报告信息的配置 .................................................................................................................312 
3.5.4 功能图与重要参数一览 ......................................................................................................315 
3.5.5 故障信息的广播 .................................................................................................................316 
3.5.6 警告级 ...............................................................................................................................317 

3.6 编码器故障处理 .................................................................................................................319 

A 附录 .............................................................................................................................................. 323 

A.1 硬件组件的可用性 .............................................................................................................323 

A.2 可用的软件功能 .................................................................................................................327 

A.3 缩略语目录 ........................................................................................................................331 

 索引 .............................................................................................................................................. 341 



 

调试手册 
开机调试手册, (IH1), 01/2013, 6SL3097-4AF00-0RP3 17 

调试准备 1
 

调试开始之前，应注意以下前提条件： 

● 必须满足调试的前提条件（在下一章节中说明）。 

● 填写相关的检查表。 

● 完成通讯所需组件的布线工作。 

● 必须遵守 DRIVE-CLiQ 布线规定。 

● 驱动器作出 ON/OFF 响应。 
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1.1 调试的前提条件 
进行 SINAMICS S 驱动系统的调试必须具备： 

● 编程器 (PG/PC) 

● 调试工具 STARTER 

● 一个通讯接口（例如：PROFIBUS、PROFINET、Ethernet） 

● 完成接线的驱动系统（参见 SINAMICS S120 设备手册） 

下图是书本型和装机装柜型组件的结构简图，分别采用 PROFIBUS 通讯和 PROFINET 
通讯。 

 

图 1-1 组件结构（示例）  
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1.2 SINAMICS S 调试的检查表 

书本型功率单元调试的检查表 (1) 

必须遵照下面的检查表。 在开始工作之前，请阅读设备手册中的安全提示。  

表格 1- 1 书本型调试的检查表  

检查 是 

环境条件在允许的范围内吗？   

组件是否按规定安装在了设计好的固定点上？  

是否能提供设备冷却要求的规定风量？  

是否满足了组件的通风空间？  

存储卡是否正确插入了控制单元中？  

配置的驱动系统中的所有必要组件是否都存在，并已安装和连接？  

温度监控回路是否符合安全电气隔离的规定？  

是否符合 DRIVE-CLiQ 拓扑规则？  

电网侧和电机侧的电源电缆的尺寸规格和敷设是否符合环境和敷设条件？  

变频器与电机之间的电缆长度是否遵循了允许的最大长度（根据所使用的

电缆）？ 
 

电源电缆是否按规定的扭矩正确地连接到了组件端子上？   

所有其它的螺钉是否都按规定的扭矩拧紧了？  

是否所有的布线工作都已完成？  

所有的插头是否都已正确地插入或拧紧？  

直流母线的所有保护罩是否都已盖上并插好？  

屏蔽层是否正确并大面积地连接？  
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装机装柜型功率单元调试的检查表 (2) 

必须遵照下面的检查表。在开始工作之前，请阅读设备手册中的安全提示。  

表格 1- 2 装机装柜型调试的检查表  

操作 是 

环境条件在允许的范围内吗？  

组件是否按规定安装在机柜中？  

是否能提供设备冷却要求的规定风量？  

是否通过安装措施，避免了装机装柜型组件上进风口和排风口之间的气流

短路？ 
 

是否满足了组件的通风空间？  

存储卡是否正确插入了控制单元中？  

配置的驱动系统中的所有必要组件是否都存在，并已安装和连接？  

温度监控回路是否符合安全电气隔离的规定？   

是否符合 DRIVE-CLiQ 拓扑规则？  

电网侧和电机侧的电源电缆的尺寸规格和敷设是否符合环境和敷设条件？  

变频器与电机之间的电缆长度是否遵循了允许的最大长度（根据所使用的

电缆）？ 
 

电机的接地是否直接与电机模块的接地相连（短距离相连）？  

电机是否连接了屏蔽型电源电缆？  

电源电缆的屏蔽层是否最大可能地接近端子盒进行了大面积的连接？  

电源电缆是否按规定的扭矩正确地连接到了组件端子上？  

所有其它的螺钉是否都按规定的扭矩拧紧了？  

所确定的直流母线总功率是否足够？  

电源模块与电机模块之间直流母线的连接/布线是否根据负载和安装条件进

行了足够的设计？ 
 

低压配电设备与功率单元之间的电缆是否使用电源熔断器进行了保护？ 必
须考虑电缆保护(1)。  
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操作 是 

是否确保减轻了电缆张力？  

使用外部辅助电源时： 是否根据设备手册进行了辅助电源电缆的连接？  

控制电缆是否根据相应的接口配置进行了连接并按屏蔽层进行了铺装？  

数字信号和模拟信号是否通过相互独立的电缆连接？   

是否遵循了电源电缆之间的间距？  

机柜是否按规定在设计好的位置上进行了接地？  

装机装柜型组件中风扇的输入电压是否与现场的电网电压进行了匹配？  

在未接地电网中运行时： 是否拆除了电源模块或功率模块上的抗干扰连接

片? 
 

距首次调试的时间或功率组件的停工期是否短于 2 年(2)？  

是否由上一级控制系统 / 控制室对驱动进行控制？  

 

(1) 建议使用组合式熔断器对导体和半导体进行保护（VDE 636，第 10 部分和第 40 部分 / 
EN 60269-4）。 相应的熔断器见产品样本。 

(2) 如果停工期超过 2 年，则必须对直流母线电容器进行再充电（参见设备手册的“维护与

检修”一章）。 生产日期见铭牌。  
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模块型功率模块调试的检查表(3) 

必须遵照下面的检查表。在开始工作之前，请阅读设备手册中的安全提示。  

表格 1- 3 模块型调试的检查表  

检查 是 

环境条件在允许的范围内吗？  

组件是否按规定安装在了设计好的固定点上？  

是否能提供设备冷却要求的规定风量？  

是否满足了组件的通风空间？  

存储卡是否正确插入了控制单元中？  

配置的驱动系统中的所有必要组件是否都存在，并已安装和连接？  

温度监控回路是否符合安全电气隔离的规定？  

电网侧和电机侧的电源电缆的尺寸规格和敷设是否符合环境和敷设条件？  

变频器与电机之间的电缆长度是否遵循了允许的最大长度（根据所使用的

电缆）？ 
 

电源电缆是否按规定的扭矩正确地连接到了组件端子上？  

所有其它的螺钉是否都按规定的扭矩拧紧了？  

是否所有的布线工作都已完成？  

所有的插头是否都已正确地插入或拧紧？  

屏蔽层是否正确并大面积地连接？  
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1.3 PROFIBUS 组件 
PROFIBUS 通讯所需的必要组件。  

● 一个具有 PROFIBUS 接口的通讯模块，用于连接 PG/PC。 

– PROFIBUS 接口可转接到 PG/PC 上的 USB 接口（USB V2.0）。 
结构： USB 接口(USB V2.0) + 适配器，带 9 芯 SUB-D 母插，可接到 PROFIBUS 
接口上。  
和软件 SIMATIC Net PC Software Edition 2008 + SP2 一起使用 
订货号：6GK1571-1AA00 

连接电缆 

PROFIBUS 适配器和 PG/PC 之间的连接电缆有： 

● CP 5xxx 电缆，订货号： 6ES7901-4BD00-0XA0 

● MPI 电缆（SIMATIC S7），订货号： 6ES7901-0BF00-0AA0 

电缆长度 

表格 1- 4 允许的 PROFIBUS 电缆的最大长度 

波特率 [bit/s] 最大电缆长度 [m] 

9.6 k 至 187.5 k 1000 

500 k 400 

1.5 M 200 

3 至 12 M 100 
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1.4 PROFINET 组件 
PROFINET 通讯所需的必要组件： 

● 一个具有 PROFINET 接口的通讯模块，用于连接 PG/PC。 

  说明 
调试时可用的电缆 
在使用调试工具 STARTER 调试设备时，可以在控制单元的板载以太网接口上连接 
CAT5 起的交叉电缆。  
PROFINET 模块 CBE20 支持所有的标准以太网电缆和 CAT5/5e 起的交叉电缆。  

● 连接电缆  
PROFINET 适配器和 PG/PC 之间的连接电缆，例如： 

– 工业以太网 FC TP 标准电缆 GP 2 x 2（最长 100 m） 

刚性芯线型标准总线电缆以及快速安装专用结构 

订货号： 6XV1840-2AH10 

– 工业以太网 FC TP 柔性电缆 GP 2 x 2（最长 85 m） 

订货号：6XV1870-2B 

– 工业以太网 FC 拖拽电缆 GP 2 x 2（最长 85 m） 

订货号： 6XV1870-2D 

– 工业以太网 FC 跟踪电缆 2 x 2（最长 85 m） 

订货号： 6XV1840-3AH10 

– 工业以太网 FC 船用电缆 2 x 2（最长 85 m） 

订货号： 6XV1840-4AH10 

● 连接器 
PROFINET 适配器和 PG/PC 之间的连接器，例如： 

– 工业以太网 FC RJ45 连接器 145，用于控制单元 

订货号： 6GK1901-1BB30-0Ax0 
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1.5 DRIVE-CLiQ 布线规则 
进行 DRIVE-CLiQ 组件的布线时须遵循特定规则。 其中可区分为强制遵循 DRIVE-CLiQ 
规则和建议遵循规则，这样便不必再对调试工具 STARTER 中离线创建的拓扑结构进行

修改。  

DRIVE-CLiQ 组件的最大数量以及布线方式取决于以下系数： 

● 强制性 DRIVE-CLiQ 拓扑规则 

● 所激活驱动的数量和类型以及相应控制单元的功能 

● 相应控制单元的计算效率 

● 所设置的处理周期和通讯周期 

下面将介绍约束性布线规则和一些附加的推荐规则，并介绍了几个 DRIVE-CLiQ 布线的

拓扑示例。 

这些示例中的组件可以被移除、替换或添加。 如果组件被替换为其它类型的组件或者添

加了额外的组件，则应使用选型工具 SIZER 来检查该拓扑。 

如果实际的拓扑与在调试工具 STARTER 离线模式下创建的拓扑不一致，则应在下载前

对离线拓扑进行调整。  

1.5.1 DRIVE-CLiQ 诊断 

DRIVE-CLiQ 诊断 

通过 DRIVE-CLiQ 诊断可检查 DRIVE-CLiQ 的接口和电缆。 发生传输故障时，可分析其

中 PHY 模块中的故障计数器来确定发生故障的连接部件的位置。 

不仅可以看到故障计数器的整体情况，还可以进行单个连接的详细诊断。 针对所选的连

接，可以设置采集故障数量的间隔时间，并且通过参数进行跟踪。如果连接错误的话，则

可以通过记录传输故障的出现情况并且和驱动的其他事件联系起来。 
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重要参数一览 

 

• r9936[0...199] DRIVE-CLiQ 诊断：计数器连接 

• p9937 DRIVE-CLiQ 诊断：配置 

• p9938 DRIVE-CLiQ 详细诊断：配置 

• p9939 DRIVE-CLiQ 详细诊断：时间间隔 

• p9942 DRIVE-CLiQ 详细诊断：单个连接选择 

• r9943 DRIVE-CLiQ 详细诊断：单个连接故障计数器 

有关 DRIVE-CLiQ 诊断参数的详细信息参见 SINAMICS S120/S150 参数手册。  

1.5.2 DRIVE-CLiQ 布线的强制规定 

下列的布线规定针对的是标准周期（伺服 125 µs，矢量 250 µs）。 如果比该标准周期

短，控制单元的计算性能会产生其它限制（使用选型工具 SIZER 进行选型配置）。 
 

 说明 
每个双轴电机模块、DMC20、DME20、TM54F 和 CUA32 都相当于两个 DRIVE-CLiQ 
节点。 只配置了一个驱动的双轴电机模块也是如此。 

 

以下通用 DRIVE-CLiQ 布线规定是强制规定，以确保驱动的安全功能。 

● 控制单元的一条 DRIVE-CLiQ 支路上禁止连接超过 14 个 DRIVE-CLiQ 节点（例如 12 
个 V/f 轴 + 1 个电源模块 + 1 个附加模块）。 在下面的布线示例图中，DRIVE-CLiQ 
支路包含了驱动对象（Drive Objects）1 到 14。 

● 一个控制单元上禁止连接超过 8 个电机模块。 多轴电机模块上，一根轴相当于一个模

块（1 个双轴电机模块 = 2 个电机模块）。 特例： 采用 V/f 控制时最多允许连接 12 
个电机模块。 

● 在矢量 V/f 控制中，控制单元的一条 DRIVE-CLiQ 支路上禁止连接超过 4 个节点。 

● 组件禁止环形布线。 
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● 组件禁止重复布线。 

 
图 1-2 示例： 控制单元 DRIVE-CLiQ 接口 X103 上的 DRIVE-CLiQ 支路  

● 拓扑结构中禁止接入类型未知的 DRIVE-CLiQ 组件。 此时会对 DRIVE-CLiQ 信号进

行环通。  
以下标准用于界定未知类型： 

– 组件参数不存在。 

– 未定义代理驱动对象。 

– 未将组件指定给已知驱动对象（DO）。 

● 在包含一个 CU Link 以及 DRIVE-CLiQ 连接的拓扑结构中，只有一个控制单元允许用

作 CU Link 主站/ DRIVE-CLiQ 主站。 

● 若检测到一个 CU Link 连接，则 DRIVE-CLiQ 基本周期 0（r0110[0]） 会被设置为 
125 μs，并被指定给该 DRIVE-CLiQ 接口。 

● 针对书本型组件： 

– 在伺服控制和矢量 V/f 控制运行中，控制单元上只允许连接一个电源模块。 

– 在伺服控制中，一个电源模块和若干个电机模块可连接到同一条 DRIVE-CLiQ 支路

上。 

– 在矢量控制中，一个电源模块和若干电机模块必须连接至不同的 DRIVE-CLiQ 支
路。 

– 使用书本型组件时，禁止并联电源模块或电机模块。 

● 针对装机装柜型组件： 

– 电源模块（基本型、调节型、非调节型）和电机模块必须连接到同一条 DRIVE-
CLiQ 支路上。 
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● 针对装机装柜型功率单元的并联运行： 

– 只在矢量控制和 V/f 控制中允许并联电源模块或者并联电机模块。 

– 一条并联回路内禁止连接超过 4 个电源模块。 

– 一条并联回路内禁止连接超过 4 个电机模块。 

– 只允许一条电机模块并联回路。 一条并联回路在拓扑结构中只有一个驱动对象。 

● 并联电机模块时，每个电机模块仅允许配备一个集成 DRIVE-CLiQ 接口（SINAMICS 
集成编码器模块）。 

● 并联时禁止在不同的电机间进行切换。 

● 针对不同电源模块的混用或不同电机模块的混用： 

– 一条并联回路中禁止连接功率不同的电源模块或电机模块。 

– 装机装柜型电源模块允许有两条并联回路，用于非调节型电源模块和基本型电源模

块的混用。 

– 禁止采用以下电源模块组合： 
调节型电源模块（ALM）+基本型电源模块（BLM） 
调节型电源模块（ALM）+非调节型电源模块（SLM） 

● 针对不同结构类型的混用： 

– DriveCLiQ 支路上小功率单元（400V；>250kW）和大功率单元（500 - 690V）的

混用会因脉冲频率调整导致电流降容。 所以装机装柜型电机模块和书本型电机模块

必须连接到不同的 DRIVE-CLiQ 支路上。 

● 针对不同控制模式的混用： 

– 禁止混合使用伺服控制和矢量控制。 

– 允许混合使用伺服控制和 V/f 控制。 

– 允许混合使用矢量控制和 V/f 控制。 

● 针对不同控制周期的混用： 
允许采用以下组合： 

– 62.5 µs 的伺服控制 + 125 µs 的伺服控制 

– 125 µs 的伺服控制 + 250 µs 的伺服控制 

– 250 µs 的矢量控制 + 500 µs 的矢量控制 
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● 针对带电压监控模块（VSM）的运行： 

– 当电源功能模块激活时，可以在电源模块上连接第二个或第三个电压监控模块

（VSM）。 

– VSM 必须连接到相应电源模块或电机模块的空置 DRIVE-CLiQ 接口上（以支持 
VSM 的自动分配）。 

● 在一个“SERVO”或“VECTOR”驱动对象上每个驱动数据组禁止设置超过三个编码器数

据组。 编码器数据组的最大数量取决于组态范围和电流控制器周期： 

– 在采用伺服控制、电流控制器周期为 125 μs、包含一个电源模块的 6 轴最大组态范

围条件下，最多可连接 12 个编码器。 

– 在采用伺服控制、电流控制器周期为 125 µs 的 5 轴组态范围条件下，最多可连接 
15 个编码器。 

● 最多可连接 24 个驱动对象（Drive Objects = DOs）。 

● CU320-2 上最多可连接 16 个端子模块。 
注：若连接了 TM15 Base、TM31、TM54F 或 TM41，则必须减少相连标准轴的数

量。 

● 控制单元 CU310-2 上最多可连接 8 个类型为 TM15 Base 和 TM31 的端子模块。 

● 控制单元 CU310-2 上最多可连接 3 个类型为 TM15、TM17 或 TM41 的端子模块。 

● 使用 TM31 时的周期时间 
时间片为 2 ms 时，最多可连接 3 个端子模块 31(TM31)。 

● DRIVE-CLiQ 支路上所有组件的通讯基本周期（p0115[0] 和 p4099）必须可以相互整

除。 

– 最小通讯基本周期为 125 µs。 

– 例外：最多有 3 根伺服控制轴可以采用 62.5 µs 的通讯基本周期；一根伺服控制轴

可以采用 31.25  的通讯基本周期。 

● 电流控制器周期 Ti < 125 μs 时，即使控制器周期相同，电机模块也必须对称连接到两

个 DRIVE-CLiQ 接口。 

● 伺服控制中驱动对象的最快采样时间如下得出： 

– Ti = 31.25 µs：伺服控制中有且只有 1 个驱动对象（仅 CU320-2） 

– Ti = 62.5 µs：伺服控制中最多 3 个驱动对象（CU320-2） 
伺服控制中有且只有 1 个驱动对象（CU310-2） 

– Ti = 125 µs：伺服控制中最多 6 个驱动对象 
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● 矢量控制中驱动对象的最快采样时间如下得出： 

– Ti = 250 µs：矢量控制中最多 3 个驱动对象 

– Ti = 400 µs：矢量控制中最多 5 个驱动对象 

– Ti = 500 µs：矢量控制中最多 6 个驱动对象 

● V/f 控制中驱动对象的最快采样时间如下得出： 

– Ti = 500 µs：V/f 控制中最多 12 个驱动对象 

● 控制单元 CU320-2 一条 DRIVE-CLiQ 支路上可连接的 DRIVE-CLiQ 节点的最大数量

取决于 DRIVE-CLiQ 支路的基本周期： 

– 电流控制器周期为 31.25 µs 时最多允许连接 3 个 DRIVE-CLiQ 节点 

– 电流控制器周期为 62.5 µs 时最多允许连接 5 个 DRIVE-CLiQ 节点 

– 电流控制器周期为 125 µs 时最多允许连接 14 个 DRIVE-CLiQ 节点 

– 电流控制器周期为 250 µs 时最多允许连接 20 个 DRIVE-CLiQ 节点 

– 电流控制器周期为 500 µs 时最多允许连接 30 个 DRIVE-CLiQ 节点 

● 控制单元 CU310-2 一条 DRIVE-CLiQ 支路上可连接的 DRIVE-CLiQ 节点的最大数量

取决于 DRIVE-CLiQ 支路的基本周期： 

– 电流控制器周期为 125 µs 或更高时最多允许连接 8 个 DRIVE-CLiQ 节点 

● 采样时间为 62.5 µs 的 CU320-2 示例： 

– 拓扑结构 1：1 个 ALM（250 µs） + 2 个伺服（62.5 µs）+ 2 个伺服（125 µs）+ 3 
个 TM15 + TM54F + 4 个 Safety Integrated 扩展功能（编码器 SI Motion 监控周期 
p9500 = 12 ms + SI Motion 实际值采集周期 p9511 = 4 ms） + 4 个直接测量系统 

– 拓扑结构 2：1 个 ALM（250 µs） + 2 个伺服（62.5 µs） + 2 个 V/f（500 µs） + 
3 个 TM15 Base 2 ms + 2 个 Safety Integrated 扩展功能（编码器 SI Motion 监控

周期 p9500 = 12 ms + SI Motion 实际值采集周期 p9511 = 4 ms） + 2 个 Safety 
Integrated 扩展功能无传感器 + 2 个直接测量系统 

– 拓扑结构 3：1 个伺服（62.5 μs） + 4 个 V/f，不可与 Safety Integrated 连接。 

● 采样时间为 31.25 µs 的 CU320-2 示例： 

– 拓扑结构 1：1 个 ALM（250 µs）在一条支路上、1 个 Servo（31.25 µs）在一条

支路上、3 个端子模块在一条支路上串联 

– 拓扑结构 2：1 个 ALM（250 µs）在一条支路上、1 个 Servo（31.25 µs）在一条

支路上、1 个直接测量系统在一条支路上 
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● 若在一个驱动对象上须更改电流控制器采样时间 Ti，而更改值又与同一条 DRIVE-
CLiQ 支路上其他驱动对象采样时间不匹配，则可采用以下解决方案： 

– 将经过修改的驱动对象插入一条单独的 DRIVE-CLiQ 支路中。 

– 同时修改电流控制器采样时间以及其他驱动对象输入/输出的采样时间，使其与修改

过的采样时间匹配。 

● 在采样时间 Ti = 31.25 μs 的组件的 DRIVE-CLiQ 接口上只允许连接采样时间相同的组

件。  
允许连接以下组件： 

– 编码器模块 

– 高频阻尼模块（HF damping modules） 

– 高频滤波器模块支路中的书本型调节型电源模块 

– 高频滤波器模块支路中的书本型非调节型电源模块 

– 必须使用另外的 DRIVE-CLiQ 支路的其它组件： 
伺服控制、矢量控制、V/f 控制的中电机模块或者端子模块（TM）。 

● 采样时间 Ti = 31.25 μs 时禁止连接以下组件： 

– 更多采用伺服控制的电机模块 

– 更多采用 V/f 控制的电机模块 

– 使用控制单元 CU310-2 

● 使用 TM54F 时的规定： 

– TM54F 必须通过 DRIVE-CLiQ 直接连接到控制单元上。 

– 一个控制单元只能连接一个 TM54F。 

– 在 TM54F 上可以连接更多的 DRIVE-CLiQ 节点，例如：编码器模块 SM 或端子模

块 TM，但是不能连接更多的 TM54F 模块。电机模块和电源模块不允许连接到一个 
TM54F 上。 

– 在使用控制单元 CU310-2 时，TM54F 不允许连接到功率模块所在的 DRIVE-CLiQ 
支路上， TM54F 只能连接到控制单元上唯一的 DRIVE-CLiQ 插口 X100 上。 

● 一条 DRIVE-CLiQ 支路上禁止运行超过 4 个带扩展安全集成功能的电机模块（仅针对 
TI = 125 μs）。 在此 DRIVE-CLiQ 支路上禁止连接其他 DRIVE-CLiQ 组件。 

● 若一根轴只有一个编码器，且该轴激活了安全集成功能，则此编码器只可连接至电机

模块或集线器模块 DMC20。 
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● 针对控制单元 CX / NX 模块上 DRIVE-CLiQ 接口： 

连接至控制单元的接口由 CX / NX 的总线地址得出 
（10 → X100，11 → X101，12 → X102，13 → X103，14 → X104，15 → X105）。 

● 禁止混用 SIMOTION 主站控制单元和 SINUMERIK 从站控制单元。 

● 禁止混用 SINUMERIK 主站控制单元和 SIMOTION 从站控制单元。 

对于控制单元 CU310-2： 

● CU310-2 为 1 轴控制模块，插装在功率模块 PM340 上 

● 装机装柜型中与功率模块的连接通过 DRIVE-CLiQ 接口 X100 进行。 

● 不管是在插装模式中，还是通过 DRIVE-CLiQ 接口 X100 都可选择最小 62.5 µs 的电

流控制器周期。 

● 不可采用 31.25 µs 的电流控制器周期。 

1.5.3 DRIVE-CLiQ 布线建议 

为了使用“自动配置”功能将编码器分配给驱动，您还需要注意以下布线建议： 

● 针对 DRIVE-CLiQ 组件（控制单元除外）： DRIVE-CLiQ 接口 Xx00 为 DRIVE-CliQ 
输入端，其他 DRIVE-CLiQ 接口为输出端。 

● 单独的电源模块应直接连接至控制单元的 DRIVE-CLiQ 接口 X100。 

– 存在多个电源模块时应采用线性拓扑结构。 

– 若 DRIVE-CLiQ 接口 X100 不可用，应选择下一个编号较高的接口。 

● 电流控制器周期为 31.25 μs 时，滤波器模块应直接连接至控制单元的 DRIVE-CLiQ 
接口。 

● 结构类型为装机装柜型时，电流控制器周期为 250 μs 的电机模块应连接至控制单元

的 DRIVE-CLiQ 接口 X101。 必要时应采用线性拓扑结构。 

– 若 DRIVE-CLiQ 接口 X101 不可用，则应为此电机模块选择下一个编号较高的 
DRIVE-CLiQ 接口。 

● 结构类型为装机装柜型时，电流控制器周期为 400 μs 的电机模块应连接至控制单元

的 DRIVE-CLiQ 接口 X102。 必要时应采用线性拓扑结构。 

– 若 DRIVE-CLiQ 接口 X102 不可用，则应为此电机模块选择下一个编号较高的 
DRIVE-CLiQ 接口。 
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● 脉冲频率不同的装机装柜型电机模块（结构尺寸 FX、GX、HX、JX）应连接至不同

的 DRIVE-CLiQ 支路。 

● 装机装柜型电机模块和装机装柜型电源模块模块应连接至不同的 DRIVE-CLiQ 支路。 

● I/O 组件（例如端子模块 TM）应以线性拓扑连接至控制单元的 DRIVE-CLiQ 接口 
X103。 

– 若 DRIVE-CLiQ 接口 X103 不可用，则可以为 I/O 组件选择任意一个空置的 
DRIVE-CLiQ 接口。 

● 采用伺服控制时，书本型电机模块应以线性拓扑连接至控制单元的 DRIVE-CLiQ 接口 
X100。 

– 若 DRIVE-CLiQ 接口 X100 不可用，则应为此电机模块选择下一个编号较高的 
DRIVE-CLiQ 接口。 

● 双轴电机模块首个驱动的电机编码器应连接至相应的 DRIVE-CLiQ 接口 X202。 

● 双轴电机模块第二个驱动的电机编码器应连接至相应的 DRIVE-CLiQ 接口 X203。 

● 电机编码器应连接至相应电机模块： 
通过 DRIVE-CLiQ 连接电机编码器： 

– 书本型单轴电机模块连接至端子 X202 

– 书本型双轴电机模块，电机 X1 连接至端子 X202，电机 X2 连接至端子 X203 

– 装机装柜型单轴电机模块连接至端子 X402 

– 配备 CUA31 的模块型功率模块：编码器连接至端子 X202 

– 配备 CU310-2 的模块型功率模块：编码器连接至端子 X100，或通过 TM31 连接至 
X501 

– 装机装柜型功率模块连接至端子 X402 

  说明 
自动分配额外的编码器 
如果在电机模块上连接了一个额外的编码器，则应将它作为编码器 2 自动分配给该驱

动。 

● 应尽可能对称地对 DRIVE-CLiQ 接口进行布线。  
示例： 需要连接 8 个 DRIVE-CLiQ 节点时，不要将其批量连接至控制单元的一个 
DRIVE-CLiQ 接口，而是连接至 4 个 DRIVE-CLiQ 接口，即每个 DRIVE-CLiQ 接口连

接 2 个节点。 

● 控制单元的 DRIVE-CLiQ 电缆应连接至第一个书本型功率单元的 DRIVE-CLiQ 接口 
X200，或第一个装机装柜型功率单元的插口 X400。 
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● 功率单元间的 DRIVE-CLiQ 电缆应从 DRIVE-CLiQ 接口 X201 连接到下一个组件的插

口 X200 上，或者从 X401 连接到 X400 上。 

● 带有 CUA31 的功率模块应连接到 DRIVE-CLiQ 支路的末端。 

 
图 1-3 DRIVE-CLiQ 支路示例 

● 在一条 DRIVE-CLiQ 支路中，组件的一个空置 DRIVE-CLiQ 接口上始终只能连接一个

终端节点，例如编码器模块或端子模块，此时不再继续连接额外的组件。 

● 如果可能，请不要将端子模块和直接测量系统的编码器模块连接到电机模块的 
DRIVE-CLiQ 支路上，而是连接至控制单元的空置 DRIVE-CLiQ 接口。 
提示：采用星形连接时无此限制。 

● TM54F 不应与电机模块在一条 DRIVE-CLiQ 支路上运行。 

● 端子模块 TM15、TM17 和 TM41 的采样周期比 TM31 和 TM54F 短。 因此应将这两

个端子模块组连接在不同的 DRIVE-CLiQ 支路上。 

● 若混用伺服控制和矢量 V/f 控制，则电机模块应连接至不同的 DRIVE-CLiQ 支路。 

– 在双轴电机模块上不允许混用控制方式。 

● 电压监控模块（VSM）应连接至电源模块的 DRIVE-CLiQ 接口 X202（书本型）或 
X402（装机装柜型）。 

– 若 DRIVE-CLiQ 接口 X202 / X402 不可用，则应在电源模块上选择一个空置 
DRIVE-CLiQ 接口。 

 
图 1-4 书本型和装机装柜型组件带有 VSM 的拓扑示例 
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1.5.4 有关可控制的驱动数量的说明 

受控制轴的数量和类型以及额外激活的功能可通过固件配置来增减。 特别是在对配置要

求较高，例如驱动具备高动态特性或额外使用特殊功能时轴数量较大的情况下，建议使用

选型工具 SIZER 进行检查。 选型工具 SIZER 会计算项目的可执行性。  

可实现的最大功能性取决于所使用的控制单元的计算功率以及所配置的组件。  

1.5.4.1 系统采样时间和可控制驱动数量 

此章节中列出了使用控制单元可控制的轴的数量。 轴数取决于周期时间和控制模式。 剩
余计算时间可用于选件（例如 DCC）。  

伺服控制中的周期时间 

下表中列出了伺服控制中控制单元可控制的轴的数量。 轴数同样取决于控制器的周期时

间： 

表格 1- 5 伺服控制中的采样时间设置 

周期时间[μs] 数量 

电流控制器 转速控制器 轴 电源模块 

电机/直接测量

系统 
TM1) / TB 

125 125 6 1 [250 μs] 6 / 6 3 [2000 μs] 

62,5 62,5 3 1 [250 μs] 3 / 3 3 [2000 μs] 

31,252) 31,252) 1 1 [250 μs] 1 / 1 3 [2000 μs] 
1)适用于 TM31 或 TM15IO；对于 TM54F、TM41、TM15、TM17、TM120 和 TM150 可根据所设置的采

样时间进行限制。 
2)周期为 31.25 µs 时，可以额外创建以下对象： 

• 当前固件和硬件支持的外部编码器模块（SEM）和 SMC20。其特征是订货号末位为 3。 

• 在该周期内不允许运行附加轴。 
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在电流控制器周期混用时允许采用以下组合： 

● 125 µs 的伺服控制和 250 µs 的伺服控制（最多可混用 2 种周期） 

● 62.5 µs 的伺服控制和 125 µs 的伺服控制（最多可混用 2 种周期） 

此时请注意：周期时间为 31.25 µs 的 1 个轴相当于 

● 2 个周期为 62.5 µs 的伺服控制轴 

● 4 个周期为 125 µs 的伺服控制轴 

● 8 个周期为 500 µs 的 V/f 控制轴 

矢量控制中的周期时间  

下表中列出了矢量控制中控制单元可控制的轴的数量。 轴数同样取决于控制器的周期时

间：  

表格 1- 6 矢量控制中的采样时间设置 

周期时间[μs] 数量 

电流控制器 转速控制器 轴 电源 2) 

电机/直接测量

系统 
TM1) / TB 

500 µs 2000 µs 6 1 [250 μs] 6 / 6 3 [2000 μs] 

4003) µs 1600 µs 5 1 [250 μs] 5 / 5 3 [2000 μs] 

250 µs 1000 µs 3 1 [250 μs] 3 / 3 3 [2000 μs] 
1)适用于 TM31 或 TM15IO；对于 TM54F、TM41、TM15、TM17、TM120 和 TM150 可根据所设置的采

样时间进行限制。 
2)对于装机装柜型功率单元，电源周期取决于模块功率，可达到 400 μs、375 μs 或 250 μs。 
3)此设置会导致剩余计算时间减少。 

在矢量控制模式中可混用 250 µs 和 500 µs 的电流控制器周期。 
 

 说明 
在装机装柜型组件上的限制条件 
若通过 p1802 ≥ 7 激活脉冲沿调制的同时也通过 p1810.2 = 1 激活了摆动，则矢量控制的

组态范围会减半。 之后例如在电流控制器周期为 500 µS 时最多可使用 3 个轴， 400 µS 
时为 2 个轴，250 µS 时为 1 个轴。 
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V/f 控制的周期时间  

下表中列出了 V/f 控制中控制单元可控制的轴的数量。 轴数取决于电流控制器周期： 

表格 1- 7 V/f 控制的采样时间设置 

周期时间[μs] 数量 

电流控制器 转速控制器 驱动 / 电源模块 

电机/直接测量

系统 
TM/TB 

500 2000 12 1 [250 μs] - / - 3 [2000 μs] 

矢量控制和 V/f 控制的混用  

在伺服控制和 V/f 控制混用时，周期为 125 µs 时一根伺服轴消耗的计算性能与周期为 
500 µs 时两个 V/f 轴的消耗完全相同。 伺服控制和 V/f 控制混用最多允许 11 个轴（1 伺
服控制 + 10 矢量 V/f 控制）。 

表格 1- 8 伺服控制和 V/f 控制混用时的轴数 

采用伺服控制的轴数量 采用 V/f 控制的轴数量 

6 125 µs 3 62.5 µs 0  

5 125 µs   2 500 µs 

4 125 µs 2 62.5 µs 4 500 µs 

3 125 µs   6 500 µs 

2 125 µs 1 62.5 µs 8 500 µs 

1 125 µs   10 500 µs 

0  0  12 500 µs 

矢量控制和 V/f 控制混用 

在矢量控制和 V/f 控制混用时，周期为 250 µs 时一根矢量轴消耗的计算性能与周期为 
500 µs 时两个 V/f 轴的消耗完全相同。 在矢量控制和 V/f 控制混用时最多允许 11 个轴

（1 矢量控制 + 10 V/f 控制）。 
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表格 1- 9 矢量控制和 V/f 控制混用时的轴数 

采用矢量控制的轴数量 采用 V/f 控制的轴数量 

6 500 µs 3 250 µs 0  

5 500 µs   2 500 µs 

4 500 µs 2 250 µs 4 500 µs 

3 500 µs   6 500 µs 

2 500 µs 1 250 µs 8 500 µs 

1 500 µs   10 500 µs 

0  0  12 500 µs 

伺服控制中 CU310-2 的周期时间 

表格 1- 10 伺服控制中的采样时间设置 

周期时间[μs] 数量 通过 DQ2) 卡接 

电流控制器 转速控制器 轴 电源模块 电机模块 功率模块 

TM1) / TB 

125 125 1 - - 1 3 [2000 μs] 

62,5 62,5 1 - - 1 3 [2000 μs] 
1)适用于 TM15、TM17 或 TM41；对于 TM54F、TM31、TM120、TM150 可根据所设置的采样时间进行

限制。 
2) DQ = DRIVE-CLiQ  

若将控制单元 CU310-2 卡接到了功率模块 PM340 上，则可采用 62.5 µs 的最小电流控制

器周期。 

使用 DCC  

可用的剩余计算时间可用于 DCC。 此时以下边界条件适用： 

● 时间片为 2 ms 时，每省去一个周期为 125 μs 的伺服控制轴（≙ 2 个周期为 500 μs 
的 V/f 轴）则可配置最多 75 个 DCC 模块。 

● 时间片为 2 ms 时 50 个 DCC 模块对应 1.5 个周期为 500 μs 的 V/f 轴。 

有关 DCC 标准模块的详细信息参见“SINAMICS/SIMOTION DCC 编辑器描述”手册。  
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使用 EPOS  

下表中列出了使用简易定位系统（EPOS）时通过 SINAMICS S120 可运行的轴的数量。 
轴数取决于电流控制器周期。 

表格 1- 11 使用 EPOS 时的采样时间 

周期时间[μs] 周期时间 [ms] 数量 

电流控制器 转速控制器 位置控制器 定位器 轴 电源模块 

250 250 2 8 6 1 [250 μs] 

250 250 1 4 5 1 [250 μs] 

125 125 1 4 4 1 [250 μs] 

功能模块 EPOS（1 ms 位置控制器/ 4 ms 定位器）的计算消耗相当于 0.5 个周期为 
500 μs 的 V/f 轴的消耗。  

使用 CUA31/CUA32  

使用控制单元适配器 CUA31 或 CUA32 时的提示信息： 

● CUA31/32 是 CUA31/32 拓扑结构中的第一个组件： 5 轴型 

● CUA31/32 不是 CUA31/32 拓扑结构中的第一个组件： 6 轴型 

● 电流控制器周期为 62.5 µs 时，使用 CUA31/32 时可仅有 1 轴。 

1.5.4.2 DRIVE-CLiQ 的优化 

在控制器周期为 62.5 µs 和 31.25 µs 时采取对称排列 

为了达到控制单元上理想的运算时间，有必要按照如下方式在 DRIVE-CLiQ 接口上对称

连接各个轴： 

● DRIVE-CLiQ 接口 X100：电源，轴 2、4、6、... 

● DRIVE-CLiQ 接口 X101：轴 1、3、5、... 

这种排列的优点在于 2 个测量值可以同时到达控制单元。 
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1.5.4.3 采样时间的缺省设置 

在首次调试时电流控制器采样时间 (p0115[0]) 会自动预设为出厂设置值：  

表格 1- 12 出厂设置 

结构型式 数量 p0112 p0115[0] p1800 

调节型电源 

书本型 1 2 (低) 250 µs - 

装机装柜型 
400 V / <≤ 
300 kW 
690 V / <≤ 
330 kW 

 
1 
1 

 
2 (低) 
2 (低) 

 
250 µs 
250 µs 

 
- 
- 

装机装柜型 
400 V / > 
300 kW 
690 V / > 
330 kW 

 
1 
1 

 
0 (专家级) 
1 (x 低) 

 
375 µs (p0092 = 
1) 
400 µs (p0092 = 
0) 

 
- 
- 

非调节型电源 

书本型 1 2 (低) 250 µs - 

装机装柜型 
400 V / <≤ 
355 kW 
690 V / <≤ 
450 kW 

 
1 
1 

 
2 (低) 
2 (低) 

 
250 µs 
250 µs 

 
- 
- 

装机装柜型 
400 V / > 
355 kW 
690 V / > 
450 kW 

 
1 
1 

 
0 (专家级) 
1 (x 低) 

 
375 µs (p0092 = 
1) 
400 µs (p0092 = 
0) 

 
- 
- 

基本型电源 

书本型 1 4 (高) 250 µs - 

装机装柜型 1 2 (低) 2000 µs - 
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结构型式 数量 p0112 p0115[0] p1800 

伺服 

书本型 1 到 6 3 (标准) 125 µs 4 kHz 

装机装柜型 1 到 6 1 (x 低) 250 µs 2 kHz 

模块型 1 到 5 3 (标准) 125 µs 4 kHz 

矢量 

书本型 4 kHz 

装机装柜型 
400 V / <≤ 
250 kW 

1 到 3 仅转速控

制 
1 到 6 仅 V/f 

3 (标准) 250 µs 

2 kHz 

书本型 4 kHz 

装机装柜型 
400 V / <≤ 
250 kW 

4 到 12  0(专家级) 500 µs 

2 kHz 

装机装柜型 
> 250 kW 
690 V 

1 到 4 仅转速控

制 
1 到 5 仅 V/f 
1 到 6 仅转速控

制 

0（专家级） 
1（x 低） 
0（专家级） 

375 µs (p0092 = 
1) 
400 µs (p0092 = 
0) 
500 µs (p0092 = 
1) 

1.333 kHz 
1.25 kHz 
2 kHz 

 

 

 说明 
如果控制单元上连接了一个模块型功率模块，所有矢量驱动的采样时间都会依据规定设为

和模块型功率模块匹配的值（只允许 250 µs 或 500 µs）。 
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1.5.5 在调试工具 STARTER 中修改离线拓扑 

设备拓扑可以在调试工具 STARTER 中通过移动拓扑树中的组件来进行修改（拖放）。 

 

示例：修改 DRIVE-CLiQ 拓扑 

1. 选中 DRIVE-CLiQ 组件。 

 

2. 按住鼠标键将组件拖动到需要的 DRIVE-CLiQ 接口处，松开鼠标。 

 

调试工具 STARTER 中的拓扑已经修改。  
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1.5.6 模块化的设备方案： 离线修改设定拓扑结构 

拓扑结构基于模块化的设备方案。 设备方案可在调试工具 STARTER 中离线设为具有最

大配置的设定拓扑结构。 

最大配置指特定设备类型具有的最大结构。 在最大配置中已经预先定义了所有可能会用

到的设备组件。  

取消激活组件/处理不存在的组件 

在配置范围没有达到最大配置时，您必须在 STARTER 拓扑结构中标出未使用的驱动对

象和编码器。 为此为相应的驱动对象和编码器设置参数 p0105 或 p0145 = 2（取消激活

组件且将组件设为不存在）。 离线生成的项目中值设为 2 的组件因此无法再在开始时插

入到实际拓扑结构中。 

如果需要在某个组件失灵、备件尚未可用时使设备继续运行，也可以使用这种部分拓扑结

构。 但此时该驱动对象上的 BICO 信号源不允许连接到其他驱动对象上。 

部分拓扑结构示例 

初始情况是：已经在调试工具 STARTER 中离线创建了一个设备，该设备上没有实现“驱
动 1”。 

1. “离线”通过 p0105 = 2 将驱动对象“驱动 1”从设定拓扑结构中删除。 

2. 将 DRIVE-CLiQ 电缆从控制单元直接插到“驱动 2”上。 
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3. 点击“Load to drive unit”传送项目。 

4. 执行“从 RAM 复制到 ROM”。 

 

图 1-5 部分拓扑结构示例 
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小心  
 

SI 状态出错 
如果通过 p0105 取消激活了一个 Safety Integrated 组合中的驱动，则 r9774 不再正

确输出，因为该驱动上的信号不再更新。  
因此在取消激活该驱动前，应将该驱动从安全组合中取出。 
参见： SINAMICS S120 Safety Integrated 功能手册 

激活/取消激活组件 

通过这种方式您可以利用专家参数表中的参数 p0105 来激活/取消激活某个驱动对象，利

用 p0145[0...n] 来激活/取消激活编码器。 当您暂时不需要一个组件时，可以将组件的参

数 p0105 或 p0145 从 1 改为 0。 取消激活的组件仍保持插入，但已被禁用。 系统不会

显示取消激活的组件出现的故障。 

重要参数一览（参见 SINAMICS S120/S150 参数手册） 

 

• p0105 激活/取消激活驱动对象 

• r0106 驱动对象激活/禁用 

• p0125 激活/取消激活功率单元组件 

• r0126 功率单元激活/禁用 

• p0145[0...n] 编码器接口激活/取消激活 

• r0146 编码器接口激活/禁用 

• p9495 取消激活的驱动对象的 BICO 特性 

• p9496 激活的驱动对象的 BICO 特性 

• r9498[0...29] BICO 取消激活的驱动对象的 BI/CI 参数 

• r9499[0...29] BICO 取消激活的驱动对象的 BO/CO 参数 

• r9774.0...31 CO/BO: SI 状态（STO 组） 
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1.5.7 拓扑示例：采用矢量控制的驱动 

示例 1 

驱动组中包含三个脉冲频率相同的装机装柜型电机模块，或三个采用矢量控制的书本型电

机模块。 

脉冲频率相同的装机装柜型电机模块，或采用矢量控制的书本型电机模块可连接在控制单

元的一个 DRIVE-CLiQ 接口上。 

下图所显示的是将三个电机模块连接至 DRIVE-CLiQ 接口 X101 的方案。 
 

 说明 
在调试工具 STARTER 中自动创建的离线拓扑（如果该拓扑已经进行了布线）必须手动

进行修改。  
 

 

图 1-6 脉冲频率相同的驱动组（装机装柜型） 
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由四个脉冲频率不同的装机装柜型电机模块组成的驱动组 

脉冲频率不同的电机模块最好连接至控制单元上的不同的 DRIVE-CLiQ 支路上， 当然也

可以连接到相同的 DRIVE-CLiQ 支路上。 

在下图中，两个电机模块（400 V，功率 ≤ 250 kW，脉冲频率 2 kHz）连接在 X101 接口

上，另外两个电机模块（400 V，功率 > 250 kW，脉冲频率 1.25 kHz）连接在 X102 接
口上。 

 

 说明 
在调试工具 STARTER 中自动创建的离线拓扑（如果该拓扑已经进行了布线）必须手动

进行修改。  
 

 

图 1-7 脉冲频率不同的驱动组（装机装柜型） 
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1.5.8 拓扑示例：采用矢量控制的并联电机模块 

由两个并联的电源模块和相同类型的装机装柜型电机模块组成的驱动组 

并联的装机装柜型电源模块和相同类型的装机装柜型电机模块可分别连接在控制单元的一

个 DRIVE-CLiQ 插口上。 

在下图中，两个调节型电源模块和两个电机模块分别连接在插口 X100 和 X101 上。 

其他信息请参见 SINAMICS S120 驱动功能手册中“功率单元的并联”一章。 
 

 说明 
在调试工具 STARTER 中自动创建的离线拓扑（如果该拓扑已经进行了布线）必须手动

进行修改。  
 

 

 

图 1-8 由并联的装机装柜型功率单元组成的驱动组 
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1.5.9 拓扑示例：采用 V/f 控制（矢量控制）的驱动 

下图显示了控制单元能控制的矢量 V/f 驱动和附加组件的最大数量。 各组件的采样时间

为： 

● 调节型电源模块： p0115[0] = 250 µs 

● 电机模块： p0115[0] = 500 µs 

● 端子模块/端子板 p4099 = 2 ms 

 

图 1-9 V/f 控制中矢量驱动系统的拓扑示例  
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1.5.10 拓扑示例：采用伺服控制的驱动 

下图显示了控制单元能控制的伺服驱动和附加组件的最大数量。 各组件的采样时间为： 

● 调节型电源模块： p0115[0] = 250 µs 

● 电机模块： p0115[0] = 125 µs 

● 端子模块/端子板 p4099 = 1 ms 

 

图 1-10 伺服驱动组的拓扑示例 

拓扑结构示例图例： 
ALM = 调节型电源模块 
SMM = 单轴电机模块 
DMM = 双轴电机模块 
SMx = 电机编码器 
SMy = 直接测量系统 
TMx = TM31、M15DI/DO、TB30 
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1.5.11 拓扑示例：功率模块 

模块型 

 

图 1-11 模块型功率模块构成的驱动系统 
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装机装柜型 

 

图 1-12 装机装柜型功率模块构成的驱动系统 
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1.6 接通/关闭驱动系统 

电源模块上电  

 

图 1-13 电源模块上电 
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驱动系统上电 

 

图 1-14 驱动系统上电 
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OFF 响应 

● OFF1 

– 通过立即在斜坡函数发生器的减速斜坡（p1121）上设定 n_set = 0 的方式来使驱动

制动。 

– 在识别到停机之后，将电机抱闸装置（如已设置）闭合（p1215）。 在闭合时间

(p1217)结束之后，将脉冲清除。 当转速实际值低于转速阈值（p1226）或者当转

速设定值 ≤ 转速阈值（p1226）时已开始的监控时间（p1227）结束的情况下，就

识别为停机。 

● OFF2 

– 立即清除脉冲，驱动“滑行”至静止。 

– 立即闭合电机抱闸装置（如已设置）。 

– 接通禁止被激活。 

● OFF3 

– 通过立即在 OFF3 减速斜坡上（p1135）设置 n_set=0 的方式来使驱动制动。 

– 在识别到停机之后，闭合电机抱闸装置（如已设置）。 在抱闸闭合时间(p1217)结
束时，将清除脉冲。 当转速实际值低于转速阈值（p1226）或者当转速设定值 ≤ 转
速阈值（p1226）时已开始的监控时间（p1227）结束的情况下，就识别为停机。 

– 接通禁止被激活。 

控制信息和状态信息 

表格 1- 13 接通/关闭控制信息 

信号名称 内部控制字 Binector input（二进制互

联输入） 
PROFIdrive/西门子报

文 1 ... 352 

0 = OFF1 STWA.00 
STWAE.00 

p0840 ON/OFF1 STW1.0 

0 = OFF2 STWA.01 
STWAE.01 

p0844 1. OFF2 
p0845 2. OFF2 

STW1.1 

0 = OFF3 STWA.02 p0848 1. OFF3 
p0849 2. OFF3 

STW1.2 

运行使能 STWA.03 
STWAE.03 

p0852 运行使能 STW1.3 
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表格 1- 14 接通/关闭状态信息 

信号名称 内部状态字 参数 PROFIdrive/西门子报

文 1 ... 352 

接通就绪 ZSWA.00  
ZSWAE.00 

r0899.0 ZSW1.0 

运行就绪 ZSWA.01  
ZSWAE.01 

r0899.1 ZSW1.1 

运行使能 ZSWA.02  
ZSWAE.02 

r0899.2 ZSW1.2 

接通禁止 ZSWA.06  
ZSWAE.06 

r0899.6 ZSW1.6 

脉冲使能 ZSWA.11 r0899.11 ZSW2.10 1) 

1) 只在 p2038 = 0 界面模式中出现 

功能图（参见 SINAMICS S120/S150 参数手册）  

 

• 2610 顺序控制 - 控制器 

• 2634 顺序控制 - 缺少使能信号，电源接触器控制，逻辑运算 

• 8732 基本型电源 - 控制器 

• 8832 非调节型电源 - 控制器 

• 8932 调节型电源 - 控制器 
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调试 2
2.1 调试过程 

按照下列步骤进行驱动的调试： 

1. 使用 STARTER 创建项目。 

2. 在 STARTER 中配置驱动设备。 

3. 在 STARTER 中保存项目。 

4. 在 STARTER 中在线联机目标设备。 

5. 将项目装载到目标设备中。 

6. 结果：电机运转。 
 

 说明 
永久保存电机数据和编码器数据 
如果使用的是配备有 DRIVE-CLiQ 接口的电机，在更换了电机上的编码器模块后，建议

通过设置参数 p4692 = 1 永久保存所有编码器数据和电机数据。 
 

 

危险  
断电后的危险电压 
在断电后的 5 分钟内，所有组件上仍会带有危险电压。  
请注意组件上的提示！  

 

 说明 
需要验收测试 
创建带有 Safety Integrated 功能的项目时可以离线操作，调试时必须进行验收测试，且

只可在线进行。 
 

 说明 
项目上传之后才能更新单位 
在调试工具 STARTER 中，通过 p9302/p9502 切换了轴类型并接着执行了上电后，与轴

类型相关的单位在项目上载之后才能被更新。 
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 说明 
必须注意遵守设备手册中的安装规则和安全注意事项（参见 SINAMICS S120 控制单元及

附加系统组件设备手册和 SINAMICS S120 书本型功率单元设备手册）。 
 

 

警告  
单个驱动意外加速  
当通过一个无馈电能力的电源（例如基本型电源模块）或在电源故障时或过载

（SLM/ALM）时对多个电机模块进行供电，只能在驱动转动惯量较大的电机上激活最大 
Vdc 控制功能。  
在其它电机模块上必须禁用此功能，或设置为监控。  
在多个电机模块上激活最大 Vdc 控制会导致参数设置不便，这可能会使控制器相互产生

负面影响。 驱动可能会变得不稳定，各驱动可能会不按计划加速。 

• 激活最大 Vdc 控制： 
– 矢量控制： p1240 = 1（出厂设置） 
– 伺服控制： p1240 = 1 
– V/f 控制： p1280 = 1（出厂设置） 

• 禁用最大 Vdc 控制： 
– 矢量控制： p1240 = 0 
– 伺服控制： p1240 = 0（出厂设置） 
– V/f 控制： p1280 = 0 

• 激活最大 Vdc 监控： 
– 矢量控制： p1240 = 4 或 6 
– 伺服控制：p1240 = 4 或 6 
– V/f 控制： p1280 = 4 或 6 
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2.2 调试工具 STARTER 
调试工具 STARTER 用于 SINAMICS 系列驱动产品的参数设置和调试。  

可以使用调试工具 STARTER 执行以下操作： 

● 调试 

● 测试（通过控制面板） 

● 驱动优化 

● 诊断 

● 设置并激活安全功能 

系统环境条件 

STARTER 的系统环境条件见调试工具 STARTER 安装目录下的“Readme”文件。 

2.2.1 STARTER 概述 

2.2.1.1 调用 STARTER 

调用 STARTER 

1. 点击用户界面上的 STARTER 图标 。 

或者 

2. 在 Windows 开始菜单中选择 “Start > SIMATIC > STEP 7 > STARTER” 来启动 
STARTER。 
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2.2.1.2 操作界面说明 

可使用调试工具 STARTER 创建项目。 在执行不同的配置操作时需要使用到界面的不同

区域（见下图）：  

● 项目导航器: 在该区域可显示插入到项目中的各种单元和对象。  

● 工作区域： 在该区域可执行创建项目的任务：  

– 对驱动进行配置时，此区域中包含用于配置驱动对象的向导。 

– 例如，可以设置转速设定值滤波器的参数。 

– 切换到专家列表后，便会显示一张所有参数的列表，可查看或修改。 

● 详细信息显示： 该区域包含了详细的信息，比如故障和警告。  

 
图 2-1 STARTER 操作界面的区域 
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2.2.2 调试工具 STARTER 中的重要功能 

调试工具 STARTER 为支持项目的操作提供以下功能：  

● 恢复出厂设置 

● 不同的操作向导 

● 配置驱动器并为驱动器设置参数 

● 虚拟控制面板，用于运转电机 

● 执行跟踪功能，用于驱动控制器的优化 

● 创建和复制数据组 

● 将项目从编程器中装载到目标设备中 

● 将易失数据从 RAM 中复制到 ROM 

● 将项目从目标设备中装载到编程器中 

● 设置并激活安全功能 

● 激活写保护 

● 激活专有技术保护 

下文将编程器称为“PG/PC”。 SINAMICS 驱动系统的控制单元称作“目标设备”。 

恢复出厂设置 

该功能可将控制单元工作存储器中的全部参数恢复到出厂设置。 为使存储卡上的数据也

恢复为出厂设置，必须执行一次“Copy from RAM to ROM”。 该功能只可在在线模式下激

活。 激活该功能的步骤为： 

1. 调用右键菜单中的“Drive unit > Target device > Restore factory settings”。 

在出现的询问窗口中选择是否将出厂设置另存在 ROM 中。 

2. 点击 “OK” 确认。 

通过向导引导用户操作 

STARTER 中集成了不同功能的向导，引导用户操作。 
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创建和复制数据组（离线） 

在驱动配置窗口中，可以添加驱动数据组和指令数据组(DDS 和 CDS)。 应点击相应的按

钮。 在复制数据组之前，应对两个数据组进行所有必要的互连。 

有关数据组的其它信息参见 SINAMICS S120 驱动功能手册的“驱动系统的基础原理”一
章。 

将项目装载到目标设备中 

该功能可将当前的编程器项目载入到控制单元中。 首先系统会检查项目的一致性。 一旦

发现有不一致的地方，便发出相应的报告。 您必须在加载之前去除不一致的地方。 一旦

数据一致，系统便将数据传送至控制单元的工作存储器中。 您也可按照以下步骤在在线

模式下执行该功能： 

1. 勾选驱动设备，调用菜单“Project > Load to target system”。 

或 

2. 勾选驱动设备，调用右键菜单“Project > Load to target system...”。 

或 

3. 勾选驱动设备，调用菜单“Target system > Load > Load CPU/ Drive unit to target 
device...”。 

或 

4. 驱动设备灰显时，点击图标 “Load CPU/ Drive unit to target device...”。 
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对数据进行非易失性存储 

该功能将控制单元中的易失数据备份到非易失存储器中（存储卡）。 这样数据在断开控

制单元的 24 V 电源后就不会丢失。 您也可按照以下步骤在在线模式下执行该功能： 

1. 勾选驱动设备，调用菜单“Target system > Copy from RAM to ROM”。 

或 

2. 勾选驱动设备，调用右键菜单“Target device > Copy from RAM to ROM...”。 

或 

3. 驱动设备灰显时，点击图标 “Copy from RAM to ROM”。 

或  

4. 如果在每次数据装载到目标设备后都需要自动保存到非易失存储器中，则调用菜单

“Options > Settings...”来实现。 

5. 点击选项卡“Download”，激活“After the load Copy from RAM to ROM”。 点击“OK”完
成。 

将项目载入 PG/PC 

该功能可将控制单元中的当前项目载入到 STARTER 中。 该功能只可在在线模式下激

活。 您也可按照以下步骤在在线模式下执行该功能： 

1. 勾选驱动设备，调用右键菜单“Target device -> Load CPU/ Drive unit to PG...”。 

或 

2. 勾选驱动设备，调用菜单“Target system > Load > Load CPU/ Drive unit to PG...”。 

或 

3. 驱动设备灰显时，点击图标 “Load CPU/ Drive unit to PG/PC...”。 
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设置并激活安全功能 

调试工具 STARTER 中提供有向导和各种窗口用于设置、激活和操作 Safety Integrated 
功能。 您可以从项目树形图中在线和离线调用 Safety Integrated 功能。 

1. 在项目树形图中打开以下结构：“Drive unit xy > Drive > Drive xy > Function > Safety 
Integrated”。 

2. 双击功能条目“Safety Integrated”。 
 

 说明 
有关使用 Safety Integrated 功能的其他信息可以从 SINAMICS S120 Safety Integrated 功
能手册中获取。 

 

激活写保护 

写保护功能可避免设置受到非自愿的修改。 写保护不需要口令。 该功能只可在在线模式

下激活。 

1. 在 STARTER 项目的导航窗口中选择所需的驱动设备。 

2. 调用右键菜单中的“Drive unit write protection > Activate”。 

这样就激活了写保护功能。 此时专家参数表中所有设置参数的输入栏都会以灰色阴影

显示，这表示写保护功能生效。 

为了持续地传输设置，必须在修改写保护功能后执行“RAM to ROM”进行保存。  
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激活专有技术保护 

专有技术保护（KHP）功能可防止公司关于配置和参数设置方面的绝密技术知识被读取。 
专有技术保护功能需要口令。 口令最少须包含 1 个字符，最多可包含 30 个字符。 

1. 在 STARTER 项目的导航窗口中选择所需的驱动设备。 

2. 调用右键菜单中的“Drive unit know-how protection > Activate”。 

“Activate the know-how protection for drive object”对话框打开。 

 
图 2-2 激活专有技术保护 

3. 如果除了专有技术保护之外还需要激活复制保护，请点击选项“Know-how prot. with 
copy prot.”。 

4. 点击“Specify”。 

对话框“Know-how Protection for Drive Unit - Specify Password”打开。  

 
图 2-3 设置专有技术保护口令 

5. 在“New password”栏中输入口令（1 到 30 个字符）。 请注意大小写。 
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6. 在“Confirm password”一栏中再次输入口令并点击“OK”，确认输入。 

对话框关闭，口令在对话框“Activate Know-how Protection of the Drive unit”中显示为

加密。 

缺省设置中，选项“Copy RAM to ROM”自动激活，会在控制单元中永久保存专有技术

保护。 如果只是想临时激活专有技术保护，可以撤销该选项。  

7. 点击“OK”，确认设置。 

这样便激活了专有技术保护功能。 专家参数表中所有受保护参数都不再显示内容，而

是显示“Know-how-protected”文本。 
 

 说明 
有关专有技术保护功能的详细信息参见 SINAMICS S120 驱动功能手册中“驱动系统的基

础原理”一章。  
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2.2.3 激活在线操作： 通过 PROFIBUS 操作 STARTER 

安装了调试工具 STARTER 的编程器(PG/PC)通过一个 PROFIBUS 适配器接入 
PROFIBUS。 

STARTER 接入 PROFIBUS （以 2 个 CU320-2 DP 为例）  

 

图 2-4 通过 PROFIBUS 将 PG/PC 和目标设备连接在一起 

STARTER - 在 PROFIBUS 中进行设置 

在调试工具 STARTER 中设置 PROFIBUS 通讯的方式如下： 

1. 调用菜单“Options > Set PG/PC interface”。 

2. 如果还未安装接口，点击按钮“Select”。 

3. 在左边的选择列表中选择需要用作接口的模块。 

4. 点击按钮“Install”。 

所选的模块便在“Installed”列表中列出。  
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5. 点击“Close”。 

6. 调用菜单“Options > Set PG/PC interface”，点击按钮“Properties”。 

7. 勾选或不勾选选项“PG/PC is the only master on the bus”。 
 

 说明 
PROFIBUS 设置 

• 波特率 
– 将 STARTER 接入工作中的 PROFIBUS： 

调试工具 STARTER 可自动识别出和接收 SINAMICS 所使用的 PROFIBUS 波特

率。 
– 接入 STARTER，以进行调试：  

控制单元可自动识别出和接收调试工具 STARTER 中设置的波特率。 

• PROFIBUS 地址： 

各个驱动设备的 PROFIBUS 地址应在项目中给定，所设置的地址应与设备相对应。 
 

2.2.4 激活在线操作：STARTER 接入以太网 

编程器(PG/PC)可通过控制单元内集成的以太网接口对控制单元进行调试。 该接口只设计

用于调试，而不是用于对驱动器的运行进行控制。 无法通过插入扩展卡 CBE20 实现路

由。 

前提条件 

● STARTER 版本为 4.1.5 或更高 

● 控制单元 CU320-2 DP 版本 “C” 以上或 CU320-2 PN 

STARTER 接入以太网（示例） 

 

图 2-5 通过以太网将编程器和目标设备连接在一起（示例） 
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进入以太网在线模式 

1. 在编程器中按照厂商规定安装以太网接口。 

2. 在 Windows XP 系统中设置以太网接口的 IP 地址： 

– 向编程器分配任意一个 IP 地址（如：169.254.11.1）。 

– 控制单元出厂时，集成的以太网接口 X127 的 IP 地址是 169.254.11.22。 

3. 设置调试工具 STARTER 的访问点。 

4. 在调试工具 STARTER 中为控制单元的接口命名。 

在 Windows XP 系统中设置 IP 地址  

1. 点击桌面上的图标“网络环境”，右击调用右键菜单下的“属性”。 

2. 双击相应的网卡，然后点击按钮“属性”。 

3. 选择 Internet Protocol（TCP/IP）并点击按钮“属性”。 

4. 然后输入 IP 地址和子网掩码。 

 
图 2-6 设置 PG/PC 的 IP 地址 
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在调试工具 STARTER 中进行设置 

在调试工具 STARTER 中按以下方式设置以太网通讯（本例采用的是以太网接口“Belkin 
F5D 5055”）： 

1. 调用菜单“Options > Set PG/PC interface”。 

2. 选择“Access point of the application”和接口参数（本例采用访问点“S7ONLINE
（STEP 7)”和接口参数“TCP/IP(Auto)->Belkin F5D 5055”）。 

 
图 2-7 选择编程器上的以太网接口 

当前选项中没有需要的接口时，可自行创建。  
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3. 点击按钮“Select”。 

 

图 2-8 设置接口 

4. 在左边的选择列表中选择需要用作接口的模块。 

5. 点击按钮“Install”。 

所选的模块便在“Installed”列表中列出。  

6. 点击“Close”。 

然后您可以查看集成的以太网接口的 IP 地址：  
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7. 选择驱动设备，调用右键菜单“Target device > Online access...”。 

8. 然后点击选项卡“Module address”。 

 
图 2-9 设置在线访问 

分配 IP 地址和名称  
 

 说明 
以太网 IO 设备（本例为 SINAMICS 设备：控制单元）的命名必须符合 ST（Structured 
Text）惯例。 名称在以太网中必须是唯一的。 不得在 IO 设备的名称中使用符号“-”和“.”。

 

 说明 
控制单元的 IP 地址和设备名称保存在存储卡上（非易失存储）。  
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通过“可访问节点”功能分配 IP 地址 

可以在配置工具 STARTER 中为以太网接口设置 IP 地址和名称。 

1. 将控制单元和编程设备连接。 

2. 接通控制单元。 

3. 打开 STARTER。 

4. 装载项目或创建一个新的项目。 

5. 调用菜单“Project > Accessible nodes”或点击图标 “Accessible nodes”来查找以太网

中的可访问节点。 

SINAMICS 驱动设备作为总线节点驱动设备 1 显示在对话框中，IP 地址为 
169.254.11.22，未命名。 

6. 勾选总线节点，选择右键菜单“Edit Ethernet node...”。 

7. 在对话框“Edit Ethernet node”中输入以太网接口的设备名称。 

– 点击“Assign name”按钮。 

– 如果子网掩码中无任何输入项，请在 IP 配置中输入子网掩码 255.255.0.0。 

– 接着点击“Assign IP configuration”按钮。 

– 关闭信息窗口“参数传送成功”。 

– 点击按钮“Close”。 

8. 点击“View / update（F5）”按钮来显示总线节点的 IP 地址和值“NameOfStation” = “分
配的名称”。 

  说明 
如果地址和名称均未在总线节点的条目中显示，关闭对话框“Accessible node”并重新

查找可访问的节点。  

9. 如果以太网接口显示为总线节点，则选中该项并点击“Accept”按钮。 

SINAMICS 变频器在项目树形图中作为新建的驱动设备显示。 现在您可以对新建的驱

动设备进行配置。 

10. 点击按钮“Connect to selected target device”，接着调用菜单“Target system > 
Download to target device” 将项目载入到控制单元的存储卡上。 

控制单元的 IP 地址和设备名称保存在存储卡上（非易失存储）。 
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设置专家参数表中的接口  

1. 使用参数 p8900 来分配“Name of Station” 

2. 使用参数 p8901 来分配“IP Address of Station”（出厂设置为 169.254.11.22） 

3. 使用参数 p8902 来分配“Default Gateway of Station”（出厂设置为 0.0.0.0） 

4. 使用参数 p8903 来分配“Subnet Mask of Station”（出厂设置为 255.255.0.0） 

5. 使用参数 p8905 = 1 来激活配置 

6. 使用参数 p8905 = 2 来激活和存储配置 

2.2.5 激活在线操作： 通过 PROFINET IO 操作 STARTER 

STARTER 的 PROFINET IO 在线运行通过 TCP/IP 实现。  

前提条件 

● STARTER 固件版本为 4.1.5 或更高 

● 控制单元 CU320-2 PN 

● 控制单元中装有通讯板 CBE20 

STARTER 接入 PROFINET IO（示例） 

 

图 2-10 通过 PROFINET 将 PG/PC 和目标设备连接在一起（示例） 
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建立 PROFINET 在线运行的步骤 

1. 在 Windows XP 系统中设置 IP 地址 

向 PG/PC 分配一个未占用的固定 IP 地址。 集成以太网接口 X127 的缺省地址是 
169.254.11.22，因此本例中的 IP 地址是 169.254.11.1。 将子网掩码设置为 
255.255.0.0。 

2. 调试工具 STARTER 中的设置 

3. 在调试工具 STARTER 中选择在线运行模式。 

在 Windows XP 系统中设置 IP 地址 

1. 点击桌面上的图标“网络环境”，右击调用右键菜单下的“属性”。 

2. 双击相应的网卡，然后点击按钮“属性”。 

3. 选择 Internet Protocol（TCP/IP）并点击按钮“属性”。 

4. 然后输入 IP 地址和子网掩码。 

 
图 2-11 互联网协议(TCP/IP)的属性 
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在调试工具 STARTER 中设置接口 

在调试工具 STARTER 中如下设置 PROFINET 通讯：  

1. 调用菜单“Options > Set PG/PC interface”。 

2. 选择“Access point of the application”和接口参数（本例采用访问点“S7ONLINE
（STEP 7)”和接口参数“TCP/IP(Auto)->Belkin F5D 5055”）。 

 
图 2-12 设置 PG/PC 接口 

当前选项中没有需要的接口时，可自行创建。  
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3. 点击按钮“Select”。 

 

图 2-13 设置接口 

4. 在左边的选择列表中选择需要用作接口的模块。 

5. 点击按钮“Install”。 

所选的模块便在“Installed”列表中列出。  

6. 点击“Close”。 

然后您可以查看集成的以太网接口的 IP 地址：  
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7. 选择驱动设备，调用右键菜单“Target device > Online access...”。 

8. 然后点击选项卡“Module address”。 

“Connection to target station”下显示了您设置的 IP 地址。 

 
图 2-14 设置在线访问 

为驱动设备分配 IP 地址和名称 

通过调试工具 STARTER 您可以为驱动设备的 PROFINET 接口（例如 CBE20）分配一

个 IP 地址和一个名称。 为此需要下列步骤： 

1. 用一条交叉以太网电缆连接 PG/PC 和 CU320-2 中插入的 CBE20。 

2. 接通控制单元。 

3. 启动调试工具 STARTER。 
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4. 调用菜单“Project > Accessible node”或点击图标 “Accessible node”。 

– 查找 PROFINET 中的可用节点。 

– 在“Accessible nodes”下，控制单元作为总线节点显示在对话框中，IP 地址为 
0.0.0.0，没有类型信息。 

 
图 2-15 找到的总线节点 

5. 点击总线节点条目，调用右键菜单“Edit Ethernet node...”。 

– 从自动弹出的选择窗口“Edit Ethernet node”中也可以看到 Mac 地址。 

6. 在“Assign IP configuration”下输入您选中的 IP 地址（例如：169.254.11.33）和子网掩

码（例如：255.255.0.0）。 

7. 点击“Assign IP configuration”按钮。 

– 确认数据传送。 

8. 点击“Update”按钮。 

– 总线节点会作为驱动设备显示。 

– 地址和类型也会给出。 

也可以在选择窗口“Edit Ethernet node”中为识别出的驱动设备分配一个设备名。 

9. 在“Device name”栏中输入您希望的设备名。 

  说明 
PROFINET IO 设备（SINAMICS 组件）的命名必须符合 ST (Structured Text) 惯例。 
名称在 PROFINET 中必须是唯一的。  
不得在 IO 设备的名称中使用符号“-”和“.”。 
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10. 然后点击“Assign name”按钮。 

– 确认数据传送。 

11. 点击“Update”按钮。 

– 总线节点会作为驱动设备显示并分配到一个流水号。 

– 地址、设备名和类型也会给出。 

12. 关闭窗口“Edit Ethernet node”。 

13. 勾选识别出的驱动设备前的复选框，点击“Accept”按钮。 

SINAMICS 驱动以及 CBE20 将作为驱动对象传送到项目树形图中。 现在您可以进行

驱动对象的后续配置。 

14. 点击按钮“Connect to target device”，接着调用菜单“Target system > Download > to 
target device” 将项目载入到控制单元的存储卡上。 

控制单元的 IP 地址和设备名称保存在存储卡上（非易失存储）。 
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2.3 在调试工具 STARTER 中创建项目 

2.3.1 离线创建项目 

PROFIBUS  

在离线创建项目时需要提供 PROFIBUS 地址、设备类型以及设备版本（例如固件版本 
4.5 或更高版本）。 

表格 2- 1 在调试工具 STARTER 中创建项目的步骤（示例） 

 做什么？ 如何做？ 注释 

1. 创建新项目 1. 调用菜单“Project > New”。 
显示有以下标准设置： 

– “User projects”窗口打开： 显示目标目录中已存

在的项目 

– 名称： Project_1（可自由选择） 

– 类型：项目 

– Storage location（保存路径）： 默认（可自由

设置） 
2. 根据需要修改“Name”和“Storage location”。 

 

项目是离线创建的，在

配置结束时载入到目标

系统中。 
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 做什么？ 如何做？ 注释 

2. 添加单个的驱动 

 

1. 双击项目树形图中的“Add individual drive unit”。 
以下设置已预先设定好： 

– Device type: CU320-2 DP 

– Device version: 4.5 或更高版本 

– Address type: PROFIBUS/USS/PPI 

– Bus address: 7 

2. 需要时修改此设置。 

 

总线地址的说明： 

在首次调试时必须设置

控制单元的 PROFIBUS 
地址。 

该地址可通过控制单元

上的旋转编码开关设

置，范围在 1 到 126 之
间，并可通过 p0918 读
取。 当编码开关处于 0 
时（出厂设置），该值

可以选择通过 p0918 设
置，范围在 1 到 126 之
间。  

3. 配置驱动设备 在项目创建好之后，必须对驱动设备进行配置。 在后面的章节中列举了几个示

例。 
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PROFINET  

在离线创建项目时需要提供 PROFINET 地址、设备类型以及设备版本（例如固件版本 
4.5 或更高版本）。 

 

 做什么？ 如何做？ 注释 

1 创建新项目 1. 调用菜单“Project > New”。 
显示有以下标准设置： 

– “User projects”窗口打开：显示目标目录中已存

在的项目 

– 名称：Project_1（可自由选择） 

– 类型：项目 

– Storage location（保存路径）：默认（可自由设

置） 
2. 根据需要修改“Name”和“Storage location”。 

 

项目是离线创建的，在

配置结束时载入到目标

系统中。 



调试  
2.3 在调试工具 STARTER 中创建项目 

 调试手册 
84 开机调试手册, (IH1), 01/2013, 6SL3097-4AF00-0RP3 

 做什么？ 如何做？ 注释 

2. 添加单个的驱动 

 

1. 双击项目树形图中的“Add individual drive unit”。 
以下设置已预先设定好： 

– Device type: CU320-2 PN 

– 版本： 4.5 或更高版本 

– 在线访问：IP 

– 地址： 169.254.11.22 

2. 需要时修改此设置。 

 

总线地址的说明： 

在首次调试时无须设置

控制单元的 
PROFINET 地址。 

控制单元 TCP/IP 地址

的缺省值为 
169.254.11.22。 可根

据需要对地址进行修

改。 

3 配置驱动设备 在项目创建好之后，必须对驱动设备进行配置。 在后面的章节中列举了几个示

例。 
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2.3.2 在线创建项目 

如需在线查找 PROFIBUS 或 PROFINET 总线节点，必须将驱动设备和 PG/PC 通过 
PROFIBUS 或 PROFINET 连接在一起。  

表格 2- 2 在调试工具 STARTER 中的查询步骤示例 

 做什么？ 如何做？ 

1. 创建新项目 1. 调用菜单“Project > New with wizard”。 
2. 点击“Find drive units online”。 
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 做什么？ 如何做？ 

1.1 输入项目数据 1. 输入以下项目数据： 

– Project name: Project_1，可自由选择 

– Author: 可自由选择 

– Storage loc.: 可自由选择 

– Comment: 可自由选择 

2. 需要时修改相应的项目数据。 

 

2 设置 PG/PC 接
口 

在此窗口中可以设置 PG/PC 接口。 
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 做什么？ 如何做？ 

2.1 选择访问点 可以通过 STARTER 或 STEP 7 来访问设备。 
1. 第 2 步时点击“Access point”。 
2. 选择可访问节点的访问点。 

 

2.2 选择 PG/PC 接
口 

可以在该窗口中选择、设置和测试接口。 
1. 第 2 步时点击“PG/PC”。 
2. 选择“Access point of the application”和接口设置参数。 

当前选项中没有需要的接口时，可通过按钮“Select”创建其他接口。 
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 做什么？ 如何做？ 

3. 添加驱动设备 此处搜索到的节点将在预览窗口显现。  

使用按钮“Update View”可更新预览。  

 

4. 摘要 项目现已创建。 
1. 点击“Complete”。 

 

5. 配置驱动设备 在项目创建好之后，必须对驱动设备进行配置。 在后面的章节中列举了几个示

例。 



 调试 
 2.4 书本型伺服控制的首次调试 

调试手册 
开机调试手册, (IH1), 01/2013, 6SL3097-4AF00-0RP3 89 

2.4 书本型伺服控制的首次调试 
在本章节中通过示例说明首次调试时所有必须进行的配置、参数设置以及测试。 调试是

使用调试工具 STARTER 进行的。  

开机调试的前提 

● 满足了 开机调试的前提 (页 18)。 

● 调试检查表 (页 19)（表格 1-1 和 1-2）都已填写并且各项都已打勾。 

● 已安装并激活了调试工具 STARTER。 

– 参见 STARTER 安装 DVD 盘上的 “Readme”文件 

● 驱动系统按照规定进行布线。 

● PG/PC 和驱动系统之间的通讯已经准备好。 

● 控制单元的电源（DC 24 V）已接通。 

2.4.1 任务 

调试的驱动设备包含以下组件： 

表格 2- 3 组件一览 

名称 组件 订货号 

控制与电源 

控制单元 1 控制单元 320-2 DP 6SL3040-1MA00-0AA1 

调节型电源模块 调节型电源模块 16 kW 6SL3130-7TE21-6AAx 

电源滤波器 调节型接口模块 6SL3100-0BE21-6AB0 

驱动 1 

单轴电机模块 1 单轴电机模块 9 A 6SL3120-1TE21-0AAx 

编码器模块 1.0 SMC20 6SL3055-0AA00-5BAx 

电机 1 同步电机 1FK7061–7AF7x–xxxx 

电机编码器 1 sin/cos 增量式编码器 C/D 
1 Vpp 2048 p/r 

1FK7xxx–xxxxx–xAxx 

编码器模块 1.1 SMC20 6SL3055-0AA00-5BAx 
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名称 组件 订货号 

外部编码器 增量式编码器 
sin/cos 1 Vpp 4096 p/r 

- 

驱动 2 

单轴电机模块 2.0 单轴电机模块 18 A 6SL3120-1TE21-8AAx 

电机 2 异步电机 1PH7103–xNGxx–xLxx 

编码器模块 2 SMC20 6SL3055-0AA00-5BAx 

电机编码器 2 sin/cos 增量式编码器 
1 Vpp 2048 p/r 

1PH7xxx–xMxxx–xxxx 

电源模块和两个驱动的使能信号都应通过 PROFIBUS 传输。 

● 调节型电源模块的报文  
报文 370： 电源，单字（word） 

● 驱动 1 的报文  
标准报文 4： 转速控制，2 个位置编码器 

● 驱动 2 的使能信号  
标准报文 3： 转速控制，1 个位置编码器 

 

 说明 
其它有关报文类型的说明参见 SINAMICS S120 驱动功能手册或 SINAMICS S120/S150 
参数手册。  

 



 调试 
 2.4 书本型伺服控制的首次调试 

调试手册 
开机调试手册, (IH1), 01/2013, 6SL3097-4AF00-0RP3 91 

2.4.2 组件布线（示例） 

下图展示了组件结构及其相应的布线方式。 DRIVE-CLiQ 布线以粗线表示。 

 

图 2-16 组件布线（示例） 

其它有关布线和编码器系统连接的说明参见设备手册。 
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2.4.3 调试示例中的信号流 

 

图 2-17 伺服控制调试示例中的信号流（第 1 部分） 

 

图 2-18 伺服控制调试示例中的信号流（第 2 部分） 
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2.4.4 使用 STARTER 进行调试（示例） 

下表中举例说明了使用调试工具 STARTER 进行调试的步骤。 

表格 2- 4 使用调试工具 STARTER 进行调试的步骤（示例） 

 做什么？ 如何做？ 注释 

1. 创建新项目 1. 调用菜单“Project > New...”。 
2. 在对话框中“New Project”中输入名称。 
3. 点击“OK”。 

- 

2. 自动配置 1. 调用菜单“Project > Connect to selected target 
device”。 
因为现在项目中无任何设备，调试工具 STARTER 提
供查找可访问的接口。 

2. 点击“OK”。 
3. 勾选一台可访问的驱动设备。 
4. 点击“Accept”。  

该驱动对象被传送到项目窗口中。 
5. 重新调用菜单“Project” > “Connect to selected target 

device ”。  
现在已和驱动设备在线连接。 

6. 双击“Automatic configuration”。 点击

“Configuration”。 
7. 在自动调试期间，向导会为您提供可以选择的驱动对

象类型。 所有组件都选择缺省设置“SERVO”。 
8. 点击“Create”。 
9. 在自动配置结束后，会提供转至离线或保持在线选

项。 选择“GO OFFLINE ”。 

- 

3. 配置电源模块 1. 双击项目树形图中的“Infeeds” 
2. 双击创建的电源模块 
3. 点击黄色按钮“Wizard...” 
4. 根据 3.2 检查自动设置并输入附加数据（如设备标识

符等）。 

 

- 

提示： 

由于在出厂设置中 p7826 = 1，因此在首次启动所配置的 DRIVE-CLiQ 组件时，固件会自动升级到存储卡

上的固件版本。 该过程会持续几分钟。与此同时该组件上 READY LED 以绿色/红色闪烁，控制单元上的 
LED 以橙色闪烁（0.5 Hz）。 在所有升级结束后，控制单元上的 READY LED 以橙色（2 Hz）闪烁，完

成更新的组件的 READY LED 以绿色/红色闪烁（2 Hz）。 重新给组件上电后，固件才会激活。 
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 做什么？ 如何做？ 注释 

与驱动设备相连，但在自动配置期间未通过 DRIVE-CLiQ 和控制单元实现通讯的电源模块必须手动对其进

行配置，并将其传送至驱动拓扑中。 这类设备只可在离线模式下使用。 

3.1 添加电源模块 如果控制单元上没有任何 DRIVE-CLiQ 连接，则必须借

助向导手动输入电源数据。 
1. 双击项目树形图中的“Infeeds”。 
2. 双击“Insert infeeds”。 
3. 命名电源模块。 
4. 选择类型。 
5. 点击“OK”。 

如果电网环境或直流母

线的组件发生变化，则

应再次进行电网/直流母

线识别。 

3.2 电源模块 1. 输入组件名称。 
2. 选择电源电压范围。 
3. 选择冷却方式。 
4. 选择结构类型。 
5. 选择列表中只列出了可用的组件。 
6. 从列表中选择所需电源。 
7. 点击“Next >”。 

- 

3.3 供电的其它数据 1. 首次通电时激活电网/直流母线识别。 
2. 接收来自上一个窗口的设备输入电压。  

额定电网频率会自动测定。 
3. 要注意已经勾选了选项“Line filter available”。 
4. 在书本型电源模块上选择电源滤波器。  

可以选择多个不同类型的电源滤波器。 
5. 必要时输入并联的电源模块的数量。 
6. 必要时选择电压监控模块。 
7. 必要时选择外部制动模块。 
8. 必要时选择多个电源模块的主/从运行。 
9. 点击“Next >”。 

- 

3.4 过程数据交换 
（电源模块） 

有三种通讯报文可供选择： 370、371 和 999。 
1. 选择所需的报文（例如 370）。 
2. 点击“Next >”。 

- 

3.6 配置总结报告 电源模块的配置结束。 屏幕上会显示配置总结报告。 
1. 点击“Complete”。 

电源模块的配置数据可

以复制并接着粘贴到一

个文本处理程序中，以

便日后创建机器文档。 
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 做什么？ 如何做？ 注释 

小心 
如果电源模块是由控制单元控制，而不是由电机模块控制，则电源模块的就绪信号 r0863.0 必须和驱动的

参数 p0864 “电源就绪”通过一个数字量输入/输出互联在一起。 如不加注意，可能导致电源模块损坏。 

4. 配置驱动 驱动必须在离线模式下进行配置。 向导中会自动显示从

电子铭牌中得到的数据。 
- 

与驱动设备相连，但在自动配置期间未通过 DRIVE-CLiQ 和控制单元实现通讯的驱动必须手动对其进行配

置，并将其传送至驱动拓扑中。这类设备只可在离线模式下使用。 在该情况下请执行步骤 4.1。  
如果自动配置已经创建了驱动，点击驱动下的“Configuration”>“Configure DDS...”。 继续执行步骤 4.2。 
功率单元数据的设置和带 DRIVE-CLiQ 接口的电机数据均已在电子铭牌中预设。 

4.1 添加驱动 1. 双击项目树形图中的“Drives”。 
2. 双击条目“Insert Drives”。 
3. 为驱动命名。 
4. 为驱动对象选择“SERVO”驱动类型。 
5. 点击“OK”。 

- 

4.2 控制结构 1. 选择功能模块。 
2. 选择所需的控制方式。 
3. 点击“Next >”。 

- 

4.3 功率单元 1. 为功率单元命名。 
2. 选择直流输入电压。 
3. 选择冷却方式。 
4. 选择结构类型。 

选择列表中只列出了可用的组件。 
5. 从列表中选择所需的功率单元。 
6. 点击“Next >”。 

- 

4.4 配置功率单元的 
BICO 互联 

如果使用的电源模块上没有建立 DRIVE-CLiQ 连接，系

统会提示您连接运行信号。 
1. 在“Infeed in operation”中设置 p0864，将电源模块的

运行反馈信息互联至数字输入端的二进制互联输出。 
2. 点击“Next >”。 

- 

5 配置电机 1. 给电机命名（例如：电气设备标识）。 
2. 如果电机自带一个 DRIVE-CLiQ 接口，请勾选该项。 
3. 点击“Next >”，执行步骤 5.2。 

电机数据在调试时就已经自动传送到控制单元中了。 

您可以从电机列表中选

择一个标准电机或手动

输入电机数据。 接着可

以选择电机类型。 
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 做什么？ 如何做？ 注释 

1. 如果您需要使用标准电机，请勾选“Select standard 
motor from list”。 

2. 从“Motor type”列表中选择标准电机类型。 
3. 接着勾选您的电机。 
4. 点击“Next >”。  

还需额外查询每种电机类型的电机特性，接着执行步

骤 5.2。 

1. 如果所需要的电机不在标准列表中，选择“Enter motor 
data”。 

2. 在“Motor type”列表中勾选电机类型。 
3. 点击“Next >”。 

1. 根据电机铭牌输入电机数据。 

1. 您也可以在输入电机数据后在首次调试时进行一次电

机识别。 

5.1 配置电机数据 

对于某些电机类型也可以使用电机列表中的电机数据。  
1. 点击模板。 
2. 根据向导中操作，点击“Next >”。 
3. 如数据已知，您可以输入电机和驱动支路的机械/电气

数据或 PE 主轴的数据。 
4. 请选择是否需要为驱动计算电机数据/控制器数据。 

如果未输入机械数据，

STARTER 会根据铭牌

数据估算出数据。 同样 
STARTER 也会根据铭

牌数据或者通过自动的

电机数据识别估算出等

效电路图数据。 

5.2 配置电机抱闸 1. 如果没有使用电机抱闸，点击“Next >”。 
或 

2. 如果使用了电机抱闸，请在对话框中选择抱闸接着对

其进行配置。 
3. 点击“Next >”。 

详细信息：参见 
SINAMICS S120 驱动

功能手册。 

最多可以连接 3 个编码器。  
1. 如果使用了 DRIVE-CLiQ 编码器，请勾选相应的选

项。 
2. 点击“Next >”。 

STARTER 可以自动识别和配置编码器。 

5.3 配置编码器 

1. 也可以使用标准编码器。 从列表中选择编码器。 
2. 点击“Next >”。 

如果使用未在列表中的

编码器类型，也可以手

动输入数据。  

双击“Details”，可以查

看从编码器列表中选择

的编码器的数据。 
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 做什么？ 如何做？ 注释 

也可以自定义编码器。 
1. 选择“Enter data”。 
2. 点击“Encoder data”。 
3. 选择“Measuring system”。 
4. 输入所需的数据，并点击“OK”。 
5. 点击“Next >”。 

5.4 输入编码器数据 1. 在输入栏中输入编码器数据，并点击“OK”。 
2. 如果步骤 5 中已经选择了一个标准电机，接着执行步

骤 5.6。 

其他编码器按以上方式

输入。 

5.5 驱动功能 1. 如果还没有选择标准电机，此处选择工艺应用。 
2. 根据需要激活电机数据识别。 

应用的选择会影响开环

和闭环控制参数的计

算。  

5.6 配置过程数据交

换 
1. 您可以从不同的报文中选择 PROFIdrive 报文来进行

通讯。 
- 

5.7 配置总结报告 驱动线路的配置已结束。 屏幕上会显示配置总结报告。 
1. 点击“Complete”。 

驱动设备的配置数据可

以复制并接着粘贴到一

个文本处理程序中，以

便日后创建机器文档。 

5.8 配置驱动功能 1. 在项目树中点击 Drive\Drive xy\Configuration。 
2. 点击按钮“Function module / Technology package”。 

在选项卡“Function module ”下，您可以激活一个或多

个功能模块。 
3. 点击“OK”。 

- 

5.9 摘要 驱动数据可以复制并接着粘贴到一个文本处理程序中，

以便日后创建机器文档。 
- 

提示 

基准参数和极限值可以通过在调试工具 STARTER 中设置 p0340 = 1 来防止被自动覆盖：Drive > 
Configuration > “Reference parameters/blocked list”。 

6 使能信号和 
BICO 互联 

电源模块和两个驱动的使能信号都应通过控制单元的数

字输入端传输。 
- 



调试  
2.4 书本型伺服控制的首次调试 

 调试手册 
98 开机调试手册, (IH1), 01/2013, 6SL3097-4AF00-0RP3 

 做什么？ 如何做？ 注释 

电源接触器 1. 进行以下电源接触器设置： 

– p0728.8 = 1 将 DI/DO 设置为输出端 

– p0738 =0863.1 电源接触器 ON 

– p0860 = 0723.9 电源接触器，反馈信号 

电源接触器应由驱动对

象 infeed_1 来控制。 

参见功能图[8834] 

可以在 “Function > 
Line contactor control”
窗口中检查互联连接。 

6.1 

 

1. 调用菜单“Project” > “Connect to selected target 
device ”（在线模式）。 

2. 调用菜单“Target system > Load > load CPU/drive 
unit to target device...”。 

7. 备份设备中的参

数 

1. 在项目树形图中勾选驱动设备。 
2. 调用菜单“Target system > Copy from RAM to 

ROM”。 
（将数据备份到存储卡上） 

在驱动设备上点击鼠标

左键（SINAMICS 
S120）。 

8. 运转电机 可通过调试工具 STARTER 中的控制面板运转电机。  

控制面板位于项目导航器“Drive unit > Drive > 
Commissioning > Control board”下。 

有关控制面板的其它信

息参见入门指南。 

控制面板会提供控制字 
1（STW1）和转速设定

值 1（NSOLL）。 

有关电网/直流母线识别

的其它信息参见 
SINAMICS S120 驱动

功能手册。 

调试工具 STARTER 中的诊断方法 

选择 Component > Diagnosis > Control/status words 

● 控制/状态字 

● 状态参数 

● 缺少使能信号 
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2.5 书本型矢量 V/f 控制首次调试 
在本章节中通过示例说明首次调试时所有必须进行的配置、参数设置以及测试。 调试是

使用调试工具 STARTER 进行的。  

开机调试的前提 

● 满足了 开机调试的前提 (页 18)。 

● 调试检查表 (页 19)（表格 1-1 和 1-2）都已填写并且各项都已打勾。 

● 已安装并激活了调试工具 STARTER。 

– 参见 STARTER 安装 DVD 盘上的 “Readme”文件 

● 驱动系统按照规定进行布线。 

● PG/PC 和驱动系统之间的通讯已经准备好。 

● 控制单元的电源（DC 24 V）已接通。 

2.5.1 任务 

现在要对采用“矢量 V/f”控制的“书本型”驱动进行首次调试，驱动包含的组件有： 

表格 2- 5 组件一览 

名称 组件 订货号 

控制与电源 

控制单元 控制单元 320-2 DP 6SL3040-1MA00-0AA1 

非调节型电源模块 非调节型电源模块 16 kW 6SL3130-6TE21-6Axx 

电源滤波器组件包 16 kW 电源滤波器和进线电抗器 6SL3100-0BE21-6AB0 

驱动 1 

电机模块 单轴电机模块 9 A 6SL3120-1TE21-0Axx 

电机 异步电机 1PH8083-1xF2x-xxxx 

驱动 2 

电机模块 单轴电机模块 9 A 6SL3120-1TE21-0Axx 

电机 异步电机 1PH8083-1xF2x-xxxx 

电源和驱动的使能信号都应通过端子传输。 
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2.5.2 组件布线（示例） 

下图展示了组件结构及其相应的布线方式。 DRIVE-CLiQ 布线以粗线表示。 

 

图 2-19 组件布线（示例） 

其它有关布线和编码器系统连接的说明参见设备手册。 
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2.5.3 调试示例中的信号流 

 

图 2-20 采取 V/f 控制的书本型设备的信号流 
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2.5.4 使用 STARTER 进行调试（示例） 

下表中举例说明了使用调试工具 STARTER 进行调试的步骤。 

表格 2- 6 调试步骤（示例） 

 做什么？ 如何做？ 注释 

1. 创建新项目 1. 调用菜单“Project > New...”。 
2. 在对话框中“New Project”中输入名称。 
3. 点击“OK”。 

- 

2. 自动配置 1. 调用菜单“Project > Connect to selected target 
device”。 
因为现在项目中无任何设备，STARTER 提供查找可

访问的接口。 
2. 点击“OK”。 
3. 勾选一台可访问的驱动设备。 
4. 点击“Accept”。  

该驱动设备被传送到项目窗口中。 
5. 重新调用菜单“Project” > “Connect to selected target 

device ”。 
现在已和驱动设备在线连接。 

6. 双击“Automatic configuration”。 点击

“Configuration”。 
7. 在自动调试期间，向导会为您提供可以选择的驱动对

象类型。 所有组件都选择缺省设置“Vector”。 
8. 点击“Create”。 
9. 在自动配置结束后，会提供转至离线或保持在线选

项。 选择“GO OFFLINE ”。 

- 

 

3.  配置电源模块 1. 双击项目树形图中的“Infeeds”。 
2. 双击创建的电源模块。 
3. 点击黄色按钮“Wizard...”。 
4. 根据 3.2 检查自动设置并输入附加数据（如设备标识

符等）。 

- 

提示： 

由于在出厂设置中 p7826 = 1，因此在首次启动所配置的 DRIVE-CLiQ 组件时，固件会自动升级到存储卡

上的固件版本。 该过程会持续几分钟。与此同时该组件上 READY LED 以绿色/红色闪烁，控制单元上的 
LED 以橙色闪烁（0.5 Hz）。 在所有升级结束后，控制单元上的 READY LED 以橙色（2 Hz）闪烁，完

成更新的组件的 READY LED 以绿色/红色闪烁（2 Hz）。 必须给组件重新上电，固件才生效。 
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 做什么？ 如何做？ 注释 

与驱动设备相连，但在自动配置期间未通过 DRIVE-CLiQ 和控制单元实现通讯的电源模块必须手动对其进

行配置，并将其传送至驱动拓扑中。这类设备只可在离线模式下使用。 

3.1 添加电源模块 如果控制单元上没有任何 DRIVE-CLiQ 连接，则必须借

助向导手动输入电源数据。 
1. 双击项目树形图中的“Infeeds”。 
2. 双击“Insert infeeds”。 
3. 命名电源模块。 
4. 选择类型。 
5. 点击“OK”。 

如果电网环境或直流母

线的组件发生变化，则

应再次进行电网/直流母

线识别。 

3.2 电源模块 1. 输入组件名称。 
2. 选择电源电压范围。 
3. 选择冷却方式。 
4. 选择结构类型。 

选择列表中只列出了可用的组件。 
5. 从列表中选择所需电源。 
6. 点击“Next >”。 

- 

3.3 供电的其它数据 1. 首次通电时激活电网/直流母线识别。 
2. 接收来自上一个窗口的设备输入电压。 

额定电网频率会自动测定。 
3. 必要时输入并联的电源模块的数量。 
4. 必要时选择电压监控模块。 
5. 必要时选择外部制动模块。 
6. 点击“Next >”。 

- 

3.4 过程数据交换 
（电源模块） 

有三种通讯报文可供选择：370、371 和 999。 
1. 选择所需的报文。 
2. 点击“Next >”。 

- 

3.5 配置总结报告 电源模块的配置结束。 屏幕上会显示配置总结报告。 
1. 点击“Complete”。 

电源模块的配置数据可

以复制并接着粘贴到一

个文本处理程序中，以

便日后创建机器文档。 

注意 

如果电源模块是由另一个控制单元控制，则电源模块的就绪信号必须和驱动的参数 p0864 “电源就绪”通过

一个数字量输入/输出互联在一起。 如不加注意，可能导致电源模块损坏。 
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 做什么？ 如何做？ 注释 

4. 配置驱动 驱动必须在离线模式下进行配置。 向导中会自动显示从

电子铭牌中得到的数据。 
- 

与驱动设备相连，但在自动配置期间未通过 DRIVE-CLiQ 和控制单元实现通讯的驱动必须手动对其进行配

置，并将其传送至驱动拓扑中。这类设备只可在离线模式下使用。 在该情况下请执行步骤 4.1。  
如果自动配置已经创建了驱动，点击驱动下的“Configuration”>“Configure DDS...”。 继续执行步骤 4.2。 
功率单元数据的设置和带 DRIVE-CLiQ 接口的电机数据均已在电子铭牌中预设。 

4.1 添加驱动 1. 双击项目树形图中的“Drives”。 
2. 双击条目“Insert Drives”。 
3. 为驱动命名。 
4. 为驱动对象选择“VECTOR”驱动类型。 
5. 点击“OK”。 

- 

4.2 控制结构 1. 选择功能模块。 
2. 将控制方式切换到“V/f control”。 
3. 选择所需的控制方式。 
4. 点击“Next >”。 

- 

4.3 功率单元 1. 为功率单元命名。 
2. 选择直流输入电压。 
3. 选择冷却方式。 
4. 选择结构类型。 

选择列表中只列出了可用的组件。 
5. 选择所需的功率单元。 
6. 点击“Next >”。 

- 

4.4 配置功率单元的 
BICO 互联 

如果使用的电源模块上没有建立 DRIVE-CLiQ 连接，系

统会提示您连接运行信号。 
1. 在“Infeed in operation”中设置 p0864，将电源模块的

运行反馈信息互联至数字输入端的二进制互联输出。 
2. 点击“Next >”。 

- 

4.5 配置附件数据 可以在该窗口中选择以下附件  

• 不同的输出滤波器 

• 电压监控模块 

• 并联电路 

关闭该窗口后，电机模

块的配置结束。 

注意 

如果连接了正弦滤波器，则应在此时将其激活，否则可能会损坏该滤波器！ 
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 做什么？ 如何做？ 注释 

5 驱动设置 可以选择电机标准(IEC / NEMA)和功率单元的应用（负

载循环）。 
- 

1. 给电机命名（例如：电气设备标识）。 
2. 如果电机自带一个 DRIVE-CLiQ 接口，请勾选该项。 
3. 点击“Next >”。 

电机数据在调试时就已经自动传送到控制单元中了。 

1. 如果您需要使用标准电机，请勾选“Select standard 
motor from list”。 

2. 从“Motor type”列表中选择标准电机类型。 
3. 接着勾选您的电机。 
4. 点击“Next >”。 

5.1 配置电机 

1. 如果所需要的电机不在标准列表中，选择“Enter 
motor data”。 

2. 在“Motor type”列表中勾选电机类型。 
3. 点击“Next >”。 

您可以从电机列表中选

择一个标准电机或手动

输入电机数据。 接着可

以选择电机类型。 

1. 根据电机铭牌输入电机数据。 

1. 您也可以在输入电机数据后在首次调试时进行一次电

机识别。 

5.2 配置电机数据 

对于某些电机类型也可以使用电机列表中的电机数据。 
1. 点击模板。 
2. 点击“Next >”，继续操作。 
3. 如数据已知，您可以输入电机和驱动线路的机械/电气

数据或 PE 主轴的数据。 
4. 需要时，您可以选择 Complete calculation of the 

motor / control parameters without equivalent 
circular diagram data。 

5. 本例中选择简单驱动。 

如果未输入机械数据，

STARTER 会根据铭牌

数据估算出数据。同样 
STARTER 也会根据铭

牌数据或者通过自动的

电机数据识别估算出等

效电路图数据。 

5.3 配置电机抱闸 1. 如果没有使用电机抱闸，点击“Next >”。 
或 

2. 当您使用电机抱闸时，您可以在该窗口中选择和配置

抱闸。 
3. 点击“Next >”。 

详细信息参见 
SINAMICS S120 驱动

功能手册。 
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 做什么？ 如何做？ 注释 

最多可以连接 3 个编码器。  
1. 如果使用了一个 DRIVE-CLiQ 编码器，请勾选相应的

选项。 
2. 点击“Next >”。 

STARTER 可自动识别和配置编码器。 

1. 也可以使用标准编码器。 
从列表中选择编码器。 

2. 点击“Next >”。 

5.4 配置编码器 

也可以自定义编码器。 
1. 选择“Enter data”。 
2. 点击“Encoder data”。 
3. 选择“Measuring system”。 
4. 输入所需的数据，并点击“OK”。 
5. 点击“Next >”。 

如果使用未在列表中的

编码器类型，也可以根

据章节 4.8 手动输入数

据。  

双击“Details”，可以查

看从编码器列表中选择

的编码器的数据。 

5.5 输入编码器数据 1. 在输入栏中输入编码器数据，并点击“OK”。 其他编码器按以上方式

输入。 

5.6 配置驱动功能 可选择特定的工艺应用和电机数据识别方式。 应用的选择会影响开环

和闭环控制参数的计

算。 

5.7 配置过程数据交

换 
1. 您可以从不同的报文中选择 PROFIdrive 报文来进行

通讯。 
- 

5.8 重要参数 在该窗口中，您可以设定限值。  
其中比如要注意驱动线路的机械限制条件。 

- 

5.9 配置总结报告 驱动线路的配置已结束。 屏幕上会显示配置总结报告。 
1. 点击“Complete”。 

驱动设备的配置数据可

以复制并接着粘贴到一

个文本处理程序中，以

便日后创建机器文档。 

提示 

基准参数和极限值可以通过在调试工具 STARTER 中设置 p0340 = 1 来防止被自动覆盖。 在调试工具 
STARTER 中选择 Drive > Configuration > blocked list。 
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 做什么？ 如何做？ 注释 

6. 使能信号和 
BICO 互联 

电源模块和两个驱动的使能信号都应通过控制单元的数

字输入端传输。 
1. 点击项目树形图中的“Drive unit \ Control Unit \ 

Inputs/Outputs”。 
2. 选择“Bidirectional digital inputs/outputs”。 

- 

电源接触器 1. 进行以下电源接触器设置： 

– p0728.8 = 1 将 DI/DO 设置为输出端 

– p0738 =0863.1 激活电源接触器 

– p0860 = 0723.9 电源接触器，反馈信号 

电源接触器应通过驱动

对象(DO) infeed_1 进行

控制。 

见功能图 [8834] 

可以在 “Function > Line 
contactor control”窗口

中检查互联连接。 

6.1 

 

电机模块使能 • 电机模块(drive_1)的使能信号 

p0840 = 722.0 ON/OFF1 

p0844 = 722.1 1. OFF2 

p0845 = 1 2. OFF2 

p0848 = 722.2 1. OFF3 

p0849 = 1 2. OFF3 

p0852 = 722.3 使能运行 

见功能图 [2501] 6.2 

 
 



调试  
2.5 书本型矢量 V/f 控制首次调试 

 调试手册 
108 开机调试手册, (IH1), 01/2013, 6SL3097-4AF00-0RP3 

 做什么？ 如何做？ 注释 

斜坡函数发生器 • 斜坡函数发生器 

p1140 = 1 斜坡函数发生器使能 

p1141 = 1 启动斜坡函数发生器 

p1142 = 1 设定值使能 

见功能图 [3060] 6.3 

 

 

设定值 • 给定设定值 

p1001 = 40 固定设定值 1 

见功能图 [3010] 6.4 

 

7 备份设备中的参

数 
1. 在项目树形图中勾选驱动设备。 
2. 调用右键菜单中的“Connect to target device”。 
3. 接着调用右键菜单中的“Target device > Load to 

target device”。 
选项“After the load Copy from RAM to ROM”已勾

选。 
点击“OK”，确认备份。 
或者 

4. 调用右键菜单中的“Target device > Copy from RAM 
to ROM”。 

将鼠标放在驱动设备

(SINAMICS S120)上并

点击右键。 
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 做什么？ 如何做？ 注释 

8 运转电机 可通过调试工具 STARTER 中的控制面板运转电机。 

• 在电源模块给出脉冲使能后且 
激活了电网/直流母线识别后执行此项识别。 接着电

源模块就投入运行。 

• 在脉冲使能后执行一次电机数据识别，如果该功能已

激活。 

• 重新给出脉冲使能后，执行一次旋转电机的优化，如

果该功能已激活。 

有关控制面板的其它信

息参见入门指南。 

进行电机数据识别时，

电机通电，可能会发生

旋转，最大幅度达四分

之一圈。 

有关电网/直流母线识别

和电机数据识别的其它

信息，参见 
SINAMICS S120 驱动

功能手册。 

调试工具 STARTER 中的诊断方法 

选择 Component > Diagnosis > Control/status words 

● 控制/状态字 

● 状态参数 

● 缺少使能信号 
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2.6 装机装柜型矢量控制首次调试 
在本章节中通过示例说明首次调试时所有必须进行的配置、参数设置以及测试。 调试是

使用调试工具 STARTER 进行的。  

开机调试的前提 

● 满足了 开机调试的前提 (页 18)。 

● 调试检查表 (页 19)（表格 1-1 和 1-2）都已填写并且各项都已打勾。 

● 已安装并激活了调试工具 STARTER。 

– 参见 STARTER 安装 DVD 盘上的 “Readme”文件 

● 驱动系统按照规定进行布线。 

● PG/PC 和驱动系统之间的通讯已经准备好。 

● 控制单元的电源（DC 24 V）已接通。 

2.6.1 任务 

现在要对采用“矢量”控制的“装机装柜型”驱动进行首次调试，驱动包含的组件有： 

表格 2- 7 组件一览 

名称 组件 订货号 

控制与电源 

控制单元 控制单元 320-2 PN 6SL3040-1MA01-0AA1 

调节型电源模块 调节型电源模块 380 kW / 
400 V 

6SL3330–7TE36–1AAx 

调节型接口模块 调节型接口模块 6SL3300–7TE38–4Ax0 

驱动 1 

电机模块 电机模块 380 A 6SL3320–1TE33–8AAx 
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名称 组件 订货号 

电机 异步电机 

• 不带制动器 

• 带有编码器 

类型：1PL6226-xxFxx-xxxx 
额定电压 = 400 V 
额定电流 = 350 A 
额定功率 = 200 kW 
额定频率 = 59.10 Hz 
额定转速 = 1750 rpm 
冷却方式 = 自然冷却 
HTL 编码器, 1024 p/r, A/B, R 

驱动 2 

电机模块 电机模块 380 A 6SL3320–1TE33–8AAx 

电机 异步电机 

• 不带制动器 

• 带有编码器 

类型：1PL6226-xxFxx-xxxx 
额定电压 = 400 V 
额定电流 = 350 A 
额定功率 = 200 kW 
额定频率 = 59.10 Hz 
额定转速 = 1750 rpm 
冷却方式 = 自然冷却 
HTL 编码器, 1024 p/r, A/B, R 

电源和驱动的使能信号都应通过端子传输。 
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2.6.2 组件布线（示例） 

下图展示了组件结构及其相应的布线方式。 DRIVE-CLiQ 布线以粗线表示。  

 

图 2-21 组件布线（示例） 

1) 电源监控模块上的 X500 

其它有关布线和编码器系统连接的说明参见设备手册。 
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2.6.3 调试示例中的信号流 

 

图 2-22 装机装柜型调试示例中的信号流 
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2.6.4 使用 STARTER 进行调试（示例） 

下表中举例说明了使用调试工具 STARTER 进行调试的步骤。 

表格 2- 8 调试步骤（示例） 

 做什么？ 如何做？ 注释 

1. 创建新项目 1. 调用菜单“Project > New...”。 
2. 在对话框中“New Project”中输入名称。 
3. 点击“OK”。 

- 

2. 自动配置 1. 调用菜单“Project > Connect to selected target 
device”。 
因为现在项目中无任何设备，STARTER 提供查找可

访问的接口。 
2. 点击“OK”。 
3. 勾选一台可访问的驱动设备。 
4. 点击“Accept”。  

该驱动设备被传送到项目窗口中。 
5. 重新调用菜单“Project” > “Connect to selected target 

device ”。 
现在已和驱动设备在线连接。 

6. 双击“Automatic configuration”。 点击

“Configuration”。 
7. 在自动调试期间，向导会为您提供可以选择的驱动对

象类型。所有组件都选择缺省设置“Vector”。 
8. 点击“Create”。 
9. 在自动配置结束后，会提供转至离线或保持在线选

项。 选择“GO OFFLINE ”。 

- 

3.  配置电源模块 1. 双击项目树形图中的“Infeeds”。 
2. 双击创建的电源模块。 
3. 点击黄色按钮“Wizard...”。 
4. 根据 3.2 检查自动设置并输入附加数据（如设备标识

符等）。 

- 

提示： 

由于在出厂设置中 p7826 = 1，因此在首次启动所配置的 DRIVE-CLiQ 组件时，固件会自动升级到存储卡

上的固件版本。 这一过程可能持续数分钟。此时，正在升级的组件上的 READY LED 以绿色/红色闪烁，

控制单元上的 LED 以橙色闪烁(0.5 Hz)。 在所有升级结束后，控制单元上的 READY LED 以橙色（2 
Hz）闪烁，完成更新的组件的 READY LED 以绿色/红色闪烁（2 Hz）。 必须给组件重新上电，固件才生

效。  
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 做什么？ 如何做？ 注释 

与驱动设备相连，但在自动配置期间未通过 DRIVE-CLiQ 和控制单元实现通讯的电源模块必须手动对其进

行配置，并将其传送至驱动拓扑中。这类设备只可在离线模式下使用。 

3.1 添加电源模块 如果控制单元上没有任何 DRIVE-CLiQ 连接，则必须借

助向导手动输入电源数据。 
1. 双击项目树形图中的“Infeeds”。 
2. 双击“Insert infeeds”。 
3. 命名电源模块。 
4. 选择类型。 
5. 点击“OK”。 

如果电网环境或直流母

线的组件发生变化，则

应再次进行电网/直流母

线识别。 

3.2 电源模块 1. 输入组件名称。 
2. 选择电源电压范围。 
3. 选择冷却方式。 
4. 选择结构类型。 

选择列表中只列出了可用的组件。 
5. 从列表中选择所需电源。 
6. 点击“Next >”。 

- 

3.3 供电的其它数据 1. 首次通电时激活电网/直流母线识别。 
2. 接收来自上一个窗口的设备输入电压。 

额定电网频率会自动测定。 
3. 要注意已经勾选了选项“Line filter available”。 
4. 必要时输入并联的电源模块的数量。 
5. 必要时选择外部制动模块。 
6. 必要时选择多个电源模块的主/从运行。 
7. 点击“Next >”。 

- 

3.4 过程数据交换 
（电源模块） 

有三种通讯报文可供选择：370、371 和 999。 
1. 选择所需的报文。 
2. 点击“Next >”。 

- 

3.5 配置总结报告 电源模块的配置结束。 屏幕上会显示配置总结报告。 
1. 点击“Complete”。 

电源模块的配置数据可

以复制并接着粘贴到一

个文本处理程序中，以

便日后创建机器文档。 

小心 
如果电源模块是由控制单元控制，而不是由电机模块控制，则电源模块的就绪信号 r0863.0 必须和驱动的

参数 p0864 “电源就绪”通过一个数字量输入/输出互联在一起。如不加注意，可能导致电源模块损坏。 
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 做什么？ 如何做？ 注释 

4. 配置驱动 驱动必须在离线模式下进行配置。向导中会自动显示从

电子铭牌中得到的数据。 
- 

与驱动设备相连，但在自动配置期间未通过 DRIVE-CLiQ 和控制单元实现通讯的驱动必须手动对其进行配

置，并将其传送至驱动拓扑中。这类设备只可在离线模式下使用。 在该情况下请执行步骤 4.1。  

如果自动配置已经创建了驱动，点击驱动下的“Configuration”>“Configure DDS...”。 继续执行步骤 4.2。 
功率单元数据的设置和带 DRIVE-CLiQ 接口的电机数据均已在电子铭牌中预设。 

4.1 添加驱动 1. 双击项目树形图中的“Drives”。 
2. 双击条目“Insert Drives”。 
3. 为驱动命名。 
4. 选择驱动对象类型“Vektor”。 
5. 点击“OK”。 

- 

4.2 控制结构 1. 必要时选择功能模块。 
2. 选择 n/M 控制 + V/f 控制，I/f 控制。 
3. 选择控制方式“[21]speed control（with encoder）”。 
4. 点击“Next >”。 

- 

4.3 功率单元 1. 为功率单元命名。 
2. 选择直流输入电压。 
3. 选择冷却方式。 
4. 选择结构类型。 
5. 从列表中选择所需的功率单元。 
6. 点击“Next >”。 

- 

4.4 配置功率单元的 
BICO 互联 

如果使用的电源模块上没有建立 DRIVE-CLiQ 连接，系

统会提示您连接运行信号。 
1. 在“Infeed in operation”中设置 p0864，将电源模块的

运行反馈信息互联至数字输入端的二进制互联输出。 
2. 点击“Next >”。 

- 

4.5 功率单元附加数

据 
可以在该窗口中选择以下附件  

• 不同的输出滤波器 

• 电压监控模块 

• 并联电路 

关闭该窗口后，电机模

块的配置结束。 

小心 

如果连接了正弦滤波器，则应在此时将其激活，否则可能会损坏该滤波器！  
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 做什么？ 如何做？ 注释 

5 配置驱动设置 可以选择电机标准(IEC / NEMA)和功率单元的应用（负

载循环）。 
电机数据自动选择和输

入。 

1. 给电机命名（例如：电气设备标识）。 
2. 如果电机自带一个 DRIVE-CLiQ 接口，请勾选该项。 
3. 点击“Next >”。  

电机数据在调试时就已经自动传送到控制单元中了。 

1. 如果您需要使用标准电机，请勾选“Select standard 
motor from list”。 

2. 从“Motor type”列表中选择标准电机类型。 
3. 接着勾选您的电机。 
4. 点击“Next >”。 

5.1 配置电机 

1. 如果所需要的电机不在标准列表中，选择“Enter 
motor data”。 

2. 在“Motor type”列表中勾选电机类型。 
3. 点击“Next >”。 

您可以从电机列表中选

择一个标准电机或手动

输入电机数据。接着可

以选择电机类型。 

1. 根据电机铭牌输入电机数据。 

1. 您也可以在输入电机数据后在首次调试时进行一次电

机识别。 

5.2 配置电机数据 

对于某些电机类型也可以使用电机列表中的电机数据。 
1. 点击模板。 
2. 点击“Next >”，继续操作。 
3. 如数据已知，您可以输入电机和驱动线路的机械数据

或 PE 主轴的数据。 
4. 需要时，您可以选择 Complete calculation of the 

motor / control parameters without equivalent 
circular diagram data。 

5. 本例中选择简单驱动。 

如果未输入机械数据，

STARTER 会根据铭牌

数据估算出数据。同样 
STARTER 也会根据铭

牌数据或者通过自动的

电机数据识别估算出等

效电路图数据。 

5.3 配置电机抱闸 1. 如果没有使用电机抱闸，点击“Next >”。 
2. 当您使用电机抱闸时，您可以在该窗口中选择和配置

抱闸。 
3. 点击“Next >”。 

详细信息：参见 
SINAMICS S120 驱动

功能手册。 

5.4 配置编码器 最多可以连接 3 个编码器。  
1. 如果使用了一个 DRIVE-CLiQ 编码器，请勾选相应的

选项。 
2. 点击“Next >”。 

STARTER 可自动识别和配置编码器。 

如果使用未在列表中的

编码器类型，也可以手

动输入数据。  

双击“Details”，可以查
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 做什么？ 如何做？ 注释 

1. 也可以使用标准编码器。  
从列表中选择编码器。 

2. 点击“Next >”。 

也可以自定义编码器。 
1. 选择“Enter data”。 
2. 点击“Encoder data”。 
3. 选择“Measuring system”。 
4. 输入所需的数据，并点击“OK”。 
5. 点击“Next >”。 

看从编码器列表中选择

的编码器的数据。 

5.5 输入编码器数据 1. 在输入栏中输入编码器数据。 
2. 点击“OK”。 

其他编码器按以上方式

输入。 

5.6 配置驱动功能 可选择特定的工艺应用和电机数据识别方式。 应用的选择会影响开环

和闭环控制参数的计

算。 

5.7 配置过程数据交

换 
您可以从不同的报文中选择 PROFIdrive 报文来进行通

讯。 
1. 本例中选择“[999] Free message frame configuration 

with BICO”。 
2. 点击“Next >”。 

- 

5.8 重要参数 在该窗口中，您可以设定限值。 

其中比如要注意驱动线路的机械限制条件。 

- 

5.9 摘要 驱动线路的配置已结束。 屏幕上会显示配置总结报告。 
1. 点击“Complete”。 

驱动设备的配置数据可

以复制并接着粘贴到一

个文本处理程序中，以

便日后创建机器文档。 

提示 

基准参数和极限值可以通过在调试工具 STARTER 中设置 p0340 = 1 来防止被自动覆盖。 在调试工具 
STARTER 中选择 Drive -> Configuration ->blocked list。 

6. 使能信号和 
BICO 互联 

电源模块和两个驱动的使能信号都应通过控制单元的数

字输入端传输。 
提示： 

如果使用调节型电源模

块，必须为该模块的使

能提供另外一个信号

源，而不是电机模块。 
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 做什么？ 如何做？ 注释 

调节型电源模块 • 调节型电源模块的使能信号： 

p0840 = 722.4 ON/OFF1 

p0844 = 722.5 OFF2 

p0852 = 722.6 使能运行 

见功能图 [8920] 6.1 

 

电机模块使能 • 电机模块(drive_1)的使能信号： 

p0840 = 722.0 ON/OFF1 

p0844 = 722.1 1. OFF2 

p0845 = 1 2. OFF2 

p0848 = 722.2 1. OFF3 

p0849 = 1 2. OFF3 

p0852 = 722.3 使能运行 

p0864 = 863.0 电源运行 

见功能图 [2501] 6.2 

 
 

6.3 配置斜坡函数发

生器 
• 斜坡函数发生器 

p1140 = 1 斜坡函数发生器使能 

p1141 = 1 启动斜坡函数发生器 

p1142 = 1 设定值使能 

见功能图 [3060] 
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 做什么？ 如何做？ 注释 

 

 

配置设定值 • 给定设定值： 

p1001 = 0 固定设定值 1 

p1002 = 40 固定设定值 2 

p1020 = r0722 转速固定设定值选择 

r1024 = p1070 固定设定值有效 

通过数字输入端 7 指定

设定值 0（0 信号）或 
40（1 信号），该设定

值将被主设定值 p1070 
使用。 

见功能图 [3010] 

6.4 

7. 将参数载入设备 1. 在项目树形图中勾选驱动设备。 
2. 调用右键菜单中的“Connect to target device”。 
3. 接着调用右键菜单中的“Target device” > “Load to 

target device”。 

将鼠标放在驱动设备上

并点击右键。 
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配置电机温度 此项设置要求 p0340 = 0。 当 p0340 >< 0 时，温度传感

器选项无效。  
1. 您可进行以下设置： 

– 接收电机温度的方式 

– 温度传感器类型 

– 电机过热时的报警和故障响应（不降低 I 最大）。 

– 传感器故障时的故障报警 

– 延时为 0.100 s 

– 报警阈值为 120.0 C 

– 故障阈值为 155.0 °C 

 8. 
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 做什么？ 如何做？ 注释 

9. 备份设备中的参

数 
1. 在项目树形图中勾选驱动设备。 
2. 调用右键菜单中的“Connect to target device”。 
3. 接着调用右键菜单中的“Target device > Load to 

target device”。  
选项“After the load Copy from RAM to ROM”已勾

选。  
点击“OK”，确认备份。 
或者 

4. 调用右键菜单中的“Target device > Copy from RAM 
to ROM”。 

将鼠标放在驱动设备

(SINAMICS S120)上并

点击右键。 

10 运转电机 可通过调试工具 STARTER 中的控制面板运转电机。  

• 在电源模块给出脉冲使能后且激活了电网/直流母线识

别后执行此项识别。 接着电源模块就投入运行。 

• 在脉冲使能后执行一次电机数据识别，如果该功能已

激活。 

• 重新给出脉冲使能后，执行一次旋转电机的优化，如

果该功能已激活。 

有关控制面板的其它信

息参见入门指南。 

进行电机数据识别时，

电机通电，可能会发生

旋转，最大幅度达四分

之一圈。 

有关电网/直流母线识别

和电机数据识别的其它

信息，参见 
SINAMICS S120 驱动

功能手册。 

重要诊断参数（参见 SINAMICS S120/S150 参数手册） 

 

• r0002 电源/驱动运行显示 

• r0046 缺少使能信号，其它信息参见章节“诊断” 
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2.7 模块型矢量交流驱动设备的首次调试 
在本章节中通过示例说明首次调试时所有必须进行的配置、参数设置以及测试。 调试是

使用调试工具 STARTER 进行的。  

开机调试的前提 

● 满足了 开机调试的前提 (页 18)。 

● 调试检查表 (页 19)（表格 1-1 和 1-2）都已填写并且各项都已打勾。 

● 已安装并激活了调试工具 STARTER。 

– 参见 STARTER 安装 DVD 盘上的 “Readme”文件 

● 驱动系统按照规定进行布线。 

● PG/PC 和驱动系统之间的通讯已经准备好。 

● 控制单元的电源（DC 24 V）已接通。 

2.7.1 任务 

现在要调试一台采用矢量控制、转速控制的驱动设备，设备不含 DRIVE-CLiQ 接口和转

速编码器，包含以下组件： 

 

名称 组件 订货号 

控制 

控制单元 控制单元 310-2 DP 6SL3040-1LA00-0AA0 

操作面板 基本操作面板 BOP20（Basic 
Operator Panel） 

6SL3055-0AA00-4BAx 

电源与驱动 

功率模块 功率模块 340 6SL3210-1SB14-xxxx 

电机 异步电机 
（不带 DRIVE-CLiQ 接口） 

1LA7 

调试是使用 BOP20 进行的。 

BOP20 的功能按键应设置为可以执行 ON/OFF 信号和转速设置的操作。 
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2.7.2 组件布线（示例） 

下图展示了组件结构及其相应的布线方式。 

 

图 2-23 组件布线（示例） 

其它有关布线的说明参见设备手册。 

2.7.3 使用 BOP 进行快速调试（示例） 
 

警告  
危险的轴运动引起的危险 
在电机数据识别期间，驱动可能会使电机旋转。  
急停功能在调试时应能正常执行。 必须遵守有关的安全规程，避免人员和设备发生危

险。 
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表格 2- 9 快速调试，用于不带 DRIVE-CLiQ 接口的矢量驱动 

 过程 描述 出厂设置 

将驱动恢复为出厂设置： 

设备调试参数筛选* 

0 就绪 

1 设备配置 

1. p0009 = 30 

30 参数复位 

1 

复位和加载所有参数 

0 无效 

2. p0976 = 1 

1 所有参数恢复为出厂设置 

0 

在大概 15 s 等待时间后，BOP 显示为 35，RDY-LED 显示为绿色。p0009 自动设置为 1，p0976 自动设

置为 0。  

提示： 
一旦 RDY-LED 再次显示绿色，表示出厂设置已恢复，可以开始调试。 

设备调试参数筛选* 

0 就绪 

1 设备配置 

3. p0009 = 1 

30 参数复位 

1 

选择驱动对象类型* 

0 不选择 

1 驱动对象类型 SERVO 

4. p0097 = 2 

2 驱动对象类型 VECTOR 

0 

设备调试参数筛选* 

0 就绪 

5. p0009 = 0 

1 设备配置 

1 

提示： 
等待 10 秒左右。 当 RDY 显示为绿色时，表示基本配置已保存。 要将该状态传送至 ROM 中，长按“p”
键，直至显示屏闪烁。 闪烁停止后，RDY 会从黄色转为绿色，此时传送已结束。 报警 A07991 表示在驱

动 “DO 2” 上电机数据识别已激活。  

输入驱动参数： 
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 过程 描述 出厂设置 

选择驱动对象(DO) 2 ( = VECTOR) 

1 CU 专家列表 

2 驱动专家列表 

6. DO = 2 

选择驱动对象（DO）时，请同时按下 Fn 键和 ↑ 键。  
所选择的驱动对象会显示在左上方。 

1 

驱动调试参数筛选* 

0 就绪 

7. p0010 = 1 

1 快速调试 

1 

电机标准 IEC/NEMA 

0 IEC 电机（SI 单位，例如 kW） 

默认设置： 
电机额定频率(p0310)： 50 Hz 
给定功率因数 cos φ （p0308） 

1 NEMA 电机（US 单位，例如 hp） 

默认设置： 
电机额定频率(p0310)： 60 Hz 
给定有效系数 (p0309) 

8. p0100 = 0 

提示： 
如修改 p0100，则所有的电机额定参数都会被复位。 

0 

电机额定数据 [MDS] 
只当 p0300 < 100 时（第三方电机） 
根据铭牌输入电机额定数据，例如 

p0304[0] 电机额定电压 [MDS] 

p0305[0] 电机额定电流 [MDS] 

p0307[0] 电机额定功率 [MDS] 

p0308[0] 电机额定功率因数 [MDS]（只当 p0100 = 0 时） 

p0309[0] 电机额定有效系数 [MDS]（只当 p0100 = 1 时） 

p0310[0] 电机额定频率 [MDS] 

9. p030X[0] = ... 

p0311[0] 电机额定转速 [MDS] 

- 
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 过程 描述 出厂设置 

p0335[0] 电机冷却方式 [MDS]* 

0: 自然冷却 
1: 强制冷却 
2 水冷 

电机数据识别和旋转测量* 

0 禁用 

1 电机旋转时的电机数据识别 

2 电机静止时的电机数据识别 

10. p1900 = 2 

输出信息 A07991“已激活电机数据识别”。 

2 

驱动调试参数筛选* 

0 就绪 

11. p0010 = 0 

1 快速调试 

RDY 持续亮红色，故障 F07085 表明控制参数被更改。 

1 

参数 p0840[0] 只能通过访问级 p0003 = 3 修改。   

12. p0840[0] = 
r0019.0(DO 1

) 

BI: ON/OFF1 [CDS] 

设置 STW1.0 的信号源（ON/OFF1） 

与控制单元（DO 1）的 r0019.000 互联 

作用： BOP 的信号 ON/OFF1 

0 

13. p1035[0] = 
r0019.0013 

(DO 1) 

BI: 电动电位器设定值升高 [CDS] 

设置用于提高电动电位器设定值的信号源 

与控制单元（DO 1）的 r0019.013 互联 

作用： BOP 的信号，电动电位器设定值升高 

0 

14. p1036[0] = 
r0019.0014 

(DO 1) 

BI: 电动电位器设定值降低[CDS] 

设置用于降低电动电位器设定值的信号源 

与控制单元(DO 1)的 r0019.014 互联 
作用： BOP 的信号，电动电位器设定值降低 

0 
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 过程 描述 出厂设置 

15. p1070[0] = 
r1050 

(DO 63) 

CI: 主设定值 [CDS] 

设置用于转速控制器的转速设定值 1 的信号源 

与独立驱动对象(DO 63)的 r1050.000 互联 
作用： 电动电位器提供转速设定值 

0 

16. 按下“FN”，然后按下“P”。 屏幕显示 41，按下“O”，屏幕显示 31。 

17. 按下“I”启动电机数据识别。 大约 5 秒之后，再次断开驱动，屏幕再次显示 41。 

18. 按下“O”后，屏幕再次显示 31。 此时驱动已运行就绪。 按下“I”接通驱动，按下“↑”键，电机开始加

速。 

19. 存储所有参数 长按 P 键约 5 秒，直至屏幕闪烁。 

* 除了此处提及的选项外，这些参数还有更多的设置选项。 其它设置参见 SINAMICS S120/S150 参数手册

[CDS] 参数取决于指令数据组(CDS)。 数据组 0 是默认设置。 
[DDS] 参数取决于驱动数据组(DDS)。 数据组 0 是默认设置。 
[MDS] 参数取决于电机数据组(MDS)。 数据组 0 是默认设置。 
BI Binector Input 
BO Binector Output 
CI Connector Input 
CO Connector Output 
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2.8 模块型伺服交流驱动设备的首次调试 
在本章节中通过示例说明首次调试时所有必须进行的配置、参数设置以及测试。 调试是

使用调试工具 STARTER 进行的。  

开机调试的前提 

● 满足了 开机调试的前提 (页 18)。 

● 调试检查表 (页 19)（表格 1-1 和 1-2）都已填写并且各项都已打勾。 

● 已安装并激活了调试工具 STARTER。 

– 参见 STARTER 安装 DVD 盘上的 “Readme”文件 

● 驱动系统按照规定进行布线。 

● PG/PC 和驱动系统之间的通讯已经准备好。 

● 控制单元的电源（DC 24 V）已接通。 

2.8.1 任务 

调试带有以下组件的驱动设备（伺服控制、转速控制）： 

 

名称 组件 订货号 

控制 

控制单元 控制单元 310-2 DP 6SL3040-1LA00-0AA0 

操作面板 基本操作面板 20
（BOP20） 

6SL3055-0AA00-4BAx 

电源与驱动 

功率模块 功率模块 340 6SL3210-xxxx-xxxx 

电机 带 DRIVE-CLiQ 接口的同步

电机 
1FK7061–7AF7x–xAxx 

通过 DRIVE-CLiQ 的电机编

码器 
sin/cos 增量式编码器 C/D 
1 Vpp 2048 p/r 

1FK7xxx–xxxxx–xAxx 

调试是使用 BOP20 进行的。 

要正确设置基本操作面板（BOP）的功能键，使其可以给出 ON/OFF 信号和转速设定

值。 
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2.8.2 组件布线（示例） 

下图展示了组件结构及其相应的布线方式。 

 

图 2-24 带有集成式编码器模块的组件布线（示例） 

其它有关布线和编码器系统连接的说明参见设备手册。 
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2.8.3 使用 BOP 进行快速调试（示例） 

表格 2- 10 快速调试，用于带 DRIVE-CLiQ 接口的伺服驱动 

 过程 描述 出厂设置 

指示： 
驱动会在首次调试前在驱动模块 DO = 1 中恢复为出厂设置。 

设备调试参数筛选 

0 就绪 

1 设备配置 

1. p0009 = 30 

30 参数复位 

1 

复位和加载所有参数 

0 无效 

2. p0976 = 1 

1 所有参数恢复为出厂设置 

0 

提示： 

一旦 RDY LED 再次显示绿色，表示出厂设置已恢复，可以开始调试。 

访问级 

1 标准 

2 扩展 

3.  p0003 = 3 

3 专家 

1 

设备调试参数筛选* 

0 就绪 

1 设备配置 

4. p0009 = 1 

30 参数复位 

1 

选择驱动对象类型* 

0 不选择 

1 驱动对象类型 SERVO 

5. p0097 = 1 

2 驱动对象类型 VECTOR 

0 

设备调试参数筛选* 

0 就绪 

1 设备配置 

6. p0009 = 0 

30 参数复位 

1 
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 过程 描述 出厂设置 

提示： 

重新给组件上电后，固件才会激活。 

必须设置 p0108[1] = H0104 为电动电位器模拟激活扩展设定值通道。 

设备调试参数筛选* 

0 就绪 

1 设备配置 

2 设定驱动类型/驱动选件 

7. p0009 = 2 

30 参数复位 

1 

 驱动器对象，功能模块* 

位 
2 

转速控制/转矩控制 

8. p0108[1] = 
H0104 

位 
8 

扩展设定值通道 

H0000 

设备调试参数筛选* 

0 就绪 

1 设备配置 

9. p0009 = 0 

30 参数复位 

1 

提示： 

等待 RDY LED 从黄色转为绿色。 要将设置保存在 ROM 中，须长按“P”键约 5 秒，直到 BOP 开始闪烁，

然后等待 BOP 停止闪烁。 现在驱动已运行就绪。  

选择驱动对象(DO) 2 ( = SERVO) 

1 CU 专家列表 

2 伺服驱动专家列表 

10. DO = 2 

选择驱动对象（DO）时，请同时按下 Fn 键和向上箭头键。 

所选择的驱动对象会显示在左上方。 

1 

11. p0840[0] = 
r0019.0(DO 1

) 

BI: ON/OFF1 [CDS] 

设置 STW1.0 的信号源（ON/OFF1） 

与控制单元(DO 1)的 r0019.0 互联 

作用： BOP 的信号 ON/OFF1 

0 
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 过程 描述 出厂设置 

12. p1035[0] = 
r0019.0013 

(DO 1) 

BI: 电动电位器设定值升高 [CDS] 

设置用于提高电动电位器设定值的信号源 

与控制单元(DO 1)的 r0019.13 互联 

作用： BOP 的信号，电动电位器设定值升高 

0 

13. p1036[0] = 
r0019.0014 

(DO 1) 

BI: 电动电位器设定值降低[CDS] 

设置用于降低电动电位器设定值的信号源 

与控制单元(DO 1)的 r0019.14 互联 

作用： BOP 的信号，电动电位器设定值降低 

0 

14. p1037 = 
6.000 

最大转速设定值 0.000 

15. p1070[0] = 
r1050 

(DO 63) 

CI: 主设定值 [CDS] 

设置用于转速控制器的转速设定值 1 的信号源 

与独立驱动对象(DO 63)的 r1050 互联 

作用： 电动电位器提供转速设定值 

1024 

BOP 运行显示模式* 

0 运行 -> r0021，否则 r0020 <-> r0021 

1 运行 -> r0021，否则 r0020 

2 运行 -> p0005，否则 p0005 <-> r0020 

3 运行 -> r0002，否则 r0002 <-> r0020 

16. p0006 = 0 

4 p0005 

4 

按下“FN”，然后按下“P”，在 DO = 2 中，屏幕显示 31。  

17. 存储所有参数 长按按下“P”键约 5 秒，屏幕中显示 41。 按下“O”键之后，屏幕显示 31，现在驱动

运行就绪。 DO = 1 中会显示 10。 

* 除了此处提及的选项外，这些参数还有更多的设置选项。 其它设置参见 SINAMICS S120/S150 参数手册

[CDS] 参数取决于指令数据组(CDS)。数据组 0 是默认设置。 
[DDS] 参数取决于驱动数据组(DDS)。数据组 0 是默认设置。 
BI Binector Input 
BO Binector Output 
CI Connector Input 
CO Connector Output 
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2.9 并联功率部件的调试 
在调试期间，并联的多个功率单元作为电网侧或电源侧的一个功率单元处理。 实际值参

数在并联时没有太大的变化，只是它是由各个功率单元值计算出的“总和值”。 

只有“装机装柜”型功率单元才允许并联： 

● 电源模块 

● 矢量控制时的电机模块 

当首次调试功率单元时，必须通过向导在调试工具 STARTER 中激活并联连接。 选择功

率单元（电源模块和/或电机模块）时按下图所示勾选并联选项：  

调试工具 STARTER 中电源模块的并联 

 

图 2-25 3 个调节型电源模块的并联示例（装机装柜型）  
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必须在相应的输入栏中输入需要进行并联的电源模块的数量（最多允许 4 个电源模块）。 

调节型电源模块也可在主/从模式中运行。 可以勾选该对话框中的选项“Master/slave”。更

多信息参见 SINAMICS S120 驱动功能功能手册中的章节“电源模块的主/从功能”。 

根据电源模块选择电源滤波器。 在使用“调节型电源模块”（ALM）时，需要使用集成了电

源滤波器的调节型接口模块（AIM）。 在使用基本型电源模块（BLM）和非调节型电源模

块（SLM）时，推荐使用外部电源滤波器。 
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调试工具 STARTER 中电机模块的并联 

 

图 2-26 3 个电机模块的并联示例（装机装柜型，矢量控制）  

在下拉菜单“Number of parallel modules”中选择并联电机模块的数量，最多 4 个。 
 

 说明 
并联中最多只能有 8 个功率单元（最多 4 个电源模块和 4 个电机模块）。  
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通过参数进行并联的配置 

对于上级控制器的而言，控制并联的多个电源模块与控制单个电源模块的方式是一样的，

只是其功率为各电源模块之和。 

使用 PROFIdrive 报文时，上级控制器通过参数服务分别控制各个功率单元并询问其状

态。 此外，还可以通过相应的控制字和状态字来控制电源模块。 这些内容可参见 
SINAMICS S120 功能手册中驱动功能一章的“PROFIdrive 通讯”。 

功率单元的激活和禁止最好只在发生故障时进行，比如：更换了失效的功率单元后进行。 
这一操作并不适合可变功率控制，因为在每次更换固件后控制单元都要重新计算驱动组的

控制参数。 重新计算是非常必要的，以保证驱动系统达到理想的高动态控制性能。  

可以分别对功率单元进行监控和参数设置。 

● 通过 p0125 激活或禁止拓扑结构中的特定功率单元（通过拓扑编号选择）。 

● 通过 p0895 激活或禁止由互联数字输入端（BI）连接的特定功率单元。 

● r7000 可以显示当前并联功率单元的数量。 

● p7001 用于允许在发生故障或更换部件后激活或禁止特定功率单元。 

报警信息（例如由于过热导致）仍可以在该状态下传送。 电机带有单独绕组系统时

（p7003 = 1），无法单独禁用各个功率单元。 功率单元通过 p0125 或 p0895 禁止后，

p7001 会自动复位。 

● r7002 可以显示功率单元中的脉冲是否被封锁或使能。 

● r7050，r7051 和 r7052 可以显示功率单元上 U、V、W 的电流。 

● r7200 到 r7219 可以显示功率单元的过载状态和不同的温度状态。 

在显示参数值时会在并联的显示值前标记一个“P”。 

与功率单元的运行和参数设置相关的其它参数，参见参数手册 SINAMICS S120/S150 参
数手册，从参数 r7002 或 p0125 开始。  

与一个或两个控制单元并联  

禁用一个电源模块后，必须确保余下的电源模块足够对直流母线充电。例如，当用一个电

源模块替代原先两个并联的电源模块时，可以将预充电时间延长一倍。 电源模块选型的

标准是：一个并联的电源模块或一个冗余回路（2 个控制系统）中的子系统就能够为整个

直流母线预充电。 

相连的电容器不得过大。 这样可以保证在一个电源模块停止运行时，剩下的另一个电源

模块也可以额定功率对两个电容器进行预充电。 
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预充电接触器监控 

为实现预充电接触器监控（电源模块故障时），您必须将辅助端子板插入预充电接触器。 

下图为互联原理简图： 

 

图 2-27 预充电接触器监控 

 

接触器状态使用 SINAMICS 驱动中的逻辑块“自由块”进行监控。 接触器如未吸合，会触

发外部报警。 

并联功率单元的运行状态 

从 A05000 或 F05000 起报警和故障都是功率单元的故障信息。  

功率单元的故障都保存在相应控制单元的故障缓冲器中并可通过参数 r0949（十进制转

换）作为故障值读取。 该故障值与驱动组拓扑中的驱动对象的编号相对应。 所出现故障

的编号保存在参数 r0945 中。 
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功率单元（电源模块或电机模块）的运行状态通过各自 CIM（Control Interface Module）
上正面的两个 LED 来显示。 

通过参数 p0124 识别特定驱动的功率单元。 当 p0124[0...n] = 1 时，相应功率单元上的 
LED READY 以绿色/橙色或红色/橙色交替闪烁（2 Hz）。 并联中，一个参数下标对应一

个功率单元。 

并联功率单元的选型配置 

有关功率单元的硬件结构和布线的信息参见资料“SINAMICS S120 装机装柜型功率单元设

备手册”。 

有关选型的信息参见资料“SINAMICS G130、G150、S120 装机装柜型、S120 变频调速

柜、S150 选型手册”。 其中也介绍了功率单元在带有进线模块的变频调速柜中的安装。 
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2.10 设备学习 

描述 

从当前的 STARTER 版本 V4.2 起，您可通过软件升级为“设备信息”功能添加新的驱动固

件版本信息。  

升级以当前的 STARTER 版本 4.2 为基础，使用 SINAMICS Support Package（SSP）
服务包。 它会补充调试工具 STARTER 中的设备描述，而不需要重新安装该工具或修改

代码，也不需要实际接入驱动设备。 

如果 SINAMICS 的版本不在调试工具 STARTER 版本 4.2 的支持范围内，则需安装 
SINAMICS Support Package 服务包。 SINAMICS Support Package 可以从 eSupport 和 
Product Support（产品支持）网页上下载。 
在新版 SINAMICS 供货释放时会同步在产品支持网页上发布新版的 SSP。 

SSP (SINAMICS Support Package)  

SSP 只包含设备和驱动对象的描述文件。 通过安装 SSP 可以在现有的 STARTER 中添

加新的驱动对象和设备，不需要修改已安装 STARTER 中的程序代码。  
在安装之后，新版 SINAMICS 中的全部功能都可以通过专家列表进行配置。 所有与前一

版本相兼容的功能保留了所有窗口和向导。  

SSP 的内容： 

● 新驱动对象 

● 新设备版本 

● 专家列表中新建和修改过的参数 

● 新建和修改过的故障、报警、消息 

● 新建和修改过的顺序参数设置 

● 模块目录的增加（新电机、编码器、DRIVE-CLiQ 组件） 

● 配置目录的增加(SD) 

● 修改过的在线帮助文件（参数帮助、功能图） 
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安装 
所有为同一个 STARTER 版本释放的 SSP 可按任意顺序进行安装。 

安装的 SINAMICS Support Package 会显示在 STARTER 的 “Info”对话框中。 

一个新版本的 STARTER 释放并且交付使用后，该版本的 STARTER 含有当时已释放的

全部 SSP 或者与这些 SSP 相兼容。  

兼容的 SSP 也可以多次安装，以便开展维修。 

在 SSP 的安装过程中不允许操作调试工具 STARTER。 安装程序在启动后不得中断。 完
成安装并重新启动 STARTER 后，新安装的 SINAMICS 版本不仅可以离线配置，也可以

在线操作（如通过“Accessible nodes”）。 
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2.11 编码器的选择和配置 

编码器选择 

调试工具 STARTER 中为 SINAMICS 驱动系统提供三种编码器选择方式： 

● 通过 DRIVE-CLiQ 接口检测电机数据和编码器数据。 

通过设置参数 p0400 = 10000 或 10100 来自动识别编码器，即，配置所需要的电机数

据和编码器数据都从编码器上读取；当 p0400 = 10100 时：识别时间不受限制。 

● 从编码器列表中选取某个标准编码器（编码器 1/电机编码器也可以通过电机订货号进

行选择）。 列表中的每种编码器类型都有一个代码编号，可从中选取，也可以通过参

数 p0400（编码器类型选择）来选择编码器类型。 

● 手动输入用户自定义的编码器数据。 可借助于调试工具 STARTER 中编码器输入栏对

编码器进行配置。 

另外也可以通过参数对编码器进行单独配置（参数 p0400 到 p0499）。 

表格 2- 11 标准编码器类型、代码和编码器模块 

编码器类型 编码器代码 编码器评估方式  编码器模块 

DRIVE-
CLiQ  
编码器 
 

绝对值 旋转  202 
242 
204 
244 

绝对值,单圈 20 位 
绝对值,单圈 24 位 
绝对值,多圈 12 位, 单圈 20 位) 
绝对值,多圈 12 位, 单圈 24 位) 

- 

旋转变压器 增量式 
旋转 

1001 
1002 
1003 
1004 

1 通道旋转变压器 
2 通道旋转变压器 
3 通道旋转变压器 
4 通道旋转变压器 

SMC10, SMI10 

sin/cos 
1Vpp 
编码器 

增量式编码器 
旋转 

2001 
2002 
2003 
2005 
2010 

2048, 1 Vpp, A/B C/D R 
2048, 1 Vpp, A/B R 
256, 1 Vpp, A/B R 
512, 1 Vpp, A/B R 
18000, 1 Vpp, A/B R 距离编码 

SMC20, SMI20, 
SME20, SME120 
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编码器类型 编码器代码 编码器评估方式  编码器模块 

EnDat 编码

器 
绝对值 
旋转 

2051 
2052 
2053 
2054 
2055 

2048, 1 Vpp, A/B, EnDat, 多圈 4096 
32, 1 Vpp, A/B, EnDat, 多圈 4096 
512, 1 Vpp, A/B, EnDat, 多圈 4096 
16, 1 Vpp, A/B, EnDat, 多圈 4096 
2048, 1 Vpp, A/B, EnDat, 单圈 

SMC20, SMC40, 
SMI20, SME25 
 

sin/cos 
1Vpp 
SSI 编码器 

绝对值 
旋转 

2081 
2082 
2083 
2084 

2048, 1 Vpp, A/B, SSI, 单圈 
2048, 1 Vpp, A/B, SSI, 多圈 4096 
2048, 1 Vpp, A/B, SSI, 单圈, 错误位 
2048, 1 Vpp, A/B, SSI, 多圈 4096, 错
误位  

SMC20, SMI20, 
SME25, SME125 

增量式 
线性 

2110 
2111 
2112 
2151 

4000 nm, 1 Vpp, A/B R 距离编码 
20000 nm, 1 Vpp, A/B R 距离编码 
40000 nm, 1 Vpp, A/B R 距离编码 
16000 nm, 1 Vpp, A/B, EnDat, 分辨率 
100 nm 

SMC20, SMI20, 
SME20 

线性编码器 

绝对值 
线性 

2151 16000 nm, 1 Vpp, A/B, EnDat,  
分辨率 100 nm 

SMC20, SMI20,  
SME25 

HTL/TTL 
编码器 

增量式 
正交 
旋转 

3001 
3002 
3003 
3005 
3006 
3007 
3008 
3009 
3011 
3020 

1024 HTL A/B R 
1024 TTL A/B R 
2048 HTL A/B R 
1024 HTL A/B 
1024 TTL A/B 
2048 HTL A/B 
2048 TTL A/B 
1024 HTL A/B 单极性 
2048 HTL A/B 单极性 
2048 TTL A/B R, 带有信号电缆 

SMC30 

SSI 绝对值 
编码器 

绝对值 
旋转 

3081 
3082 

SSI, 单圈, 24 V 
SSI, 多圈 4096, 24 V 
不用于电机控制, 
只作为直接测量系统 

SMC20, SMI20, 
SME25, SME125 
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编码器类型 编码器代码 编码器评估方式  编码器模块 

SSI 绝对值 
编码器 HTL 

绝对值 
旋转 

3090 4096, HTL, A/B, SSI, 单圈 SMC30 

线性编码器 增量式 
线性 

3109 2000 nm，TTL，A/B R 距离编码 SMC20, SMI20, 
SME20 

SIMAG H2 增量式编码器 
旋转 

2002 
2003 
2004 
2005 
2006 
2007 
2008 

2048, 1 Vpp, A/B R 
256, 1 Vpp, A/B R 
400, 1 Vpp, A/B R 
512, 1 Vpp, A/B R 
192, 1 Vpp, A/B R 
480, 1 Vpp, A/B R 
800, 1 Vpp, A/B R 

SMC20, SMI20, 
SME20 

 

 

 说明 
只有连接了相应的 EnDat 2.2 编码器之后，SMC40 才可完全配置。 未连接编码器时，

SMC40 不能连接至拓扑结构中。 
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配置编码器  

通过调试工具 STARTER 中的输入栏进行编码器的配置。 有三种配置方法：  

带 DRIVE-CLiQ 接口的编码器配置 

1. 点击鼠标，勾选选项“Encoder with DRIVE-CLiQ interface”。 

STARTER 便会自动识别带 DRIVE-CLiQ 接口的编码器，将它显示在编码器的配置窗

口中。 

 

图 2-28 识别 DRIVE-CLiQ 编码器 
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标准编码器配置 

1. 勾选“Select standard encoder from list”选项。 

编码器 1/电机编码器也可以通过电机订货号选中和配置。 

 

图 2-29 默认编码器选项 

西门子提供的标准编码器可在配置驱动时从“encoder”选项列表中选择。 在选择编码器

类型的同时，所有必要的参数设置都会自动传输到编码器配置中。 下表中列出了标准

编码器的类型和相应的编码器模块。  
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手动输入用户数据的配置 

1. 点击鼠标，勾选选项“Enter data”，手动输入用户自定义的编码器数据。 

可借助于调试工具 STARTER 中编码器输入栏对编码器进行配置。 

 

图 2-30 用户自定义编码器选项  
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2. 点击按钮“Encoder data”。 

STARTER 打开以下编码器数据输入窗口： 

 
图 2-31 旋转编码器类型  

在该窗口中可以在“rotary”和“linear”编码器中进行选择。 

3. 勾选相应的选项，激活编码器类型。 

旋转编码器中可以选择以下编码器： 

– 旋转变压器 

– sin/cos 增量式编码器 

– EnDat 协议的绝对值编码器 

– HTL/TTL 增量式编码器 

– SSI 协议的绝对值编码器 

– SSI 协议的 HTL/TTL 绝对值编码器 

– SSI 协议的 sin/cos 绝对值编码器 
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旋转编码器有以下型号供选择： 

 
图 2-32 线性编码器类型  

您可以配置以下型号的线性编码器： 

– EnDat 协议的绝对值编码器 

– sin/cos 增量式编码器 

– HTL/TTL 增量式编码器 

– SSI 协议的绝对值编码器 

– SSI 协议的 HTL/TTL 绝对值编码器 

– SSI 协议的 sin/cos 绝对值编码器 

4. 从下拉表中选择所需的编码器。 

旋转编码器和线性编码器的编码器窗口都是一目了然的，因此此处不再进行更详细的展

示。 

下面以 DRIVE-CLiQ 编码器为例来说明编码器的调试和更换步骤。 
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带 DRIVE-CLiQ 接口的编码器  

带有 DRIVE-CLiQ 接口的编码器模块有以下几种规格： 

● 机柜安装式编码器模块（SMCx），适合安装在标准顶帽导轨上 

● 外部编码器模块（SMEx），适合安装在外部 

● 内置编码器模块（SMI），适合安装在电机上 

● DRIVE-CLiQ 集成模块（DQI），集成在电机内 

出厂时 DRIVE-CLiQ 编码器上已安装了用于检测电机温度的温度传感器。 

STARTER 版本支持 

调试工具 STARTER 支持带 DRIVE-CLiQ 接口的编码器。 为此在编码器一览中列出了配

套 DRIVE-CLiQ 电机的订货号。 

SMI 或 DQI 电机使用的是订货号。 

在配置 DRIVE-CLiQ 电机时，不区分 SMI 电机和 DQI 电机。 

如果用 SMI 电机或 DQI 电机来代替带有编码器和外部 DRIVE-CLiQ 接口的电机，就必须

重新设置 SMI 电机或 DQI 电机。  

编码器类型/应用不同，工作方式也不同： 

● 编码器在测量原理和分辨率方面有差异时。 

● 编码器在需要找到零脉冲（例如用于回参考点）的应用中使用时。 集成了 DRIVE-
CLiQ 接口的编码器不提供单独的零脉冲，因为它一直是绝对值编码器。 因此在这些

应用或上级控制器中必须选择变化后的工作方式。 

● 编码器需要在配备 SINAMICS Safety Integrated 扩展功能或 SINUMERIK Safety 
Integrated 的驱动系统上使用，因为冗余位置值（POS2）的分辨率变小而导致位置精

度（SOS Safe Operating Stop）和最大速度（SLS Safely Limited Speed）变小。 

在激活 SINAMICS Safety Integrated 扩展功能或 SINUMERIK Safety Integrated 时，必

须重新执行验收测试以及可能需要进行的设置更改。 
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调试带 DRIVE-CLiQ 接口的编码器 

带 DRIVE-CLiQ 的绝对值旋转编码器的属性可以通过以下控制单元参数确定： 

 

p0404[0..n]  生效的编码器配置 

p0408[0..n]  旋转编码器的线数 

p0421[0..n]  旋转绝对值编码器多圈分辨率 

p0423[0..n]  旋转绝对值编码器单圈分辨率 

这些数据根据编码器列表中的参数 p0400（编码器类型选择）中设置的代码自动设置。 
控制单元会在启动时检查参数 p0404、p0408、p0421 和 p0423。 

或者可以通过设置 p0400 = 10000 或 p0400 = 10100 从编码器上读出这些数据。 如果控

制单元读出的编码器数据和某个已知的编码器类型一致，控制单元会将类型代码输入到 
p0400 中。 否则会输入通用代码，例如：p0400 = 10050（识别带 EnDat 接口 2.1 的编

码器）、p0400 = 10058（识别数字绝对值编码器）或 p0400 = 10059（识别数字增量式

编码器）。 

通过参数 p0404.10 = 1 识别 DRIVE-CLiQ 编码器。 

DRIVE-CLiQ 编码器的代码在参数 p0400 中定义（参见 SINAMICS S120/S150 参数手册

和上表）。  
如果控制单元识别出的 DRIVE-CLiQ 编码器没有代码，控制单元在识别后会输入 p0400 = 
10051（识别 DRIVE-CLiQ 编码器）。 

如果在自动调试时发现了 DRIVE-CLiQ 编码器，也同样会自动识别数据。 在进行识别

时，控制单元会从 DRIVE-CLiQ 编码器上读出 p0404、p0421 和 p0423 的值。 接着控制

单元会从这些数据中计算出 p0400 的内容。 新定义的代码不会保存在 DRIVE-CLiQ 编码

器中。 

更换 SINAMICS 内置编码器模块 SMI 

若 SINAMICS 内置编码器模块（SMI）或 DRIVE-CLiQ 内置编码器（DQI）出现损坏，

请联系您所在地区的西门子办事处进行维修。 
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2.12 直线电机开机调试的提示 

2.12.1 直线电机调试的概述 

在电机调试开始之前，必须先回答以下问题：  

● 是否满足了 调试的前提条件 (页 18)？ 

● 调试检查表 (页 19)是否都已填好并且各项都已打勾？ 

有关直线电机编码器、编码器接口、功率接口、电机选型和安装的详细信息参见 1FN1、
1FN3 或 1FN6 直线电机的选型手册。 

旋转电机和直线电机的术语对比 

表格 2- 12 对比 

旋转 线性 

转速 速度 

转矩 推力 

定子 初级部件 

转子 次级部件 

转动件 次级部件 

旋转方向 方向 

线数 栅距 

旋转 移动 
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未通电时的检查 

可以进行以下检查： 

● 直线电机 

– 使用的是哪种直线电机？ 
1FN _ _ _ _ – _ _ _ _ _ – _ _ _ _ 

– 电机是否已经完成安装并处于接通准备状态？ 

– 如果使用了冷却回路，其功能是否正常？ 

● 机械系统 

– 轴可以在整个最大行程上自由运行吗？ 

– 初级部件和次级部件之间的空隙或安装距符合电机厂商数据吗？ 

– 悬挂轴： 
如果轴使用了配重，其功能是否正常？ 

– 制动： 
如果使用了制动装置，制动是否可被正确控制（参见 SINAMICS S120 驱动功能手

册）？ 

– 最大行程限制： 
最大行程的两侧是否存在机械限位挡块并且已固定好？ 

– 可移动的电源电缆是否已经正确地布设在电缆拖链中？ 

● 测量系统 

– 使用了哪种测量系统？ 
 
_ _ _ _ _ _ _ _ _ _ _ _ 
 

– 绝对或增量？ 
 

– 栅距 _ _ _ _ _ _ _ _ _ _ µm 
 

– 零脉冲（数量和位置）_ _ _ _ _ _ _ _ _ _ _ _ 

– 正驱动方向在何处？ 
测量系统的正计数方向在何处？  
 

– 进行取反吗（p0410）？是/否 



调试  
2.12 直线电机开机调试的提示 

 调试手册 
154 开机调试手册, (IH1), 01/2013, 6SL3097-4AF00-0RP3 

● 布线 

– 功率单元（UVW 连接，相序，顺时针旋转磁场） 

– 连接了保护线吗？ 

– 设置屏蔽了吗？ 

– 温度监控回路： 
屏蔽连接板的端子上连接了电缆？ 
温度传感器（Temp-F）： 
使用温度传感器（Temp-F）可以测量绕组的平均绝对温度。 
过温开关（Temp-S）： 
过温回路（Temp-S）可以实现对电机每相绕组的数字式过温监控。 

警告  
 

不存在电气隔离时会有电击危险 
不管是 Temp-F 和 Temp-S 回路之间，还是它们与动力回路之间都没有达到 IEC 
61800-5-1 标准要求的“安全电气隔离”。  
通过编码器模块 SMC20 来连接温度监控回路也达不到该标准的要求。 因此为了

符合 EN 61800-5-1 的规定，必须通过编码器模块 SME12x 来连接温度监控回

路。  
另可参见 1FN1、1FN3 或 1FN6 直线电机选型手册。 

– 温度传感器评估 

– 使用 SME12x 进行温度监控（温度监控回路说明见 1FN1、1FN3 或 1FN6 选型手

册“电机热保护”一章中的“SME12x 的接口”，SME12x 的接线方式参见“连接温度监

控回路”一章中的说明） 

– 编码器系统连接 
编码器系统是否正确地与 SINAMICS 进行了连接？ 
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2.12.2 调试： 带有初级部件的直线电机 
 

警告  
直线电机上的危险运动 
直线电机可以达到远远高于传统电机的加速度和速度。  
为确保人员和机器的安全，电机的行程范围应与人员/机器隔开。  
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使用调试工具 STARTER 调试电机 

既可以从电机列表中选择所需的电机，也可以手动输入第三方电机的电机数据。此时，必

须输入并联的初级部件的数量(p0306)。 

1. 点击鼠标，勾选“Select standard motor from list”。 选择电机类型，然后从“Motor 
Selection”列表中选择标准电机。 

 
图 2-33 STARTER 1FN3 直线电机选择对话框 

或 

2. 点击鼠标，勾选“Enter motor data”。 选择电机类型并点击“Next”。 然后手动输入第三

方电机的数据。 
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使用第三方电机时，必须输入以下电机数据： 
 

参数 描述 

p0305 电机额定电流 

p0311 电机额定速度 

p0315 电机极对宽度 

p0316 电机力常数 

p0322 电机最大速度  

p0323 最大电机电流 

p0338 电机极限电流 

p0341 电机重量 

p0350 电机冷态定子电阻 

p0356 电机定子漏电感 

可以选择输入的其它电机数据（直线同步电机）： 
 

参数 描述 

p0312 电机额定力 

p0317 电机电压常数 

p0318 电机静止电流 

p0319 电机静止力 

p0320 电机额定磁化电流 

p0325 电机磁极位置识别第 1 相电流 

p0326 电机堵转转矩补偿系数 

p0329 电机磁极位置识别，电流 

p0348 弱磁起始速度 

p0352 电缆电阻，常温 

p0353 电机串联电感 

p0391 电流控制器适配，经过适配的 KP 的动作点  

p0392 电流控制器适配，经过适配的 KP 的动作点  

p0393 电流控制器适配，P 增益适配 
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3. 通过同名的对话框输入用户自定义的编码器数据。 
直线电机的编码器通过窗口“User defined encoder data”进行配置。 

 

图 2-34 STARTER 的编码器数据窗口 

警告  
 

直线电机上的危险运动 
在对直线电机进行首次调试时，必须对换向角偏移（p0431）进行调整。 有关换向角

偏移和磁极位置识别的详细信息，参见 SINAMICS S120 驱动功能手册的“伺服控制”
一章。  
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2.12.3 调试： 带有多个相同初级部件的直线电机 

如果确定多个直线电机的 EMF 具有相同的相位位置，这些直线电机可通过连接电缆并联

到一个电机模块上。  

并联直线电机的调试是以单台直线电机的调试为基础的。 在窗口“Configuration - 
SINAMICS_S120_CU320 - 2 motor”中勾选“Motor parallel connection”，便可激活直线电

机的并联。 

并联直线电机的数量在调试工具 STARTER 驱动配置的窗口“Motor”中输入（p0306）。 

将直线电机逐个连接到驱动上并将它们作为一台电机（1FNx ...）调试。 此时 STARTER 
会自动测定每个电机的换向角偏移并记录下来。 最后 STARTER 会对所测得的电机换向

角偏移进行比较。 

如果换向角偏移之差小于 5 度的电气角，则所有的电机都可以并联到驱动上，作为 n 个
直线电机（例如 2 个 1FN3xxx）的并联回路进行调试。 

允许的并联 

并联的直线电机须满足以下前提： 

● 相同的初级部件结构尺寸 

● 相同的绕组类型 

● 相同的空隙 
 

 说明 
直线电机并联在一根轴上时，初级部件之间以及与次级部件之间必须间隔一个指定栅格，

从而达到一致的电气相位位置。  
更多信息请参见 1FN1、1FN3 或 1FN6 直线电机选型手册。 
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温度传感器及其电气连接 

温度传感器可以通过以下方式连接和处理： 

● 温度传感器 

– 电机 1: 传感器通过 SME12x 接入，温度由驱动控制加以处理 

– 电机 n: 未连接 
（短接以及与 PE 连接） 

● 温度开关 

– 电机 1 到 n: 通过驱动控制进行处理 

另见： 1FN3 或 1FN6 直线电机选型手册 
 

警告  
电击危险 
在连接温度监控回路时要注意满足 EN 61800-5-1 对保护隔离的要求。 
更多信息请参见 1FN1、1FN3 或 1FN6 直线电机选型手册。 

 

2.12.4 电机热保护 

温度监控回路：Temp-F 和 Temp-S  

电机出厂时带有两条温度监控回路：Temp-F 和 Temp-S。 Temp-F 用来监测和计算电机

中的温度变化。 Temp-S 用来在电机绕组出现过热时激活电机保护。 

两条温度回路是相互独立的。 温度处理由控制单元来实现。 温度传感器是通过 SME12x 
系列的编码器模块连接到驱动系统或电机模块的。 

Temp-F (KTY84 传感器) 

温度监控回路 Temp-F 由一个位于线圈中的温度传感器 KTY84 组成。 在某些条件下，比

如：各个相位的电流负载不同时，这种传感器可能无法检测三个相位绕组的最高温度。 
因此不允许单独使用 Temp-F 来实现电机保护。 Temp-F 用于温度监控，可用于在 
Temp-S 响应导致驱动关闭前发出预警。  
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Temp-S (PTC 元件) 

Temp-S 由多个热敏电阻温度传感器（PTC 元件）构成。 在每个相位绕组（U、V 和 
W）中都有一个热敏电阻温度传感器对电机绕组进行监控。 这种方式可以实现过载保

护，即使在一个初级部件各个相位的电流负载不均匀或者多个初级部件的负载不均匀时。 
各个 PTC 元件串联在一起。 

有关 Temp-F 和 Temp-S 布线和连接详见 1FN3 或 1FN6 直线电机选型手册中的描述。 

SME12x（Sensor Module External：外部编码器模块）配备了连接器，可以实现与不同

的直线电机传感器的连接（WMS，霍尔传感器，温度传感器）。 SME12x 的输出通过 
DRIVE-CLiQ 和 SINAMICS 系列驱动系统相连。 它实现了动力回路和传感器回路之间实

现的安全电气隔离，以满足 EN 61800-5-1 对保护隔离的要求。 因而，SME12x 可提供以

下功能： 

● 所有的信号电缆可以连接在电机附近。 

● 全面利用温度传感器： 

– Temp-S 实现电机热保护 

– Temp-F 显示温度变化 

SME12x 有两种型号： 

● 用于增量式位移测量系统的 SME120 

● 用于绝对位移测量系统的 SME125 

有关 SME12x 的其它信息请参见 SINAMICS S120 设备手册，控制单元及附加系统组

件，“编码器系统连接”一章。 
 

警告  
不存在电气隔离时会有电击危险 
不管是 Temp-F 和 Temp-S 回路之间，还是它们与动力回路之间都没有达到 IEC 61800-
5-1 标准要求的“安全电气隔离”。 
通过编码器模块 SMC20 来连接温度监控回路也达不到该标准的要求。 因此为了符合 
EN 61800-5-1 的规定，必须通过编码器模块 SME12x 来连接温度监控回路。 
另可参见 1FN1、1FN3 或 1FN6 直线电机选型手册。 
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注意 
 

过热会引起损坏 
必须连接 Temp-S，以实现电机过热保护。 严禁不连接 Temp-S！  
在进行调试或测试时，可以选择将 Temp-F 连接到测试设备上。  
在常规运行中，Temp-F 的端子应短接在一起或与 PE 连接。  

 

 说明 
温度传感器 Temp-F 只测量初级部件某一相的绕组温度。 然而同步电机各相的负载不

同。 未被测量的相可能温度更高。 
 

警告  
电击危险 
如果未使用合适的保护模块（例如：TM120），在要求安全电气隔离时，Temp-F 不得

与 SINAMICS 驱动系统的编码器模块连接。  
始终要安全关断驱动电源。 在操作和连接 Temp-F 时请注意如果驱动通电，电机端子上

以及 Temp-F 的连接电缆上可能带有危险电压。 
 

警告  
电击危险 
如果未使用热敏电阻型电机保护器 3RN1013-1BW10 或合适的保护模块，在要求安全电

气隔离时，Temp-S 不得与 PLC 或 SINAMICS 驱动系统的编码器模块连接。 
始终要安全关断驱动电源。 在操作和连接 Temp-S 时请注意如果驱动通电，电机端子上

以及 Temp-S 的连接电缆上可能带有危险电压。 
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安全电气隔离的温度处理单元  

端子模块 120 是适合安装在机柜中、带有 DRIVE-CLiQ 接口的温度处理单元。 TM120 有 
4 条安全电气隔离的测量回路，用于连接 KTY 或 PTC 温度传感器。 TM120 也可以和编

码器模块（SMCxx、SMIxx 和 SMExx）一起使用，以实现温度传感器的安全电气隔离。 

有关温度传感器测量的详细信息 

更多信息请参见 1FN1、1FN3 或 1FN6 直线电机选型手册。 

2.12.5 测量系统 

确定控制方向 

如果电机正转时（顺时针旋转磁场 U, V, W），测量系统向上计数，那么轴的控制方向就

是正确的。 
 

 说明 
用于确定电机转向的说明只针对西门子的 1FNx 系列电机。  
如果电机正转时测量系统不向上计数，则必须在调试时通过对话框“configuration encoder 
- Details”对转速实际值(p0410.0)进行取反。  
控制方向也可以这样检查：首先设置好驱动并接着在封锁使能后手动移动电机。  
当电机在正向移动时，速度实际值也必须为正值。  
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确定电机转向 

如果初级部件相对于次级部件的运动方向与电缆的引出方向相反，则表明电机正向移动。 

 

图 2-35 确定电机正转方向 

确定测量系统的计数方向 

测量系统不同，计数方向也不同。 

Heidenhain 公司的测量系统 
 

 说明 
如果探头与铭牌之间的距离在变大，则表明测量系统在向上计数。 

 

 

图 2-36 确定 Heidenhain 公司测量系统的计数方向 
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Renishaw 公司的测量系统（例如 RGH22B） 

由于 Renishaw RGH22B 参考标记的位置取决于方向，因此带有 BID 和 DIR 控制电缆的

编码器必须设置为只以一个方向输出参考标记。 

该方向（正/负）取决于机器的几何布置以及参考点的逼近方向。 

表格 2- 13 信号一览 

连接到 信号 电缆颜色 圆形连接器 
12 针 +5 V 0 V 

BID 黑色 9 针 两个方向上的参考

标记 
一个方向上的参考

标记 

DIR 橙色 7 针 正方向 负方向 

+5 V 棕色 12 针 

0 V 白色 10 针 

 

如果探头相对于金色带条的运动方向与电缆的引出方向一致，则表明测量系统向上计数。 

 

图 2-37 确定 Renishaw 公司测量系统的计数方向 

 

 说明 
电缆的引出方向与计数方向不同 
如果探头以机械方式与初级部件相连，那么电缆的引出方向与计数方向不能相同。 否则

实际值要取反！  
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2.12.6 直线电机的测量检查 

为什么进行测量？  

如果已经按照说明对线性电机进行了调试，但仍然出现无法解释的报警，那么必须使用示

波器对全部 EMF 信号进行检查。 

检查相序 U-V-W 

当初级部件并联时，电机 1 的 EMF_U 必须与电机 2 的 EMF_U 同相。 这一点同样适用

于 EMF_V 和 EMF_W。 
最好通过测量进行核实。 

测量检查的步骤 

● 断开驱动系统的电源。 

● 注意： 请等待几分钟，直到直流母线放电完毕！ 

● 拆除驱动上的电源电缆。 
断开初级部件可能存在的并联。 

● 人为地使用 1 kOhm 的电阻构建中性点。 

 

图 2-38 测量电路 
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电机正向移动时，相序应为 U-V-W。 如果初级部件相对于次级部件的运动方向与电缆的

引出方向相反，则表明电机正向移动。 

 

图 2-39 确定电机的正向移动（顺时针旋转磁场） 

通过示波器测定换向角 

在连接示波器之后，电机必须先越过零脉冲，才能达到精同步。 

换向角偏移可以通过测量 EMF 和模拟量输出端上的标准电气磁极位置来测定。 

 

图 2-40 示波图 
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通道定义(Ch1 ... Ch4): 

● Ch1: 相位 U 相对于中性点的 EMF 

● Ch2: 相位 V 相对于中性点的 EMF 

● Ch3: 相位 W 相对于中性点的 EMF 

● Ch4: 模拟量输出端上的标准电气磁极位置 

 

图 2-41 设置 CU320 上的测量插口 T0 

驱动经过同步后，相位 U 上的 EMF 和电气转子位置之间的角度差不能超过 10 度。 

如果差异太大，则应调整换向角偏移。 
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2.13 调试内装式转矩电机 SIMOTICS 类型 1FW6 

2.13.1 调试的安全提示 
 

危险  
如果由未经培训的人员操作直接驱动和/或其组件，则可能导致人身伤亡以及/或者财产

损失。 
只允许由了解并且遵循相关安全提示的人员来操作直接驱动及其组件。 
只允许由合格、受过培训的专业人员进行安装、调试、运行和维护。 这些人员必须详细

了解本说明的内容。 
所有电机上的操作都必须至少由两人完成。 

 

 
 

危险  
如果调试的机器不满足公认安全要求，可能会造成死亡、严重的身体伤害以及/或者财产

损失。 
配备了由变频器馈电的低压转矩电机的机器和设备必须满足 EMC 指令 2004/108/EEC 
的保护要求。 设备制造商必须确保安装符合 EMC 要求。 信号与功率电缆必须进行屏蔽

处理。 请遵照变频器制造商的 EMC 安装指令，订货号 6FC5297-□AD30-0AP□。 
 

危险  
如果电机意外运行，可能会造成死亡、严重的身体伤害以及/或者财产损失。 
正在旋转的转子会造成危险！ 严禁在机器通电时进入转子旋转区域。 
人员必须远离旋转和挤压区域！ 
确保转子能自由旋转。 
在通电前必须检查换向！ 还要遵守所用驱动系统的调试说明！ 
限制电机电流。 
将转速极限设置到最小值。 
检查最终位置。 
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警告  
电机的表面温度可能会超过 100 ℃（212℉）。 灼伤危险！ 
假如配有冷却系统，请保证其运行的高效性！ 
使用时不能接触电机！使用后不得立即触摸电机！ 
在最临近的危险范围内贴上“灼热表面警告”(DW-026)标签，使其清晰可见！ 
不得将对温度敏感的元件（电缆、电子元件）放置在灼热的表面上。 

 

 
 

危险  
电击危险！ 
转子旋转时会产生一个感应电压。 必须在转子旋转前按规定连接好电机的功率电缆并进

行绝缘处理！ 
 

 
 

危险  
温度监控回路有电击的危险！ 
Temp-S 和 Temp-F 回路不满足 DIN EN 61800-5-1 中关于保护隔离的规定（该规定是

之前的 DIN EN 50178 安全电气隔离规定）。 
通过编码器模块 SMC20 的编码器插口（X520，引脚 13 和引脚 15）直接连接温度回路 
Temp-S 和 Temp-F 时，无法满足保护隔离规定，因此不允许采用。 
请使用例如 SME12x 或 TM120 来连接温度监控回路 Temp-S 和 Temp-F。 
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警告  
在转矩电机运行时，转子的最高温度不得超过 120 °C，否则可能会使永磁铁失去磁性。

在首次调试时，必须通过相应的测试确保没有该危险。 
该要求特别针对电机处于静态或周期性短时间旋转时出现的电流失衡，因为此时可能会

引发局部高温。 
 

 
 

注意 
 

如没有温度防护装置电机可能会过热并损坏。 
请在第一次接通直流母线电压之前（！），检查温度防护装置是否有效！ 
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2.13.2 调试检查表 

调试内装式转矩电机 SIMOTICS T-1FW6 的检查表 

在开始调试之前请先了解安全注意事项并注意下列检查表。 

表格 2- 14 检查表 (1) - 常规检查 

检查 是 

配置的驱动系统中的所有必要组件是否都存在，是否正确选型，并已按规定安装和连接？  

系统组件（例如：驱动系统、编码器、冷却系统、制动）和选型手册“内装式转矩电机 
SIMOTICS T-1FW6”的制造商资料是否提供？ 

 

下列当前 SINAMICS 资料是否提供？ 

• SINAMICS S120 调试手册 

• SINAMICS S120 入门指南 

• SINAMICS S120 驱动功能手册 

• SINAMICS S120/S150 参数手册 

 

是否阅读了“SINAMICS S 调试的检查表”章节？  

需要调试的电机类型是否已知？ 

（例如：1FW6 _ _ _ – _ _ _ _ _ –  _ _ _ _） 

 

如果是“第三方电机”，那么以下电机数据是否已知？ 
（“第三方电机”指的是不属于西门子调试软件标准电机的电机。） 

• 电机额定电流 

• 电机额定转速 

• 电机极对数 

• 电机转矩常数 

• 电机最大转速 

• 最大电机电流 

• 电机极限电流 

• 电机转动惯量 

• 电机冷态定子电阻 

• 电机定子漏电感 

 

环境条件在允许的范围内吗？  
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表格 2- 15 检查表 (2) - 机械检查 

检查 是 

电机是否已按照厂商规定正确装配并处于就绪状态？  

运输保护装置是否已按照选手册“内装式转矩电机 SIMOTICS T-1FW6”安装一章的说明拆

除？ 
 

轴可以在整个旋转范围内自由旋转吗？  

所有的螺钉是否都按规定的扭矩拧紧了？  

定子和转子的对中符合电机厂商规定吗？  

如果有电机抱闸，其功能是否正常？  

编码器的安装是否正确？是否根据厂商规定进行了对中？ 

有关编码器的重要信息请参见选型手册“内装式转矩电机 SIMOTICS T-1FW6”。 

 

液体冷却电机所需的冷却系统是否已按照厂商规定连接？其功能是否正常？  

冷却液符合选型手册“内装式转矩电机 SIMOTICS T-1FW6”中“冷却液”一章的要求吗？  

在注满冷却回路之前，是否用冷却液冲洗了回路？  

是否确定不会超过冷却回路中允许的压力（参见选型手册“内装式转矩电机 SIMOTICS T-
1FW6”中的“技术特性”）？ 

 

可移动的电缆是否按照规定的敷设在牵引链中？  

电源电缆是否按规定的扭矩正确地连接到了组件端子上？  

是否确保减轻了电缆张力？  
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表格 2- 16 检查表 (3) - 电气检查 

检查 是 

是否所有的布线工作都已完成？  

保护接地线的连接是否正确？  

电机的接地是否直接与功率模块的接地相连（短距离相连避免出现高放电电流）？  

所有的插头是否都已正确地插入或拧紧？  

电机是否连接了屏蔽型电源电缆？  

电源电缆的屏蔽层是否最大可能地接近端子盒进行了大面积的连接？  

所有的电缆屏蔽层是否与外壳大面积连接？  

控制电缆是否根据相应的接口配置进行了连接并按屏蔽层进行了铺装？  

电机的功率电缆是否按相序 UVW（顺时针旋转磁场）正确连接到功率模块上？  

温度监控回路是否符合安全电气隔离的规定？ 

有关温度监控回路 Temp-S 和 Temp-F 的重要附加信息请参见选型手册“内装式转矩电机 
SIMOTICS T-1FW6”。 

 

在调试和首次接通直流母线电压前是否检查了温度监控回路能否正确响应？  

编码器的连接是否正确？  

数字信号和模拟信号是否通过相互独立的电缆连接？  

是否遵循了电源电缆之间的间距？  

电网侧和电机侧的电源电缆的尺寸规格和敷设是否符合环境和敷设条件？  

变频器与电机之间的电缆长度是否遵循了允许的最大长度（根据所使用的电缆）？  
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2.13.3 换向设置的一般提示 

下列两个磁极位置识别方法可以用于所有结构尺寸的内装式转矩电机 SIMOTICS T-
1FW6： 

● 以运动为基础的方法 

● 以饱和为基础的方法（一次谐波） 
 

 说明 
建议采用精同步以达到精确换向 
使用一个带有可分析零脉冲的测量系统或者一个绝对值测量系统。 

 

以运动为基础的方法 

在连接了绝对值测量系统时，例如：Heidenhain 公司的 RCN 85xx，该方法也可以在首

次确定或再次检查换向角偏移时提供调试帮助。 

该方法可以应用在垂直轴和水平轴上，在这些轴上，负载断电时不会失控地向下旋转。 
此时的轴必须处于非制动的、自由转动状态。 （静摩擦 < 电机额定转矩的 10 %）。 

使用这种方法时，最差情况下转子会旋转 ± 5 度。 
 

警告  
在倾斜轴和水平轴上，如果重心超出了旋转轴，断电时负载会不受控制地向下旋转。 轴
的角度无法在时间上加以控制。 
如果使用以运动为基础的识别方法，请考虑到这一点。 

 

以饱和为基础的识别方法 

由于不需要转动转子，因此可以在完全制动的状态下使用该方法。 如果轴未被夹紧，仍

可能会出现转动。 根据结构的不同，在识别中接通轴电源时这种方法会产生更高的噪声

电平。 
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2.13.4 设置电机和编码器的参数 
 

 说明 
使用 STARTER 进行参数设置 
下列说明和截屏以调试工具 STARTER 为例。 
可借助调试工具 STARTER 的窗口和专家参数表来显示参数设置。 
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配置标准电机数据 

必须单独配置驱动。 

1. 在项目导航中依次双击“Drives” > “Drives name” > “Configuration” > “Configure 
DDS”。 

2. 从列表中选择用于调试的标准电机。 

相应的电机数据已保存在系统中，无须手动输入。 

 
图 2-42 电机配置窗口 - 选择一个标准电机 
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配置第三方电机数据 

电机列表中不包含 1FW6 内装式转矩电机中客户定制的特殊型号以及开发的新型号。 

1. 查看随电机发货的技术数据页，然后进行以下设置： 

 
图 2-43 电机配置窗口 - 设置第三方电机 
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2. 为永磁旋转同步电机输入以下数据： 

 
图 2-44 输入的电机数据示例 
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图 2-45 输入的可选电机数据示例 
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输入等效电路图数据 

 

图 2-46 输入的等效电路图数据示例 
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计算控制器数据 

在选择电机和输入电机数据后必须对控制器数据进行完整的计算。 

 

图 2-47 电机/控制器数据计算窗口 
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配置电机抱闸 

如果有电机抱闸，就在下列窗口中对其进行配置。 

 

图 2-48 电机抱闸的配置窗口 
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编码器数据 

1. 请注意编码器制造商的数据说明以及手册中的“选择和配置编码器 (页 142)”一章。 

2. 通过“Encoder data” 窗口为转矩电机配置编码器数据。 在对话框中点击按钮“Encoder 
data”。 

 
图 2-49 编码器配置窗口 
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增量式测量系统 

以每转 18000 线、每转一个零脉冲的增量式正弦/余弦编码器为例： 

 

图 2-50 编码器数据输入窗口 

 
 

 说明 
带有增量式测量系统的内装式转矩电机 SIMOTICS T-1FW6 需要进行磁极位置识别。 
有以下方法可用： 

• 以运动为基础的方法 

• 以饱和为基础的方法（一次谐波） 
在增量式测量系统中，精同步通常是在零脉冲上进行的。 初次调试时必须对换向角偏移 
(p0431) 设定，参见章节“测定换向角偏移 (页 196)”。 
如果是第三方电机，则无法指定用于确定换向角偏移的磁极位置识别方法。 
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绝对值测量系统 

如果编码器是 DRIVE-CLiQ 编码器，控制单元可自动识别出该编码器。 对于其他编码器

而言，则需要在按下 “Encoder data” 按钮后通过配置窗口进行以下输入，以绝对值编码

器为例，编码器采用 EnDat 协议（订货标识 EnDat 01 或 02），带增量信号，用于将绝

对值从编码器传送到控制单元，比如：Heidenhain 公司的 RCN 85xx： 

 

图 2-51 带 EnDat 协议的绝对值编码器配置窗口 
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1. 如果有需要，可通过“Encoder data” 和“Details” 对转速实际值和位置实际值进行取

反。 这样就可以调整控制方向。 

2. 为此点击窗口中的“Encoder data”按钮。 

 

图 2-52 更多编码器数据输入窗口 

定义控制方向 

如果驱动正转时（顺时针旋转磁场 U、V、W），测量系统向上计数，那么轴的控制方向

就是正确的。 

这些确定驱动方向的说明只针对西门子 1FWx 电机。 

如果驱动正转时测量系统不向上计数，则必须在调试时通过对话框“configuration encoder 
- Details” 对转速实际值(p0410.0 或 p0410.1)进行取反。 
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确定电机转向 

面朝驱动侧法兰，如果转子顺时针旋转，则表明电机正转。 

 

图 2-53 确定电机正转方向 

 

确定测量系统的计数方向 

计数方向取决于测量系统和安装位置。 测量系统的计数方向和电机的旋转方向必须一

致。 必要时必须通过参数设置来调整计数方向。 请注意测量系统的制造商资料。 必要

时，按照 图 2-52 更多编码器数据输入窗口 (页 187)所述将计数方向取反。 
 

 说明 
检查测量系统的计数方向 
也可以首先设置驱动，然后封锁使能、手动旋转电机来检查测量系统的计数方向。 
如果电机正转，则速度实际值必须也为正。 

 

参见 

设置电机和编码器的参数 (页 176) 
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结束参数设置 

内装式转矩电机 SIMOTICS T-1FW6 是进给驱动（极限电流限制）。 

 

图 2-54 应用选择窗口 
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图 2-55 配置汇总 

现在必须将创建的离线项目加载到驱动中。 在 STARTER 中在线连接目标设备。 

如果选择了一个带有 EnDat 协议的绝对值测量系统，则在建立在线连接后 STARTER 会
自动载入编码器的序列号并设置相应的编码器参数。 
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2.13.5 设置温度传感器和检查温度传感器 

外部编码器模块 SME12x 

SME 模块的连接在选型手册“内装式转矩电机 SIMOTICS T-1FW6”中的“系统连接”一章中

有详细描述。 有关外部编码器模块 SME12x 的信息请参见“SINAMICS S120 控制单元及

附加系统组件手册”中的“外部编码器模块 120 (SME120)”一章和“外部编码器模块 125 
(SME125)”一章。 

有关温度传感器的参数设置在“SINAMICS 组件中的温度传感器 (页 216)”一章中有详细说

明。 

下面展示的是通过外部编码器模块 SME12x 连接到矩电机的一个 KTY 84 和两个 PTC 传
感器的设置示例。  

使用参数列表设置驱动参数。  

表格 2- 17 驱动中的参数设置： 

参数 输入 

p0600 用于监控的电机温度传感器 
1：通过编码器 1 连接温度传感器 

p0601 电机温度传感器类型 
10：多温度通道处理 SME12x 

p0604 电机温度报警阈值  
设置用于监控电机温度的报警阈值 
对于电机列表 (p0301) 中的电机，该参数会自动设置 (120 °C)。 

p0605 电机温度故障阈值  
设置用于监控电机温度的故障阈值 
对于电机列表 (p0301) 中的电机，该参数会自动设置 (155 °C)。 

p0606 电机温度延时段 
0 到 2 s 
当在参数 p4600...4603 中选择了带有延时段的报警时，就可以在此设置电机温度监控中

报警阈值的延时段。 
在超过温度报警阈值 (p0604) 时会启动延时段。 
如果延时段到期时温度还没有低于报警阈值，则会输出故障信息 F07011。 
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参数 输入 

p4600...p4603 电机温度传感器 1...4 类型 
设置用于监控电机温度的温度传感器类型。 外部编码器模块 SME12x 使用通道 2 - 4。 
通道 1 不使用。 转矩电机可使用的值有： 

0: 无传感器 
10：PTC 故障 
12：PTC 报警 & 延时段 
20： KTY 84 

当您在选择带延时段报警时，必须将参数 p0606 的相应延时段设为 2 s（最大）。 

示例： 标准内装式转矩电机 SIMOTICS T-1FW6 

 

p4600 0: 无传感器 

p4601 20: KTY 84 

p4602 10: PTC 故障 (PTC 130 °C) 

p4603 10: PTC 故障 (PTC 150 °C) 

如果没有使用标准电机，必须设置参数 p0600...p0606（见上）。 必须根据外部编码器模

块 SME12x 的传感器类型或温度通道来选择参数 p4600...p4603。 

检查外部编码器模块 SME12x 上的温度传感器 

外部编码器模块 SME12x 通道中的传感器温度可从和动在线相连的调试工具 STARTER 
中的参数 r4620[0…3] 中读出。 

另外最高电机温度可在 r0035 中读出。 该参数显示的是参数 r4620[0…3] 中的最大值。 

无论实际温度是多少，设置的 PTC 传感器的温度在 r4620 中始终显示为 – 200 °C。 

如果参数 r0035 或 r4620[1] 中显示的温度值在 – 40 °C 到 – 80 °C 之间，则有可能是接入

了 KTY 传感器，而不是 PTC 传感器。  

检查 PTC 传感器 

可通过断开连接来模拟出现过热（高阻）时传感器导致的跳闸。 可以拔出外部编码器模

块 SME12x （接口 X200）来断开温度传感器的连接。 

如果该传感器被设置为 PTC 故障，则无论是否设置 p0604 - p0606，都会立即显示故障

“F07011 驱动：电机过热”。 如果该传感器被设置为带延时段的 PTC 报警，那么在 
p0606 中设置的时间经过后会生成故障 F7011。 
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检查 KTY 传感器 

当拔出接口 X200 上的连接器以断开 KTY 连接时，在 p0607 中设置的时间结束之后会在

调试工具 STARTER 的报警窗口中显示故障“F07016 驱动：电机温度传感器故障”。 

检查接口 X200 上的电阻值来检查温度传感器的接线。 以下电阻值表明接线正常： 

KTY 84 在 20 °C 下大约 570 Ohm 

PTC 在 20 °C 下大约 120 Ohm - 240 Ohm 

接口 X200 的引脚布局请参见“SINAMICS S120 控制单元及附加系统组件手册”。 

端子模块 TM120 

端子模块 TM120 是一个 DRIVE-CLiQ 组件，可实现安全电气隔离的温度分析功能，参见

“SINAMICS S120 设备手册控制单元及附加系统组件”中的“附加系统组件”一章。 

TM120 是一个独立的输入/输出组件。 温度通道可以分给任意一个电机模块。 

可为每个通道分配以下传感器类型： 

● PTC 

● KTY 84 

● 双金属常闭触点 
 

 说明 
标准拓扑结构 
标准拓扑结构是：  
电机模块 - 端子模块 TM120 - 机柜式编码器模块 SMC20 

 

参数设置 

端子模块 TM120 位于编码器模块 SMC20 和电机模块（DRIVE-CliQ 端口 X202）之间

时，标准配置（含温度通道的缺省分配）才是合适的。 

其他情况下，无论是在电机模块中还是在端子模块 TM120 中都必须设置所有必要温度通

道。 

无论如何都必须在首次调试电机前对温度跳闸回路的功能进行检查（例如：通过拆下传感

器接线）。 

使用专家列表设置驱动。 
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表格 2- 18 驱动中的参数设置： 

参数 输入 

p0600 用于监控的电机温度传感器 
20：连接 BICO p0608 互联温度传感器 

p0601 电机温度传感器类型 
11：多温度通道处理 BICO 

p0606 电机温度延时段 
0 到 2 s 
当在参数 p4610...4613 中选择了带有延时段的报警时，就可以在此设置电机温度监控中

报警阈值的延时段。 
在超过温度报警阈值 (p0604) 时会启动延时段。 

如果延时段到期时温度还没有低于报警阈值，则会输出故障信息 F07011。  

p0608 [0...3] CI： 电机温度信号源 2 

设置通过 BICO 互联分析电机温度的信号源 2。例如： 
[0]: 电机温度通道 1 TM120 . r4105[0]  

[1]: 电机温度通道 2 TM120 . r4105[1] 

[2]: 电机温度通道 3 TM120 . r4105[2]  

[3]: 电机温度通道 4 TM120 . r4105[3] 

p4610...p4613 电机温度传感器 1...4 类型 
设置用于监控电机温度的温度传感器类型。 转矩电机可使用的值有： 
0：无传感器 
10：PTC 故障 
12: PTC 报警&延时段 
20：KTY84 
30：双金属常闭触点故障 
32： 双金属常闭触点报警&延时段 

当您在选择带延时段报警时，必须将参数 p0606 的相应延时段设为 2 s（最大）。 
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表格 2- 19 端子模块 TM120 中的参数设置 

参数 输入 

p4100[0...3] TM120 温度传感器类型 
设置端子模块 TM120 的温度分析。 
以此选择温度传感器的类型并激活温度分析。 允许使用下列数值： 
0： 关闭分析 
1：PTC 热敏电阻 
2：KTY84 
4：双金属常闭触点 

根据上文外部编码器模块 SME12x 的说明来检查温度传感器。 断开连接来测试各个温度

通道。 

通过热敏电阻电机保护设备 3RN1013-1GW10 连接 PTC 

可通过热敏电阻电机保护设备 3RN1013-1GW10 来连接 PTC 传感器。 为此，必须将其

常闭触点与电机模块上的温度输入端相连（端子 X21.1 X21.2）。 

在多个电机并联时，每个电机都要使用一个热敏电阻电机保护设备 3RN1013-1GW10。 
常闭触点应串联在一起。 

表格 2- 20 驱动中的参数设置： 

参数 输入 

p0600 用于监控的电机温度传感器 
11：温度传感器由电机模块/控制单元端子接入 

p0601 电机温度传感器类型 
4：双金属常闭触点报警&延时段（只适用于由电机模块执行的温度分析） 

p0604 电机温度报警阈值 
设置用于监控电机温度的报警阈值。 
缺省值 120 °C 

p0605 电机温度故障阈值 
设置用于监控电机温度的故障阈值。 
缺省值 155 °C 

p0606 电机温度延时段 

最大为 0.1 s。如果是双金属开关，必须选择 0.1 s 的延时段，从而确保安全关闭电机。 

延时段到期后，会输出故障信息 F07011。 
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通过热敏电阻电机保护设备接入温度传感器时检查传感器 

至少拆下一个触点以检查 PTC 连接。 在 p0606 中设置的时间（本例为 0.1 s）到期后会

显示 F07011。 

2.13.6 确定换向角偏移 
 

小心  
首次调试时，在校准换向角偏移前，电机的换向可能完全是错误的。 一个错误换向的电

机可能会输出错误的转矩。 这有可能导致电机意外旋转，例如：电机可能在错误方向上

高速旋转。 
因此出于安全考虑，必须先通过参数 p0640 将电流限制为最大电机电流的 20 %。 

 

 

在内装式转矩电机 SIMOTICS T-1FW6 上，同步电机所需的磁极设置可以由磁极位置识

别功能确定，该方法是一种采用软件的自动识别法。 

下列两个方法适用于所有结构尺寸的内装式转矩电机 SIMOTICS T-1FW6： 

● 以运动为基础的方法 p1980 = 10 

● 以饱和为基础的方法（一次谐波）p1980 = 1 

信息另见章节 换向设置的一般提示 (页 175)。 

参数输入/换向设置 

增量式测量系统 

设置驱动使能（OFF3、OFF2、OFF1），进行粗同步。 粗同步状态通过参数 r1992.9 显
示。 接着设置 p1990 = 1 来激活“自动确定换向角偏移”功能。在确定换向角偏移期间会发

出报警 A07971。 接着必须使电机越过零脉冲。 越过零脉冲后换向角偏移自动输入到 
p0431 中。 之后会自动设置 p1990 = 0。 然后出现报警 A07965，请求永久保存修改。 

绝对值测量系统 

设置 p1990 = 1，然后激活使能。 之后换向角偏移会自动输入到 p0431 中并自动设置 
p1990 = 0。 然后出现报警 A07965，请求永久保存修改。 
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2.13.6.1 检查换向角偏移 

 

警告  
电机换向错误会引起危险 
电机换向错误会导致电机转矩损耗、温度升高和意外运动。  
因此必须根据下列描述来检查换向角偏移从而完成调试！ 

 

粗同步表示：已经进行了磁极位置识别，但电机还没有越过零脉冲。 在电机越过零脉冲

后，即达到精同步。 在使用绝对值测量系统时可省略精同步过程。 

检查磁极位置识别 

可通过 p1983 在精同步状态下检查磁极位置识别的结果。 

将电机转动到一个电气周期内的（极距）不同的位置上并设置参数 p1983 = 1。这样就可

以重新进行磁极位置识别，计算出的偏差会显示在参数 p1984 中。 

磁极位置识别结束后，参数 p1983 会再次置 0。 参数 p1984 中读出的角度差必须在[-
 10°...+10°]之间。 如果测出的角度差平均值大于 + 10°，那么必须将该平均值和输入的换

向角偏移 p0431 相加（参见 图 2-66 磁极位置的公差带 (页 207)）。  

如果测出的角度差平均值小于 - 10°，那么必须将该平均值从输入的换向角偏移 p0431 中
减去。 必须设置 p0010 = 4 才能修改参数 p0431。 

接着必须重新进行粗同步和精同步。 在绝对值测量系统上可省略精同步过程。 

参见 

使用测量仪器检查换向角偏移 (页 198) 
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2.13.6.2 使用测量仪器检查换向角偏移 

 

危险  
在直流母线上操作有电击危险！ 
关闭电源后，组件上仍可能存在危险的直流母线电压。 
请注意组件上加贴的警示标签! 
用电压表(CAT III)测量电机端子 U - V、V - W；U - W 之间的电压（直流电压可至少达 
600 V）。 

 

检查 EMF 电压 

如果您已根据调试说明对内装式转矩电机进行了调试，但仍出现了故障信息，则必须先检

查内装式转矩电机的 EMF 电压。 这里简要描述以下两种方法： 

● 借助示波器来记录相电压和磁极位置 

● 使用调试工具 STARTER 的跟踪功能来跟踪相电压和磁极位置 

借助示波器来记录相电压和磁极位置 

1. 关闭驱动组的电源。 

2. 直流母线完全放电后断开电机电缆与变频器的连接。 
断开电机之间可能存在的并联电路。 

3. 用 1 kΩ 的电阻人为构成一个中性点（电机并联时每个电机都要一个电阻）。 
 

 
图 2-56 测量电路 

4. 用尽可能恒定的转速顺时针旋转转子。 顺时针旋转指面朝驱动侧法兰时转子是顺时针

旋转的（参见选型手册“内装式转矩电机 SIMOTICS T-1FW6”中的“技术特性”一章）。 
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检查相序：U 相 - V 相 - W 相 

在电机正转时，相序必须为“U 相 - V 相 - W 相”。 

检查各相之间的位移：U 相 - V 相 - W 相 

下图中各个电压之间的相移为 120°。 

 

图 2-57 相序：U 相 - V 相 - W 相 
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检查多台电机并联时的同相相移：U 相 - V 相 - W 相 

各个电机上各相之间的位移必须一致： 

● 电机 1 的 U 相与电机 2 的 U 相 

● 电机 1 的 V 相与电机 2 的 V 相  

● 电机 1 的 W 相与电机 2 的 W 相  

同相之间允许的最大位移为 10°。 

 

图 2-58 电机 1 的 U 相允许最多滞后电机 2 的 U 相 10°  
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图 2-59 电机 1 的 U 相允许最多提前电机 2 的 U 相 10°  

使用测量仪器确定换向角偏移 

在出现故障以及多电机并联时必须按如下方式检查换向角偏移： 

带增量式测量系统的电机必须达到精同步，即：必要时必须连接电机，然后设置伺服使能

以实现粗同步。 接着使电机越过零脉冲。 如下文“借助示波器来记录相电压和磁极位置”
所述，必须关闭驱动组的电源。 在此请注意，在该方法中不允许关闭控制单元的电源，

但必须将电源模块从电网上断开。 
 

危险  
在直流母线上操作有电击危险！ 
关闭电源后，组件上仍可能存在危险的直流母线电压。 
请注意组件上加贴的警示标签! 
用电压表(CAT III)测量电机端子 U - V、V - W；U - W 之间的电压（直流电压可至少达 
600 V）。 
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测量 EMF 和经过模拟量输出标幺的电气磁极位置来确定换向角偏移。 可在测量插口 T0 
到 T2 上对经过标幺的电气磁极位置进行设置和分接。 

通道定义(Ch1 ... Ch4): 

● Ch1: U 相相电压 

● Ch2: V 相相电压 

● Ch3: W 相相电压 

● Ch4: 经过模拟量输出标幺的电气磁极位置 

 

图 2-60 设置 CU320 上的测量插口 T0 

可通过参数 r1992 在线读取粗同步和精同步的状态：r1992.8（已进行精同步）、r1992.9
（已进行粗同步）。 
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图 2-61 达到最佳换向状态的电机的理想 EMF 电压和理想磁极位置 

使用调试工具 STARTER 的跟踪功能来记录相电压和磁极位置 

该方法不使用示波器。 不需要拆除电机的接线。 由于电机电压是从晶体管导通时间计算

出的，而不是直接测定的，所以该方法没有第一种方法准确。 该方法不允许用于并联电

机，参见“特殊情况-并联 (页 209)”一章。 

必须设置以下参数： 

 

图 2-62 用于检查换向角偏移的跟踪通道 
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驱动应采用转矩控制。 需要进行以下参数设置：  

1. 设置 p1501 = 1，切换转速控制/转矩控制。 

2. 设置 p0640 = 0，限制电流为 0。 

3. 设置 p1545 = 1，激活运行至固定挡块。 

4. 电机必须处于受控状态并从外部旋转。 

 
图 2-63 达到最佳换向状态的电机示例（使用调试工具 STARTER 的跟踪功能进行

记录，颜色含义见上图） 
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评估测量结果（适用于两种测量方法） 

电机正转时（定义参见“确定电机正转方向 (页 188)”一图），波形必须在 0°和 360°之间单

调上升，参见“达到最佳换向状态的电机的理想 EMF 电压和理想磁极位置 (页 203)”一
图。 

如果波形单调下降且相序为“U 相 - V 相 - W 相”，那么就必须通过 p0410 位 0 “转速实际

值取反”来修改驱动的控制方向。 如果使用了位置控制器，还必须另外检查 p0410 位 1 
“位置实际值取反”。 

 

图 2-64 转速实际值取反错误时的 EMF 

如果波形单调下降且相序为“U 相 - W 相 - V 相”（即 V 相和 W 相接反），那么根据“设置

电机和编码器的参数”一章中的“确定电机正转方向”一图，电机反转（即：面朝驱动侧法兰

观察时，电机逆时针旋转）。 
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图 2-65 逆时针旋转时的 EMF 
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换向角公差 

在精同步驱动中，EMF U 相和经过标幺的电气磁极位置之间允许的最大偏差为 10°。
即：下降沿的过零点和 EMF U 相之间允许的最大电气角为 10°。 在多电机并联时，该最

大偏差规定对于每个并联电机的 EMF U 相都有效。 

如果偏差过大，则应调整换向角偏移。 如果在越过零脉冲时发出故障信息“F31130 (N，A) 
编码器 1：粗同步中的零脉冲和位置错误”，则表明电气角的换向偏差大于 60°。必须通过

上述方法重新检查换向角。 

 

图 2-66 磁极位置的公差带 
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换向角超出公差 

示例： 电压波形（磁极位置）的下降沿超过了 EMF U 相过零点的电气角约 18°。 

 

图 2-67 换向错误的电机示例 

上图中显示的错误换向须根据“检查换向角偏移 (页 197)”一章进行调整。 

p0431 = p0431 - 18 

参见 

设置电机和编码器的参数 (页 176) 

使用测量仪器检查换向角偏移 (页 198) 



 调试 
 2.13 调试内装式转矩电机 SIMOTICS 类型 1FW6 

调试手册 
开机调试手册, (IH1), 01/2013, 6SL3097-4AF00-0RP3 209 

2.13.7 特殊情况-并联 
 

 说明 
并联 
只有相同“结构尺寸”和“电流需求”（即相同的绕组规格）的转矩电机才可以并联在一起。 
电机订货号 (MLFB) 中“接口位置”中的数字/字母必须相同。 
其他信息和接线图请参见选型手册“内装式转矩电机 SIMOTICS T-1FW6”中的“电机耦

合”。 
 

必须满足下列条件才能在 SINAMICS 电机模块上并行运行多个转矩电机： 

● 根据选型手册“内装式转矩电机 SIMOTICS T-1FW6”中的说明设计了电机布局。 

● 并联电机的旋转方向和选型手册“内装式转矩电机 SIMOTICS T-1FW6”中的说明一

致。 在 Janus 排列方式中，必须在连接从动电机时互换 V 相和 W 相，使从动电机的

旋转方向就和主动电机的旋转方向相同，参见选型手册“内装式转矩电机 
SIMOTICS T-1FW6”中的“并联运行中的功率接口和信号接口”一章。 

● 按“使用测量仪器检查换向角偏移 (页 198)”一章描述的方式确保同相相移的正确性，

并加以核实。 根据“使用测量仪器检查换向角偏移”一章，检查相间相移是否在最大偏

移内。 只有在所有需要并联的电机的换向角偏差位于极限值以内时才允许将电机连接

到变频器上。 

● 请注意：必须在调试和首次接通直流母线电压前首先检查了温度监控回路能否正确跳

闸。 

然后借助调试工具 STARTER 根据“设置电机和编码器的参数 (页 176)”一章进行调试。 从
电机列表中选择的内装式转矩电机 SIMOTICS T-1FW6 的并联必须在“Drive”专家参数表

中设置。 

完成配置后在调试工具 STARTER 中打开“Drive”专家参数表，并将 p0306 设为需要并联

的电机的数量。 设置的电机数量必须符合实际并联的电机数量。  

修改完 p0306 后，务必通过自动计算（设置 p0340 = 1）来调整控制参数，参见调试工具 
STARTER 中有关参数 p0306 的帮助。 

如果在快速调试 (p0010 = 1) 时已经修改了 p0306，最大电流 p0640 会自动设定。 在电

机调试 (p0010 = 3) 内则不是这样！ 

调试工具 STARTER 中显示的电机数据始终只适用于一个电机，有多个并联电机时，

STARTER 只是进行内部估算。 
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2.13.8 优化控制 

进行驱动配置时会在“计算电机/控制器数据”这一步自动计算驱动专用的控制器参数，参见

“电机/控制器数据计算窗口 (页 182)”一图。 但是仍需要对控制器参数进行以下优化才能获

得机床最佳性能。 通过优化设置可以达到更高的定位精度/加工精度并缩短循环时间。 

仅允许由有经验的专业人员对控制器进行优化。 

在控制系统中可以通过测量频率响应或记录设定值阶跃来优化控制器。 频率响应测量考

虑了机床固有频率，该频率限制控制环的带宽。  

有关控制器优化的信息请咨询当地西门子办事处。 

参见 

设置电机和编码器的参数 (页 176) 
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2.14 SSI 编码器的调试说明 

错误位的使用 

在 SSI 编码器中错误位的数量和位置可以有多种。 在发生故障时，有时甚至可以在位置

信息中传输故障代码。  

因此必须对所有已有的错误位进行计算（参见本章节中的“参数设置”和“限制”），否则在

发生故障时，故障代码有可能被当作位置信息进行处理。 

硬件前提条件 

● 机柜安装式编码器模块 SMC20 

● 外部编码器模块 SME25 

● 机柜安装式编码器模块 SMC30 

● 控制单元 CU320-2 

可连接的编码器类型  

表格 2- 21 可连接的编码器类型与相关的西门子编码器模块一览  

编码器模块 
 

增量信号 绝对位置 编码器电源电压 SSI 波特率 注释 

SMC20 sin/cos, 1 Vpp SSI 非循环 1) 5 V 100 kBaud - 

SME25 sin/cos, 1 Vpp SSI 非循环 1) 5 V 100 kBaud SME25 只适用

于直接测量系

统 

SMC30 正交或  

无增量信号 

SSI 非循环 1)，3) 

SSI，循环 2) 

5 V 或 24 V 100-
250 kBaud 

- 

1)“非循环”指只在初始化编码器模块时读入绝对值，位置接着只通过增量信号计算得出。 
2)“循环”指持续读出绝对值（通常以 PROFIBUS 周期或位置控制器周期）并由此计算出位置(X_IST1) 。 
3) 为进行合理性检查，SSI 协议进行循环读取 
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 说明 
只能使用支持传输率 100 kHz 且在闲置状态下为高电平的编码器。 
单稳态触发时间应设置成大于或等于编码器的规定单稳态触发时间。该值应在 15 – 30 µs 
以内。 
在单稳态触发时间内应为低电平。 

 

编码器的启动时间 

为了确保接收到正确的传感器数据，编码器模块会检查相连编码器是否激活并就绪：  

● 在编码器的电源接通后 800 ms 的等待时间内不会转换任何信号。 

● 在这段等待时间结束后，编码器模块将检测信号发送给时钟（Clock）电缆，监测数据

电缆的响应。只要编码器还未就绪，编码器的数据电缆就会永久处于闲置状态（通常

为高电平）。 
编码器模块会等待编码器进入就绪状态。 

● 如果编码器在大约 10 秒之后仍未进入就绪状态，编码器模块会报告超时错误。 

在以下条件下等待时间重新计时： 

● 向编码器注入 5 V 电压。 

● 根据所设置的电平，在编码器模块启动之后切换到 24 V 电源。 
 

 说明 
在每次重新插入编码器时，激活程序就会启动。 激活程序会在向编码器模块报告编码器

就绪后结束。 
 

 说明 
允许使用 24 V 的外部编码器电源。 
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参数设置 

预定义的编码器 

STARTER 中提供了几种预定义的 SSI 编码器用于调试。 编码器可以在调试工具 
STARTER 调试窗口中进行选择。 

用户自定义的编码器 

如果需要使用的编码器未经定义，那么可以在调试向导的窗口中输入用户自定义的编码器

数据。 

特殊设置 

● 错误位（特殊情况下有多个错误位） 

如果 SSI 编码器使用了多个错误位，则按以下方式通过专家列表中的参数 p0434[x] 激
活错误位的计算： 

值 = dcba 
ba:协议中错误位的位置(0 ... 63) 
c: 电平 (0: 低电平, 1: 高电平) 
d: 计算状态（0: 关闭, 1: 开启，计算 1 个错误位, 2: 开启，计算 2 个错误位 ... 9: 开
启，计算 9 个错误位） 

有多个错误位时： 

– 在 ba 下给定的位置和其它位都按升序指定。 

– 在 c 下设置的电平适用于所有的错误位。 

示例： 

p0434 = 1013 
--> 计算开启，错误位的位置为 13 且为低电平。 

p0434 = 1113 
--> 计算开启，错误位的位置为 13 且为高电平。 

p0434 = 2124 
--> 计算开启，2 个错误位的位置从 24 开始且为高电平。 
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● 精确分辨率 p0418 和 p0419 

为了可以使用绝对值编码器的全部行程范围，位置信息包括精确分辨率在内不得超过 
32 位。 

示例： 

使用无增量信号的 SSI 编码器。 该编码器具有 16 位的单圈分辨率和 14 位的多圈分辨

率。 绝对位置分辨率即为 30 位。  

因此精确分辨率就只能设置为 2 位。 即参数列表中的参数 p0418[x] 和 p0419[x] 应设

置为 2。 

诊断 

示例 1 

使用无增量信号的 SSI 编码器。 该编码器具有 16 位的单圈分辨率和 14 位的多圈分辨

率。 精确分辨率 p0418[x] 和 p0419[x] 已设置为 2。 参数 r0482[x] (X_IST1) 为“每转线

数”和精确分辨率 p0418[x] 的乘积。 对于无增量信号的 SSI 编码器来说，线数与单圈分

辨率是一样的。 因而在本例中，位置实际值 X_IST1 (r0482[x]) 在一次编码器旋转之后应

增加： 
单圈分辨率 * 精确分辨率 = 216 * 22 = 262144 

示例 2 

使用带增量信号的 SSI 编码器。 这种情况下，会发现错误的 SSI 协议设置，例如在系统

接通之后会显示一个与上次断电前不同的绝对位置。 

绝对位置 X_IST2 (r0483[x]) 必须进行检验。 如果在编码器控制字 p0480[x] 中将位 13
（循环请求绝对值）设置为 1，那么根据 PROFIdrive 在该参数中只会显示一个值。 

该位例如可以使用数模转换器进行设置。 

接通后，将 SSI 编码器旋转几周。 重新上电后，X_IST2（r0483[x]）中的绝对位置应显

示一个未变化的值。 只允许精确分辨率区域有微小差异。 
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2.15 作为绝对值编码器的 2 极旋转变压器的调试说明 

描述  

2 极（1 个极对）旋转变压器可以作为单圈绝对值编码器使用。 编码器绝对位置实际值在 
Gn_XIST2 (r0483[x]) 中提供。  

位置实际值格式  

出厂设置中 Gn_XIST1 的精确分辨率与 Gn_XIST2 ((p0418 = 11、p0419 = 9)中的精确分

辨率不同。 因此在驱动重新上电之后，编码器可能会出现轻微的移位。 

所以在将 2 极旋转变压器作为绝对值编码器使用时，建议将 Gn_XIST1 (p0418) 与 
Gn_XIST2 (p0419) 的精确分辨率设置为相同值，如 p0418 = p0419 = 11。 

2 极旋转变压器在 PROFIdrive 协议(r0979)中会自动作为单圈绝对值编码器输入。 

位置跟踪  

您 也可以在 2 极旋转变压器上激活位置跟踪。 但需要注意的是，旋转变压器在断电状态

下的旋转不会超过半周（极宽）。 位置跟踪的激活和配置详见章节“位置跟踪”。 

EPOS - 绝对值编码器校准  

如果 2 极旋转编码器作为绝对值编码器用于简单定位(EPOS)，则必须进行绝对值编码器

校准： 

● 通过调试工具 STARTER（Basic positioner → Referencing）或 

● 通过专家列表。 

此时应将参考点坐标 p2599 设置为与机械系统相一致的值并通过设置 p2507 = 2 激活编

码器校准。 

接着必须将数据从 RAM 存储到 ROM 中。  
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2.16 SINAMICS 组件的温度传感器 
 

危险  
电击危险 
只能在“+温度”和“--温度”端子上连接符合 EN 61800-5-1 保护隔离规定的温度传感器。 
如果无法确保安全的电气隔离（例如使用直线电机或第三方电机时），则必须使用外部

编码器模块（SME120 或 SME125）或端子模块 TM120。 违反上述要求有电击危险！ 
 

下表列出了 SINAMICS 驱动系统中有温度传感器接口的组件。  

表格 2- 22 SINAMICS 组件的温度传感器接口 

模块 接口 引脚 信号名称 技术说明 

SMC10/SMC20 X520 (Sub-D) 13 
25 

+ 温度 
- 温度 
 

温度传感器 
KTY84-1C130 / PTC 

X520 (Sub-D) 
温度通道 2 

1 
8 

+ 温度 
- 温度 

温度传感器 
KTY84-1C130 / PTC / 带常闭

触点的双金属开关 

SMC30 

X531（端子）温

度通道 1 
3 
4 

- 温度 
+ 温度 

温度传感器 
KTY84-1C130 / PTC / 带常闭

触点的双金属开关 

X23 (Sub-D) 1 
8 

+ 温度 
- 温度 

温度传感器 
KTY84-1C130 / PTC 

CU310-2 DP 
CU310-2 PN 

X120（端子） 1 
2 

+ 温度 
- 温度 

温度传感器 
KTY84-1C130 / PTC 

CUA31 X210 (端子) 1 
2 

+ 温度 
- 温度 

温度传感器 
KTY84-1C130 / PTC 

X210（端子） 
温度通道 2 

1 
2 

+ 温度 
- 温度 

温度传感器 
KTY84-1C130 / PTC / 带常闭

触点的双金属开关 

CUA32 

X220 (SUB-D) 
温度通道 1 

1 
8 

+ 温度 
- 温度 

温度传感器 
KTY84-1C130 / PTC / 带常闭

触点的双金属开关 

TM31 X522 (端子) 7 
8 

+ 温度 
- 温度 

温度传感器 
KTY84-1C130 / PTC 
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模块 接口 引脚 信号名称 技术说明 

1 
2 

- 温度 
+ 温度 

3 
4 

- 温度 
+ 温度 

5 
6 

- 温度 
+ 温度 

TM120 X524（端子） 

7 
8 

- 温度 
+ 温度 

温度传感器连接 KTY84-
1C130 / PTC / 带常闭触点的

双金属开关 

直线电机应用，这里指电机温

度传感器 

连接 KTY84-1C130 

X531 1 
2 
3 
4 

+ 温度 
- 温度 
+ 温度 
- 温度 

X532 1 
2 
3 
4 

+ 温度 
- 温度 
+ 温度 
- 温度 

X533 1 
2 
3 
4 

+ 温度 
- 温度 
+ 温度 
- 温度 

X534 1 
2 
3 
4 

+ 温度 
- 温度 
+ 温度 
- 温度 

X535 1 
2 
3 
4 

+ 温度 
- 温度 
+ 温度 
- 温度 

TM150 

X536 1 
2 
3 
4 

+ 温度 
- 温度 
+ 温度 
- 温度 

KTY84-1C130/PTC/双金属常

闭触点/PT100/PT1000 

有关温度通道的接线信息见下

文。 
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模块 接口 引脚 信号名称 技术说明 

SME20 测量系统 
接口 

7 
9 

- 温度 
+ 温度 

温度传感器  
KTY84-1C130 / PTC 
必须使用订货号为 6FX8002-
2CA88- xxxx 的连接电缆 1) 

X200（连接器） 
温度通道 2 

1 
2 

- 温度 
+ 温度  

温度传感器 
KTY84-1C130 / PTC / 带常闭

触点的双金属开关 

X200（连接器） 
温度通道 3 

3 
4 

+ 温度 
- 温度 

温度传感器 
KTY84-1C130 / PTC / 带常闭

触点的双金属开关 

SME120/SME125 

X200（连接器） 
温度通道 4 

5 
6 

+ 温度 
- 温度 

温度传感器 
KTY84-1C130 / PTC / 带常闭

触点的双金属开关 

书本型 
X21（端子） 

1 
2 

+ 温度 
- 温度 

调节型电源模块 

装机装柜型 
X41（端子） 

4 
3 

+ 温度 
- 温度 

调节型电源模块的温度传感器

温度开关类型： 带常闭触点

的双金属开关 

书本型 
X21（端子） 

1 
2 

+ 温度 
- 温度 

非调节型电源模块 

装机装柜型 
X41（端子） 

4 
3 

+ 温度 
- 温度 

调节型电源模块的温度传感器

温度开关类型： 带常闭触点

的双金属开关 

书本型 
X21（端子） 

1 
2 

+ 温度 
- 温度 

基本型电源模块 

装机装柜型 
X41（端子） 

4 
3 

+ 温度 
- 温度 

基本型电源模块的温度传感

器，温度开关类型： 带常闭

触点的双金属开关 

书本型 
X21/X22（端

子） 

1 
2 

+ 温度 
- 温度 

电机模块 

装机装柜型适

用： 
X41（端子） 

4 
3 

+ 温度 
- 温度 

温度传感器 
KTY84–1C130 / PTC 

带常闭触点的双金属开关： 
报警和延时段(仅限通过电机

模块计算温度时) 

PT100 温度传感器 

1) 用于连接直接测量系统的电缆： 订货号 6FXx002-2CB54-xxxx 
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调试说明 

下面所使用的下标 [0..n] 代表电机数据组或编码器数据组。 

SMC10/SMC20  

电机温度传感器接口 SUB-D 母插 X520 的设置在 STARTER 窗口（\signals and 
monitoring \ motor temperature）中进行。  

SMC30（自订货号 6SL3055-0AA00-5CA2 起）  

该模块除了端子 X531（温度通道 1）外，它的 SUB-D 母插 X520 上也可以连接温度传感

器（温度通道 2）。 

默认设置为：p0600 = 1 “编码器 1 的温度”和 p0601 = 2 “KTY”，驱动采用第一温度通道

中的温度。 温度传感器连接在 SMC30 的端子 X531 上。 温度通过 r0035 显示。 

电机温度传感器接口 SUB-D 母插 X520 的设置必须在专家列表中进行： 

● p0600[0..n]: 选择连接电机温度传感器的 SMC30 所属的编码器（1、2 或 3），下标 n 
表示电机数据组号。 

● p0601[0..n] = 10（多温度通道处理），下标 n 表示电机数据组号。 

● p4601[0..n]: 选择温度通道 2 的温度传感器的类型。下标 n 不表示电机数据组号，而

是表示编码器数据组号。 

  说明 
当有多个编码器时，必须使用下标 [n]来区分各个编码器/编码器数据组。 

温度在参数 r4620[1] (温度通道 2) 中显示。 当有多个温度通道（SMC30 上使用温度通道 
1 和 2）时，参数 r0035 显示两者中较高的温度。 

示例： 

编码器 1 的 SMC30 的 SUB-D 母插 X520 上连接了一个 KTY 温度传感器。  

设置方式： 

● p0600[0..n] = 1 / p0601[0..n] = 10 / p4601[0..n] = 20 

两个温度通道（X520 和 X531）能够同时使用。 除了上述在 p4600[0..n] 中进行的参数设

置之外，还应输入在端子 X531 上所连接的温度传感器的类型。 驱动计算出其中的较高

电机温度，显示在 r0035 中。 
 

 说明 
当有多个编码器时，必须使用下标 [n]来区分各个编码器/编码器数据组。 
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CU310-2 DP / CU310-2 PN  

控制单元 CU310-2 集成了一个 SMC30 编码器接口。 该编码器接口即 15 芯 Sub-D 接口 
X23 ，可实现温度通道 1。 

有三种方式进行温度处理： 

 

方式 需要进行的参数设置如下： 

一个温度通道 1，占用 SMC30 编码器

接口 X23。 
• p0600[0..n] = 1： 选择编码器接口 X23 所属的编码器（1、2 

或 3），n 表示电机数据组号。 

• p0601[0..n] = 1 或 2： 选择温度传感器类型，n 表示电机数据

组号 

• r0035： 温度值显示。 

一个温度通道 1，占用端子 X120，例

如：不使用编码器时。 
• p0600[0..n] = 11： 激活占用端子 X120 的温度通道 1 

• p0601[0..n] = 1 或 2： 选择温度传感器类型，n 表示电机数据

组号 

• r0035： 温度值显示。 

两个温度通道，占用 X23 和 X120。 
其中温度通道 1 占用编码器接口 
X23，温度通道 2 占用端子 X120。 

• p0600[0..n] = 1： 选择编码器接口 X23 所属的编码器（1、2 
或 3），n 表示电机数据组号。 

• p0601[0..n] = 10: 多温度通道处理 

• p4600[0..n]： 选择温度通道 1 的温度传感器类型，n 表示电机

数据组号 

• p4601[0..n]: 选择温度通道 2 的温度传感器类型，n 表示电机数

据组号 

• r4620[0...3]： 温度值。 

– 下标 n = 0 表示温度通道 1 

– 下标 n = 1 表示温度通道 2 

• r0035： 显示温度通道 1 和 2 中的较高温度值。 
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CUA31  

连接温度传感器的端子 X210 的参数设置可以在 STARTER 窗口（signals and monitoring 
> motor temperature）中进行。 在“Temperature sensor selection”一栏中选择

“Temperature sensor via Motor Module (11)”。 传感器的温度在 r0035 中显示。 

CUA32 

连接温度传感器的端子 X210 或 SUB-D 母插 X220 的设置以双温度通道方式进行。 

p0600 = 11: 温度传感器由电机模块接入 

在 SINAMICS S120 交流驱动(AC/AC)上使用控制单元适配器 CUA31/CUA32 时，温度传

感器的接口在适配器上(X210)。 

TM31  

需要附加的数字量和模拟量输入/输出时可使用端子模块 31（TM31）。 通过 p4100 设置

使用的传感器类型，通过 r4105 进行温度信号互连。  

TM120  

电机中的温度传感器没有实现安全电气隔离时，需要使用端子模块 120（TM120）。 在 
TM120 上最多可连接 4 个不同的温度传感器。 TM120 接收并处理温度值，然后通过 
DRIVE-CLiQ 将其发送到控制单元中。 通过 KTY84 传感器测出的实际温度会被转换为 -
140°°C 到 +188.6°°C 范围的温度。 超出该范围的温度值不会被考虑。 温度值的故障或

报警阈值（p4102）可在 -48 °C 至 251 °C 的范围内设置。  

测量设置： 

● 使用 p0600 = 20 或 21 激活通过外部传感器进行的电机温度检测。 

● 使用 p0601 = 11 设置多温度通道处理。 

● 通过 p0604 设置电机温度报警阈值。 

● 通过 p0605 设置电机温度故障阈值。 

● 通过 p0608 和 p0609 设置温度通道中电机温度的信号源。 

– 通过 p4100[0...3] = 1 将温度传感器类型 PTC 分给相应通道 1 至 4，并激活温度处

理。 

– 通过 p4100[0...3] = 2 将温度传感器类型 KTY84 分给相应通道 1 至 4，并激活温度

处理。 

– 通过 p4100[0...3] = 4 设置温度传感器类型“双金属常闭触点”并激活温度处理。 
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● 在参数 r4101[0...3] 中会显示相应温度传感器的当前电阻值。 

● 在参数 r4105[0...3] 中会显示温度实际值。 若未选择传感器或温度实际值无效，则参

数 r4105[0...3] 中的值为 -300 °C。 

● 通过 p4610[0...n] 至 p4613[0...n] 将温度传感器分配至电机并定义相应响应。 

TM150  

端子模块 150（TM150）有 6 个用于连接温度传感器的 4 芯连接端子。 可采用 2 线制、

3 线制或 4 线制的温度传感器连接方案。 当每两个 2 线制传感器连接到端子上的 4 个引

脚时，最多可构成 12 个输入通道。 出厂设置为 12 个输入通道。 TM150 的温度通道可

最多分为 3 组，一起计算。 

使用 2 线制传感器时可测量电缆电阻并保存该电阻，以提高测量精度。 为此要在尽可能

接近传感器的位置接入传感器电缆。 具体步骤请见 SINAMICS S120/150 参数手册 
p4109[0...11] 下的内容。 在处理温度时，驱动会将测出的电缆电阻考虑在内。 电缆电阻

值保存在 p4110[0...11] 中。 

TM150 可连接 KTY84、PTC、双金属常闭触点、PT100 和 PT1000 这些类型的温度传感

器。 温度值的故障或报警阈值可在 -99 ℃ 至 251 °C 的范围内设置。 温度传感器可连接

到端子 X531 到 X536 上（如上表所示）。 有关配置和接口的其他信息参见 SINAMICS 
S120/S150 参数手册中的功能图 9625、9626 和 9627。 

● p4100[0...11] 为相应的温度通道设置传感器类型。 
 

p4100[0...11] 的值 温度传感器 r4105[0...11] 温度显示范围 

0 关闭处理 - 

1 PTC 热敏电阻 -50°C 或 +250°C 

2 KTY84 -99°C ~ +250°C 

4 双金属常闭触点 -50°C 或 +250°C 

5 PT100 -99°C ~ +250°C 

6 PT1000 -99°C ~ +250°C 

● r4105[0...11]会显示温度通道的实际值。 

对于开关式温度传感器而言（例如 PTC 和双金属常闭触点），该参数只会象征性地显

示两个限值： 

– r4105[0...11] = -50°C： 温度实际值在额定动作温度之下。 

– r4105[0...11] = +250°C： 温度实际值在额定动作温度之上。 
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  说明 
对于 PTC 和双金属常闭触点 
r4105[0...11] 中显示的并非温度实际值。 

● 设置 p4108[0...5] = 0，将 2 线制传感器连接到 4 线制接口的端子 1 和 2 上。端子 3 
和 4 保持空置。 

● 设置 p4108[0...5] = 2 可以 3 线制在一个 4 芯端口上接入一个传感器，即端子 3 和 4 
接入传感器，而端子 1 接入测量导线。 端子 2 和 4 必须短接。 

● 设置 p4108[0...5] = 3，将 4 线制传感器连接到 4 线制接口的端子 3 和 4 上。测量导

线连接至端子 1 和 2。 

更多信息参见 SINAMICS S120/S150 参数手册中的功能图 9626 和 SINAMICS S120 驱
动功能手册中的电机热保护一章。 

SME20  

KTY 或 PTC 温度传感器的参数设置可以在 STARTER 窗口（signals and monitoring > 
motor temperature）中进行： 

● 温度传感器选择 (≙ p0600[0..n]): 选择连接温度传感器的 SME 模块的所属对象：编码

器（1、2 或 3）、 BICO 互联或电机模块。 

● 温度传感器类型（≙ p0601[0..n]）: 设置用于电机温度监控的传感器类型。 

 
图 2-68 选择 SME20 模块的温度传感器 
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SME120/SME125  

在带有多个温度传感器接口的 SME 模块上，温度传感器根据编码器数据组 n 通过参数 
p4601[0..n]..p4603[0..n] 选择。 通过端子 X200 最多可以同时接入三个电机温度传感器。  

端子 X200 的参数设置应在专家列表中按如下方式进行： 

● p0600[0..n]: 选择连接传感器的 SME 模块所属的编码器（1、2 或 3），下标 n 表示

电机数据组号。 

● p0601[0..n] = 10（多温度通道处理），下标 n 表示电机数据组号。 

● p4601[0..n]-p4603[0..n]: 选择温度通道 2-4 的温度传感器类型，n 表示编码器数据组

号。 
在端子 X200 上只能使用温度通道 2 到 4。 

● 参数 r4620[0...3]可以 
显示通过 SME120 或 SME125 测得的当前电机温度。 下标表示： 
[1] = SME 温度通道 2/电机温度传感器 2 
[2] = SME 温度通道 3/电机温度传感器 3 
[3] = SME 温度通道 4/电机温度传感器 4 

诊断参数 r0458[0...2] 编码器模块属性 

下标 [0...2]： 编码器 1...编码器 3 

参数 r0458 可以显示 SME 模块的下列属性： 

 

位  属性 

02 温度传感器连接已存在 

03 DRIVE-CLiQ 电机上有额外的 PTC 连接 

04 模块温度存在 

08 多温度通道计算已设置 

 

只有在设置了 p0601 = 10 后，才能选择多通道温度计算 p4601 .. p4603。 您可通过查看 
r0458.8 是否为 1 确认。 

关于参数 r0458 的更多信息参见： SINAMICS S 120/S150 参数手册。 

调节型电源模、基本型电源模块、非调节型电源模块、电机模块（装机装柜型） 

参数 p0601“电机温度传感器类型”用于设置输入 X21（书本型）或 X41（装机装柜型）上

的温度传感器类型。 测量值在 r0035 中显示。 
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故障和报警  

F07011 驱动： 电机过热 

KTY 传感器： 
电机温度超过了故障阈值（p0605）或者在超过警告阈值（p0604）之后延时段

（p0606）。 
到期驱动会执行 p0610 中设置的响应动作。 

PTC 传感器 + 双金属传感器： 
超过了 1650 欧姆的触发阈值，而且延时段（p0606）到期。 
到期驱动会执行 p0610 中设置的响应动作。 

如果使用的是 SME 模块(p0601 = 10)，则参数 r949 显示触发报警的传感器通道的编号。 

A07015 驱动： 电机温度传感器报警 

在检查 p0600 和 p0601 中设置的温度传感器时发现一个故障。 

出现该故障后，p0607 设置的时间开始计时。 如果此时间期满后故障仍然存在，驱动将

输出故障信息 F07016，然而最早也要在报警 A07015 出现 50 ms 之后。 

如果使用的是 SME 模块(p0601 = 10)，则参数 r2124 显示触发报警的传感器通道的编

号。 

F07016 驱动： 电机温度传感器故障 

在检查 p0600 和 p0601 中设置的温度传感器时发现一个故障。 

出现报警 A07015 时，p0607 中的时间开始计时。 如果此时间期满后故障仍然存在，驱

动将输出故障信息 F07016，然而最早也要在报警 A07015 出现 50 ms 之后。 

如果使用的是 SME 模块(p0601 = 10)，则参数 r949 显示触发报警的传感器通道的编号。 
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功能图（参见 SINAMICS S120/S150 参数手册） 

 

• 8016 信号和监控功能 - 电机的热监控 

重要参数一览（参见 SINAMICS S120/S150 参数手册） 

 

• r0035 CO: 电机温度 

• r0458[0...2] 编码器模块属性 

• p0600[0..n] 用于监控的电机温度传感器 

• p0601[0..n] 电机温度传器类型 

• p0601 电机温度传器类型 

• p0603 CI: 电机温度信号源 

• p0604[0...n] Mot_temp_mod 2/KTY 报警阈值 

• p0605[0...n] Mot_temp_mod 1/2 阈值 

• p0606[0...n] Mot_temp_mod 2/KTY 延时段 

• p0607[0...n] 温度传感器故障报告延时 

• p0610[0...n] 电机过热反应 

• p4100[0...3] TM120 传感器类型 

• p4100 TM31 传感器类型 

• p4102[0...7] TM150 故障阈值/报警阈值 

• r4105[0...3] CO:TM120 温度实际值 

• r4105 CO:TM31 温度实际值 

• p4600[0...n] 电机温度传感器 1 类型 

• p4601[0...n] 电机温度传感器 2 类型 

• p4602[0...n] 电机温度传感器 3 类型 

• p4603[0...n] 电机温度传感器 4 类型 

• r4620[0...3] 测出的电机温度 
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2.17 基本操作面板 20(BOP20) 

简要说明 

基本操作面板 20（BOP20）是一款简易操作面板，有六个按键和一个带有背光的两行显

示屏幕。 BOP20 可以安装在 SINAMICS 控制单元上进行操作。  

使用 BOP20，您可以： 

● 输入和更改参数 

● 显示运行状态、参数和报警 

● 显示和应答故障 

● 调试时进行上电/下电 

● 模拟电动电位器 

2.17.1 使用 BOP20 (Basic Operator Panel 20)进行操作 

2.17.1.1 BOP20 概述 

使用 BOP20 能够在调试时接通和关闭驱动以及显示和修改参数。 可以诊断并应答故障。  

BOP20 是嵌入到控制单元中的，为此必须将空盖板移除（有关安装的其他说明请见 
SINAMICS S120 控制单元和扩展系统组件手册）。 

显示屏与按键 

 

图 2-69 显示屏与按键一览 
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显示信息 

表格 2- 23 显示 

显示 含义 

左上 
2 位 

这里显示 BOP 的激活驱动对象。 

显示与按键操作始终是针对该驱动对象。 

RUN 当驱动组中至少有一个驱动的状态为 RUN（运行中）时，显示。 

也可以通过各驱动的位 r0899.2 来显示 RUN。 

右上 
2 位 

在此区域中显示以下内容： 

• 超过 6 个数字： 存在但没有显示的字符 
（例如：“r2” ––> 右边有 2 个字符没有显示，“L1” ––> 左边有 1 个字符没有显示） 

• 故障： 选择/显示其他有故障的驱动 

• BICO 输入的标识（bi，ci） 

• BICO 输出的标识（bo，co） 

• 与另一个驱动对象(与当前激活的驱动对象不同)进行 BICO 互联连接的源对象。 

S 在至少有一个参数被修改并且参数值还未保存进非易失存储器中时，显示。 

P 当参数值在按下 P 按键之后才会生效时，显示。 

C 在至少有一个参数被修改并且用于一致性数据管理的计算尚未启动时，显示。 

下方，6 位 显示，如参数、索引、故障和报警。 

按键信息 

表格 2- 24 按键 

按键 名称 含义 

 ON 接通收到 BOP “ON/OFF1”指令的驱动。 

BO r0019.0 用该键设置。 

 OFF 断开收到 BOP “ON/OFF1”，“OFF2”或“OFF3”指令的驱动。 

按住该键会同时复位 BO r0019.0, .1 和 .2。 松开该键后，BO r0019.1 和 .2 会重新

设为“1”信号。 

注： 
您可以通过 BICO 参数设置来定义这些按键的有效性（比如：可通过这些按键同时

控制现有的全部驱动）。 
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按键 名称 含义 

 功能 该按键的含义取决于当前的显示。 

提示: 
可以通过 BICO 参数设置来定义这些按键是否能在发生故障时进行有效应答。 

 参数 该按键的含义取决于当前的显示。 

如果按住该键 3 秒，将执行功能“从 RAM 向 ROM 复制”。 “S”从 BOP 显示屏中消

失。 

 上 

 下 

按键的含义与当前的显示相关，用来增加或减小数值。 

BOP20 的功能 

表格 2- 25 功能 

名称 描述 

背光 可以通过 p0007 进行设置：当未使用 BOP 超过设定的时间后，背光自动熄灭。 

切换到激活的驱动 通过 p0008 定义 BOP 上的有效驱动或者通过按键“FN”和“向上箭头”选择。 

单位 单位不在 BOP 上显示。 

访问级 通过 p0003 设置 BOP 的访问级。 

访问级越高，可通过 BOP 选择的参数就越多。 

参数过滤器 通过 p0004 中的参数过滤器，可以根据参数功能过滤可用的参数。 

选择运行显示 实际值和设定值会显示在运行显示中。 

可以通过 p0006 来设置运行显示。 

用户参数列表 通过 p0013 中的用户参数列表，可以选出需要访问的参数。 

带电插拔 可以对 BOP 进行带电插拔。 

• 按键 ON 和 OFF 有效。 

在插拔时，驱动会停机。 

再次插入 BOP 后，需要重新接通驱动。 

• 按键 ON 和 OFF 无效。 

插拔不会对驱动有任何影响。 

按键控制 适用于按键“P”和“FN”： 

• 在与其它键组合使用时，总是要首先按下“P”或“FN”，接着再按其它的键。 
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重要参数一览（参见 SINAMICS S120/S150 参数手册） 

 

全部驱动对象 

• p0005 BOP 运行显示选择 

• p0006 BOP 运行显示模式 

• p0013 BOP 用户定义列表 

• p0971 储存驱动对象参数 

控制单元驱动对象 

• r0002 控制单元运行显示 

• p0003 BOP 访问级别 

• p0004 BOP 显示过滤器 

• p0007 BOP 背景灯 

• p0008 BOP 启动后的驱动对象 

• p0009 设备调试参数筛选 

• p0011 BOP 输入密码（p0013） 

• p0012 BOP 确认密码（p0013） 

• r0019 CO/BO: 控制字 BOP 

• p0977 保存所有参数 

其它驱动对象 (如 SERVO, VECTOR, X_INF, TM41 等) 

• p0010 调试参数过滤器 
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2.17.1.2 BOP20 的显示和操作 

特性 

● 运行显示 

● 修改有效驱动对象 

● 显示/修改参数 

● 显示/应答故障和报警 

● 通过 BOP20 控制驱动 

运行显示 

可以通过 p0005 和 p0006 来设置各个驱动对象的运行显示。 通过运行显示可以切换到参

数显示或其它的驱动对象。 可以有下列功能： 

● 修改有效驱动对象 

– 按下按键“FN”和“向上箭头” -> 左上方的驱动对象编号闪烁 

– 使用箭头键选择需要的驱动对象 

– 用“P”键确认 

● 参数显示 

– 按下“P”键 

– 使用箭头键选择需要的参数 

– 按下“FN”键 -> 显示参数“r00000” 

– 按下“P”键 -> 返回到运行显示 
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参数显示 

通过编号在 BOP20 中选择参数。 使用“P”键可以从运行显示切换到参数显示。 使用箭头

键选择参数。 再次按下“P”键将会显示参数的值。 同时按下“FN”键和一个箭头键可以在驱

动对象之间进行选择。 在参数显示中按下“FN”键可以在“r00000”和上一个显示的参数之间

进行切换。 

 

图 2-70 参数显示 
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数值显示 

使用“P”键可以从参数显示切换到数值显示。 在数值显示中可以通过箭头键将可调参数的

值增大或减小。 可以通过“FN”键选择光标。 

 

图 2-71 数值显示 
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示例： 修改参数 

前提条件： 相应的访问级已设置 
(本例中为 p0003 = 3) 

 

图 2-72 示例： 将 p0013[4] 从 0 修改到 300 
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示例： 修改 BI 和 CI 参数 

对于驱动对象 2 的 BI p0840[0] (OFF1)，控制单元(驱动对象 1)的 BO r0019.0 已进行了

互联连接。 

 

图 2-73 示例： 修改带索引的二进制互联参数 
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2.17.1.3 故障和报警的显示 

故障的显示 

 

图 2-74 故障 

报警的显示 

 

图 2-75 报警 
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2.17.1.4 通过 BOP20 控制驱动 

在调试时可以通过 BOP20 来控制驱动。 在控制单元驱动对象上可使用一个控制字

(r0019)，能实现与相应的 BI（如驱动的）进行互联连接。  

如果选择了标准 PROFIdrive 报文，那么该互联连接将不会生效，因为报文的互联无法断

开。 

表格 2- 26 BOP20 控制字 

位(r0019) 名称 互联参数示例 

0 ON / OFF (OFF1) p0840 

1 无滑行停止 / 滑行停止（OFF 2） p0844 

2 无快速停止 / 快速停止（OFF 3） p0848 

7 应答故障 (0 -> 1) p2102 

13 电动电位器，升高 p1035 

14 电动电位器，降低 p1036 

 
 

 说明 
对于简易调试，应只连接位 0。 当位 0 ... 2 互联时，系统下电的优先级如下： OFF2，
OFF3，OFF1。 
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2.17.2 BOP20 的重要功能 

描述 

使用 BOP20 时，可通过参数执行以下功能支持项目处理：  

● 恢复出厂设置 

● 从 RAM 复制到 ROM 

● 通过 LED 进行识别 

● 应答故障 

恢复出厂设置 

整套设备的出厂设置都可以在驱动对象 CU 中建立。 

● p0009 = 30 

● p0976 = 1 

从 RAM 复制到 ROM 

可以在驱动对象 CU 中将全部参数保存在非易失存储器（存储卡）中： 

● 长按 P 键 3 秒， 
或者 

● p0009 = 0 

● p0977 = 1 

  说明 
当驱动上已选择进行识别（例如电机数据识别）时，该参数无效。  
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通过 LED 进行识别 

驱动对象的主要组件（例如电机模块）可以通过 p0124 的索引进行识别。 组件的

“Ready”LED 开始闪烁。 索引与 p0107 中的索引一致。 通过该参数可以识别出驱动对象

的类型。 

驱动对象的组件还可以通过以下参数识别： 

● p0124 通过 LED 进行功率单元的识别 

● p0144 通过 LED 进行电压传感模块的识别 

● p0144 通过 LED 进行编码器模块的识别 

应答故障 

按下 Fn 按键可以应答所有已矫正的故障。 
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诊断 3
 

本章介绍了以下 SINAMICS S 系列驱动系统中的诊断方式： 

● LED 诊断法 

● 通过 STARTER 进行的诊断 

● 诊断缓冲器 

● 未调试轴的诊断 

● 故障和报警信息 

● 编码器故障处理 
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3.1 通过 LED 进行的诊断 

3.1.1 控制单元 

3.1.1.1 CU320-2 的 LED 状态说明 

控制单元 CU320-2 DP 和 CU320-2 PN 在启动和运行期间的不同状态通过控制单元上的 
LED 指明。 各个状态的持续时间不一样长。 

表格 3- 1 LED 

LED 功能 

RDY Ready 

DP / PN PROFIdrive 循环运行，通过 PROFIBUS (DP) 或 PROFINET (PN) 

OPT 选件 

● 发生故障时启动将会中断，故障原因会通过 LED 指出。 

● 在启动正常结束后，所有的 LED 都会暂时熄灭。 

● 启动后 LED 由载入的软件控制。 
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控制单元 320-2 DP 启动期间 

表格 3- 2 装载软件  

LED 

RDY DP OPT 

状态 注释 

红色 橙色 橙色 复位 硬件复位 
RDY-LED 红色持续亮，所有其他 
LED 橙色持续亮 

红色 红色 熄灭 BIOS 已载入 – 

红色闪烁 
2 Hz 

红色 熄灭 BIOS 出错 • 载入 BIOS 时出错 

红色闪烁 
2 Hz 

红色 
闪烁 2 Hz 

熄灭 文件出错 • 存储卡不存在或者出错 

• 存储卡上没有软件或者软件出错 

红色 橙色闪烁 熄灭 正在载入固

件 
RDY-LED 红色持续亮，DP-LED 橙
色闪烁（无固定闪烁周期） 

红色 熄灭 熄灭 固件已装载 – 

熄灭 红色 熄灭 固件已校验

（无 CRC 错
误） 

– 

红色闪烁 
0.5 Hz 

红色闪烁 
0.5 Hz 

熄灭 固件已校验

（CRC 错
误） 

• CRC 出错 

 

表格 3- 3 固件 

LED 

RDY DP OPT 

状态 注释 

橙色 熄灭 熄灭 初始化 – 

不断变化 运行 参见下表 
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控制单元 320-2 DP 运行中 

表格 3- 4 控制单元 CU320-2 DP – 启动后 LED 的响应 

LED 颜色 状态 说明，原因  解决办法 

– 熄灭 无电子电源或者超出允许公差范围。 检查电子电源 

持续亮 组件准备就绪并启动循环 DRIVE-CLiQ 通
讯。 

– 

闪烁 
0.5 Hz 

调试/复位 – 

绿色 

闪烁 
2 Hz 

正在向存储卡写入数据 – 

红色 闪烁 
2 Hz 

一般错误 检查参数设置/配置 

红色/ 
绿色 

闪烁 
0.5 Hz 

控制单元就绪。 
但是缺少软件授权。 

获取授权 

闪烁 
0.5 Hz 

所连接的 DRIVE-CLiQ 组件正在进行固件

升级 
– 橙色 

闪烁 
2 Hz 

DRIVE-CLiQ 组件固件升级完成。 等待给

完成升级的组件重新上电。 
执行组件上电 

RDY 
(READY) 

绿色/ 
橙色 
或 
红色/ 
橙色 

闪烁 
2 Hz 

“通过 LED 识别组件”激活 (p0124[0])。 

提示： 

这两种颜色取决于通过设置 p0124[0] = 1 激
活时 LED 的状态。 

– 

– 熄灭 循环通讯（还）未开始。 

提示： 

当控制单元准备就绪时（参见 LED 
RDY），PROFIdrive 也已做好通讯准备。 

– DP 
PROFIdrive 
循环运行 

绿色 持续亮 循环通讯开始。 – 
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LED 颜色 状态 说明，原因  解决办法 

闪烁 
0.5 Hz 

循环通讯还未完全开始。 

可能的原因： 

• 控制器没有发送设定值。 

• 在等时同步运行中，控制器没有传输或

者传输了错误的全局控制（Global 
Control：GC）。 

– 

闪烁 
0.5 Hz 

PROFIBUS 主站发送了错误的参数设置/配
置 

调整主站/控制器和 CU 
之间的配置 

红色 

闪烁 
2 Hz 

循环总线通讯已中断或无法建立 消除故障 

– 熄灭 无电子电源或者超出允许公差范围。 

组件没有准备就绪。 

选件板不存在或者没有创建相应的驱动对

象。 

检查电源和/或组件 

持续亮 选件板未准备就绪。 – 绿色 

闪烁 
0.5 Hz 

取决于所安装的选件板。 – 

OPT 
（选件） 

红色 闪烁 
2 Hz 

该组件中至少存在一个故障。 
选件板未就绪（例如在上电后）。 

清除故障，应答故障信

息 

RDY 和 DP 红色 闪烁 
2 Hz 

总线错误 - 通讯已中断 消除故障 

RDY 和 
OPT 

橙色 闪烁 
0.5 Hz 

所连接的选件板 CBE20 正在进行固件升级 – 
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控制单元 320-2 PN 启动期间 

表格 3- 5 装载软件  

LED 

RDY PN OPT 

状态 注释 

红色 橙色 橙色 复位 硬件复位 
RDY-LED 红色持续亮，所有其他 
LED 橙色持续亮 

红色 红色 熄灭 BIOS 已载入 – 

红色闪烁 
2 Hz 

红色 熄灭 BIOS 出错 • 载入 BIOS 时出错 

红色闪烁 
2 Hz 

红色  

闪烁 2 Hz 

熄灭 文件出错 • 存储卡不存在或者出错 

• 存储卡上没有软件或者软件出错 

红色 橙色闪烁 熄灭 正在载入固件 RDY-LED 红色持续亮，PN-LED 橙
色闪烁（无固定闪烁周期） 

红色 熄灭 熄灭 固件已装载 – 

熄灭 红色 熄灭 固件已校验 
（无 CRC 错

误） 

– 

红色闪烁 
0.5 Hz 

红色闪烁 
0.5 Hz 

熄灭 固件已校验 
（CRC 错

误） 

• CRC 出错 

 

表格 3- 6 固件 

LED 

RDY PN OPT 

状态 注释 

橙色 熄灭 熄灭 初始化 – 

不断变化 运行 参见下表 
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控制单元 320-2 PN 运行中 

表格 3- 7 控制单元 CU320-2 PN – 启动后 LED 的响应 

LED 颜色 状态 说明，原因  解决办法 

– 熄灭 缺少电子电源或者超出允许的公差范围。 检查电子电源 

持续亮 组件准备运行并正在进行 DRIVE-CLiQ 循
环通信。 

– 

闪烁 
0.5 Hz 

调试/复位 – 

绿色 

闪烁 
2 Hz 

正在向存储卡写入数据 – 

红色 闪烁 
2 Hz 

一般错误 检查参数设置/配置 

红色/ 
绿色 

闪烁 
0.5 Hz 

控制单元就绪。 
但是缺少软件授权。 

获取授权 

闪烁 
0.5 Hz 

所连接的 DRIVE-CLiQ 组件正在进行固件

升级 
– 橙色 

闪烁 
2 Hz 

DRIVE-CLiQ 组件固件升级完成。 等待给

完成升级的组件重新上电。 
执行组件上电 

RDY 
(READY) 

绿色/ 
橙色 
或 
红色/ 
橙色 

闪烁 
2 Hz 

“通过 LED 识别组件”激活 (p0124[0])。 

提示： 

这两种颜色取决于通过设置 p0124[0] = 1 激
活时 LED 的状态。 

– 

– 熄灭 循环通讯（还）未开始。 

提示： 

当控制单元准备就绪时（参见 LED 
RDY），PROFIdrive 也已做好通讯准备。 

– PN  
PROFIdrive 
循环运行 

绿色 持续亮 开始进行循环通讯。 – 
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LED 颜色 状态 说明，原因  解决办法 

闪烁 
0.5 Hz 

循环通讯还未完全开始。 

可能的原因： 

• 控制器没有发送设定值。 

• 在等时同步运行中，控制器没有传输或

者传输了错误的全局控制（Global 
Control：GC）。 

• "Shared Device"被选择（p8929=2）且

只连接至一个控制器。 

– 

闪烁 
0.5 Hz 

总线故障， 
参数设置/配置错误 

调整控制器和设备之间的

配置 
红色 

闪烁 
2 Hz 

循环总线通讯已中断或无法建立 消除故障 

– 熄灭 缺少电子电源或者超出允许的公差范围。 

组件没有准备就绪。 

选件板不存在或者没有创建相应的驱动对

象。 

检查电源和/或组件 

持续亮 选件板未准备就绪。 – 绿色 

闪烁 
0.5 Hz 

与安装的选件板有关。 – 

OPT 
（选件） 

红色 闪烁 
2 Hz 

该组件中至少存在一个故障。 
选件板未就绪（例如在上电后）。 

排除并应答故障 

RDY 和 DP 红色 闪烁 
2 Hz 

总线故障 - 通讯已中断 消除故障 

RDY 和

OPT 
橙色 闪烁 

0.5 Hz 
所连接的选件板 CBE20 正在进行固件升级 – 
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3.1.1.2 CU310-2 的 LED 状态说明 

CU310-2 DP 外壳的前面有四个 LED。  

表格 3- 8 LED 

RDY Ready 

COM 选件板 

输出 > 5V 编码器电源 > 5 V (TTL / HTL) 

MOD 运行模式（预留） 

控制单元启动期间，各个 LED 根据系统当前所处阶段亮起或熄灭。 LED 亮起后的颜色会

指明对应启动阶段的状态。 

出现故障时，控制单元会在出现故障的阶段终止启动。 此时，亮起的 LED 保持出现故障

之前的颜色，以便您结合这些 LED 颜色和熄灭的 LED 确定故障原因。 

CU310-2 DP 成功启动后，所有的 LED 将会熄灭一段时间。 如果 LED “RDY”持续显示绿

色，则说明系统已准备就绪。 

运行期间 LED 由载入的软件控制。 

控制单元 310-2 DP 启动期间 

表格 3- 9 装载软件 

LED 

RDY COM 输出 > 5V MOD 

状态 注释 

橙色 橙色 橙色 橙色 上电 所有 LED 亮起，约 1 秒 

红色 红色 熄灭 熄灭 硬件复位 按下复位键后 LED 亮起，约 1 
秒 

红色 红色 熄灭 熄灭 BIOS 已载

入 
- 

红色 
闪烁 2 Hz 

红色 熄灭 熄灭 BIOS 出错 载入 BIOS 时出错 

存储卡不存在或者出错 红色 
闪烁 2 Hz 

红色 
闪烁 2 Hz 

熄灭 熄灭 文件出错 

存储卡上没有软件或者软件出

错 
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表格 3- 10 固件 

LED 

RDY COM 输出 > 5V MOD 

状态 注释 

红色 橙色 熄灭 熄灭 固件加载 LED “COM”闪烁，无固定的闪

烁频率 

红色 熄灭 熄灭 熄灭 已载入固件 - 

熄灭 红色 熄灭 熄灭 固件校验 
（无 CRC 
错误） 

- 

红色 
闪烁 0.5 Hz 

红色 
闪烁 0.5 Hz 

熄灭 熄灭 固件校验 
（CRC 错

误） 

CRC 有错误 

橙色 熄灭 熄灭 熄灭 固件初始化 - 

控制单元 310-2 DP 运行中 

表格 3- 11 CU310-2 DP 运行期间 LED 的说明 

LED 颜色 状态 描述/原因 解决办法 

- 熄灭 无电子电源或者超出允许公差范围。 检查电源。 

持续亮 设备准备就绪。 
循环 DRIVE-CLiQ 通讯开始。 

- 

闪烁 0.5 Hz 调试/复位 - 

 

绿色 

闪烁 2 Hz 正在向存储卡写入。 - 

红色 闪烁 
2 Hz 

一般错误 检查参数设定/配置 

红色/绿色 闪烁 
0.5 Hz 

控制单元准备就绪，但是缺少软件授权。 安装缺少的授权。 

闪烁 
0.5 Hz 

正在升级相连 DRIVE-CLiQ 组件的固件。 - 

RDY 
(READY) 

 

橙色 
闪烁 
2 Hz 

DRIVE-CLiQ 组件固件升级完成。等待相应

组件的上电。 
接通组件。 
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LED 颜色 状态 描述/原因 解决办法 

绿色/橙色 
或 
红色/橙色 

 
闪烁 
2 Hz 

通过 LED 识别组件的功能已激活

（p0124[0]）。 
提示： 
这两种显示方法取决于通过 p0124[0] = 1 激
活识别时 LED 的状态。 

- 

- 熄灭 循环通讯（尚）未开始。 
提示： 
当控制单元处在准备就绪状态时，

PROFIdrive 也已做好通讯准备（参见 
LED：RDY）。 

- 

持续亮 开始进行循环通讯。 -  

绿色 闪烁 
0.5 Hz 

循环通讯还没有完全开始。 
可能的原因： 
- 控制器没有传送设定值。 
- 在等时同步运行中，控制器没有传送或传

送了错误的全局控制(GC)。 

- 

闪烁 
0.5 Hz 

PROFIBUS 主站发送了错误的参数设定或者

配置文件出错。 
协调主站/控制器和

控制单元之间的配

置。 

COM 

 

红色 

闪烁 
2 Hz 

循环总线通讯已中断或无法建立。 消除总线通讯故

障。 

MOD - 熄灭 - - 

- 熄灭 - - 输出 > 5 V 

橙色 持续亮 测量系统的电源电压是 24 V。1)  

1) 确保相连编码器的电源电压是 24 V。如果将 5 V 编码器连接到 24 V 上，可能会损坏编码器的电子元器件。 
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控制单元 310-2 PN 启动期间 

表格 3- 12 装载软件 

LED 

RDY COM 中断>5V MOD 

状态 注释 

橙色 橙色 橙色 橙色 上电 所有 LED 亮起，约 1 秒 

红色 红色 熄灭 熄灭 硬件复位 按下复位键后 LED 亮起，约 1 
秒 

红色 红色 熄灭 熄灭 BIOS 已载入 - 

红色 
闪烁 2 Hz 

红色 熄灭 熄灭 BIOS 出错 载入 BIOS 时出错 

存储卡不存在或者出错 红色 
闪烁 2 Hz 

红色 
闪烁 2 Hz 

熄灭 熄灭 文件出错 

存储卡上没有软件或者软件出

错 
 

表格 3- 13 固件 

LED 

RDY COM 中断>5V MOD 

状态 注释 

红色 橙色 熄灭 熄灭 固件加载 LED “COM”闪烁，无固定的闪

烁频率 

红色 熄灭 熄灭 熄灭 已载入固件 - 

熄灭 红色 熄灭 熄灭 固件校验 
（无 CRC 错

误） 

- 

红色 
闪烁 0.5 Hz 

红色 
闪烁 0.5 Hz 

熄灭 熄灭 固件校验 
（CRC 错

误） 

CRC 有错误 

橙色 熄灭 熄灭 熄灭 固件初始化 - 
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控制单元 310-2 PN 运行中 

表格 3- 14 CU310-2 PN 运行期间 LED 的说明 

LED 颜色 状态 描述/原因 解决办法 

- 熄灭 无电子电源或者超出允许公差范围。 检查电源。 

持续亮 设备准备就绪。 
循环 DRIVE-CLiQ 通讯开始。 

- 

闪烁 0.5 Hz 调试/复位 - 

 

绿色 

闪烁 2 Hz 正在向存储卡写入。 - 

红色 闪烁 
2 Hz 

一般错误 检查参数设定/配置 

红色/绿色 闪烁 
0.5 Hz 

控制单元准备就绪，但是缺少软件授权。 安装缺少的授权。 

闪烁 
0.5 Hz 

正在升级相连 DRIVE-CLiQ 组件的固件。 -  

橙色 
闪烁 
2 Hz 

DRIVE-CLiQ 组件固件升级完成。等待相

应组件的上电。 
接通组件。 

RDY 

(READY) 

绿色/橙色 
或 
红色/橙色 

闪烁 
2 Hz 

“通过 LED 识别组件”激活 (p0124[0])。 

提示： 

这两种颜色取决于通过设置 p0124[0] = 1 
激活时 LED 的状态。 

- 

- 熄灭 循环通讯（还）未开始。 

提示： 

当控制单元准备就绪时（参见 LED：

RDY），PROFIdrive 也已做好通讯准备。 

- 

持续亮 开始进行循环通讯。 - 

COM 

 

绿色 闪烁 
0.5 Hz 

循环通讯还未完全开始。 

可能的原因： 

• 控制器没有发送设定值。 

• 在等时同步运行中，控制器没有传输或

者传输了错误的全局控制（Global 
Control：GC） 

- 
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LED 颜色 状态 描述/原因 解决办法 

闪烁 
0.5 Hz 

PROFIBUS 主站发送了错误的参数设定或

者配置文件出错。 
协调主站/控制器和

控制单元之间的配

置。 

 

红色 

闪烁 
2 Hz 

循环总线通讯已中断或无法建立。 消除总线通讯故

障。 

MOD - 熄灭 - - 

- 熄灭 - - 输出 > 5 
V 橙色 持续亮 测量系统的电源电压是 24 V。1)  

1) 确保相连编码器的电源电压是 24 V。如果将 5 V 编码器连接到 24 V 上，可能会损坏编码器的电子元器件。 
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3.1.2 功率单元 

3.1.2.1 调节型电源模块（书本型） 

表格 3- 15 调节型电源模块 LED 的含义  

状态 

Ready DC Link  

说明，原因 
 

解决办法 
 

熄灭 熄灭 无电子电源或者超出允许公差范围。 – 

熄灭 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 – 

橙色 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 
直流母线电压上电。 

– 

绿色 

红色 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 
直流母线电压太高。 

检查进线电压 

橙色 橙色 正在建立 DRIVE-CLiQ 通讯。 – 

红色 – 该组件上至少存在一个故障。 

提示： 

LED 的控制与重新设置相应信息无关。 

清除故障，应答故障信息

绿色/红色

闪烁  
0.5 Hz  

– 正在进行固件下载。 – 

绿色/红色

闪烁 2 Hz 
– 固件下载已结束。 等待上电。 执行上电 

绿色/橙色 

或 

红色/橙色 

– “通过 LED 识别组件”激活 (p0124)。 

提示： 

这两种颜色取决于由 p0124 = 1 激活时 LED 的状

态。 

– 

 

 

警告  
直流母线电压过高有电击危险 
不管“DC Link” LED 处于哪种状态，组件上始终都存在危险的直流母线电压。 
请注意组件上加贴的警示标签！  

 



诊断  
3.1 通过 LED 进行的诊断 

 调试手册 
256 开机调试手册, (IH1), 01/2013, 6SL3097-4AF00-0RP3 

3.1.2.2 基本型电源模块（书本型） 

表格 3- 16 基本型电源模块上 LED 的含义  

状态 

Ready DC Link 

说明，原因 
 

解决办法 
 

熄灭 熄灭 无电子电源或者超出允许公差范围。 – 

熄灭 组件准备运行，并且开始进行循环 DRIVE-CLiQ 通
讯。 

– 

橙色 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 
直流母线电压上电。 

– 

绿色 

红色 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 
直流母线电压太高。 

检查电源电压。 

橙色 橙色 正在建立 DRIVE-CLiQ 通讯。 – 

红色 – 该组件上至少存在一个故障。 

提示： 

LED 的控制与重新设置相应信息无关。 

解除故障，并应答故障信

息。 

绿色/红色

闪烁 
0.5 Hz 

– 正在进行固件下载。 – 

绿色/红色

闪烁 2 Hz 
– 固件下载已结束。 等待上电。 执行上电 

绿色/橙色 

或 

红色/橙色

闪烁 

– “通过 LED 识别组件”激活 (p0124)。 

提示： 

这两种颜色取决于由 p0124 = 1 激活时 LED 的状

态。 

– 

 

 

警告  
直流母线电压过高有电击危险 
不管“DC Link” LED 处于哪种状态，组件上始终都存在危险的直流母线电压。 
请注意组件上加贴的警示标签！  
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3.1.2.3 书本型 SLM 5 kW 和 10 kW 

表格 3- 17 SLM 5 kW 和 10 kW - LED 的含义  

LED 颜色 状态 说明，原因 解决办法 

– 熄灭 无电子电源或者超出允许公差范围。 – 

绿色 持续亮 组件运行就绪。 – 

黄色 持续亮 预充电还没有结束。 
旁路继电器已释放 
EP 端子没有 DC 24 V 供电。 

– 

READY 

红色 持续亮 过热 
过电流 

通过输出端子诊断故

障，并通过输入端子应

答故障。 

– 熄灭 无电子电源或者超出允许公差范围。 – 

黄色 持续亮 许可公差范围内的直流母线电压。 – 

DC LINK 

红色 持续亮 直流母线电压超出公差范围。 
电网故障。 

检查电源电压。 

 

 

警告  
直流母线电压过高有电击危险 
不管“DC Link” LED 处于哪种状态，组件上始终都存在危险的直流母线电压。 
请注意组件上加贴的警示标签！ 

 



诊断  
3.1 通过 LED 进行的诊断 

 调试手册 
258 开机调试手册, (IH1), 01/2013, 6SL3097-4AF00-0RP3 

3.1.2.4 书本型 SLM 16 kW ~ 55 kW 

表格 3- 18 SLM ≥ 16 kW - LED 的含义  

状态 

Ready DC Link  

说明，原因 
 

解决办法 
 

熄灭 熄灭 无电子电源或者超出允许公差范围。 – 

熄灭 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 – 

橙色 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 
直流母线电压上电。 

– 

绿色 

红色 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 
直流母线电压太高。 

检查进线电压 

橙色 橙色 正在建立 DRIVE-CLiQ 通讯。 – 

红色 – 该组件上至少存在一个故障。 

提示： 

LED 的控制与重新设置相应信息无关。 

清除故障，应答故障信息 

绿色/红色

闪烁 0.5 
Hz 

– 正在进行固件下载。 – 

绿色/红色

闪烁 2 Hz 
– 固件下载已结束。 等待上电。 执行上电 

绿色/橙色 

或 

红色/橙色

闪烁 

– “通过 LED 识别组件”激活 (p0124)。 

提示： 

这两种颜色取决于由 p0124 = 1 激活时 LED 的状

态。 

– 

 

 

警告  
直流母线电压过高有电击危险 
不管“DC Link” LED 处于哪种状态，组件上始终都存在危险的直流母线电压。 
请注意组件上加贴的警示标签！ 
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3.1.2.5 单电机模块/双电机模块/功率模块 

表格 3- 19 电机模块上 LED 的含义  

状态 

Ready DC Link 

说明，原因 
 

解决办法 
 

熄灭 熄灭 无电子电源或者超出允许公差范围。 – 

熄灭 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 – 

橙色 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 
直流母线电压上电。 

– 

绿色 

红色 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 
直流母线电压太高。 

检查进线电压 

橙色 橙色 正在建立 DRIVE-CLiQ 通讯。 – 

红色 – 该组件上至少存在一个故障。 

提示： 

LED 的控制与重新设置相应信息无关。 

清除故障，应答故障信息 

绿色/红色

闪烁 0.5 
Hz 

– 正在进行固件下载。 – 

绿色/红色

闪烁 2 Hz 
– 固件下载已结束。 等待上电。 执行上电 

绿色/橙色 

或 

红色/橙色 

– “通过 LED 识别组件”激活 (p0124)。 

提示： 

这两种颜色取决于由 p0124 = 1 激活时 LED 的状

态。 

– 

 
 

警告  
直流母线电压过高有电击危险 
不管“DC Link” LED 处于哪种状态，组件上始终都存在危险的直流母线电压。 
请注意组件上加贴的警示标签！ 

 



诊断  
3.1 通过 LED 进行的诊断 

 调试手册 
260 开机调试手册, (IH1), 01/2013, 6SL3097-4AF00-0RP3 

3.1.2.6 书本型制动模块 

表格 3- 20 书本型制动模块上各个 LED 的含义  

LED 颜色 状态 说明，原因 解决办法 

– 熄灭 无电子电源或者超出允许公差范围。 

通过端子取消激活组件。 

– 

绿色 持续亮 组件运行就绪。 – 

READY 

红色 持续亮 缺少使能（输入端子） 
过热 
过电流跳闸 
I2t 监控动作 
接地/ 短路 

提示： 

模块过热时，经过一段冷却时间后才应答故障。 

通过输出端子诊断

故障，并通过输入

端子应答故障。 

– 熄灭 没有直流母线电压或没有电子电源电压，或电压超出

了允许的公差范围。 
组件没有生效。 

– DC LINK 

绿色 闪烁 组件生效（正在通过制动电阻给直流母线放电） – 
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3.1.2.7 紧凑书本型非调节电源模块 

表格 3- 21 紧凑书本型 SLM 上 LED 的含义  

状态 

RDY DC LINK 

说明，原因 
 

解决办法 
 

熄灭 熄灭 无电子电源或者超出允许公差范围。 – 

– 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 – 

橙色 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 
直流母线电压上电。 

– 

绿色 

红色 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 
直流母线电压太高。 

检查进线电压 

橙色 橙色 正在建立 DRIVE-CLiQ 通讯。 – 

红色 – 该组件上至少存在一个故障。 

提示： 

LED 的控制与重新设置相应信息无关。 

清除故障，应答故障信息 

绿色/红色

（0.5 Hz） 
– 正在进行固件下载。 – 

绿色/红色

（2 Hz） 
– 固件下载已结束。 等待上电。 执行上电 

绿色/橙色 
或 
红色/橙色 

– 激活“通过 LED 识别组件”的功能（p0124）。 
提示： 

这两种颜色取决于由 p0124 = 1 激活时 LED 的状

态。 

– 

 

 

警告  
直流母线电压过高有电击危险 
不管“DC Link” LED 处于哪种状态，组件上始终都存在危险的直流母线电压。 
请注意组件上加贴的警示标签！ 

 



诊断  
3.1 通过 LED 进行的诊断 

 调试手册 
262 开机调试手册, (IH1), 01/2013, 6SL3097-4AF00-0RP3 

3.1.2.8 紧凑书本型电机模块 

表格 3- 22 紧凑书本型电机模块上各个 LED 的含义  

状态 说明，原因 解决办法 
RDY DC LINK   

熄灭 熄灭 无电子电源或者超出允许公差范围。 – 

– 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 – 

橙色 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 
直流母线电压上电。 

– 

绿色 

红色 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 
直流母线电压太高。 

检查进线电压 

橙色 橙色 正在建立 DRIVE-CLiQ 通讯。 – 

红色 – 该组件上至少存在一个故障。 

提示： 

LED 的控制与重新设置相应信息无关。 

清除故障，应答故障信息 

绿色/红色

（0.5 Hz） 
– 正在进行固件下载。 – 

绿色/红色

（2 Hz） 
– 固件下载已结束。 等待上电。 执行上电 

绿色/橙色 
或 
红色/橙色 

– “通过 LED 识别组件”激活 (p0124)。 

提示： 

这两种颜色取决于由 p0124 = 1 激活时 LED 的状

态。 

– 

 

 

警告  
直流母线电压过高有电击危险 
不管“DC Link” LED 处于哪种状态，组件上始终都存在危险的直流母线电压。 
请注意组件上加贴的警示标签！ 
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3.1.2.9 装机装柜型 ALM 中的控制接口模块 

表格 3- 23 ALM 中控制接口模块上 LED “READY”和“DC LINK”的含义 

LED，状态 

Ready DC Link 

描述 

熄灭 熄灭 缺少电子电源或者超出了所允许的公差范围 

熄灭 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 

橙色 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 
直流母线电压上电。 

绿色 

红色 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 
直流母线电压太高。 

橙色 橙色 正在建立 DRIVE-CLiQ 通讯。 

红色 --- 该组件上至少存在一个故障。 

注： 
重新定义对应信息时，LED 的控制不受影响。 

绿色/红色

闪烁  
0.5 Hz 

--- 正在进行固件下载。 

绿色/红色

闪烁  
2 Hz 

--- 固件下载已结束。 等待上电。 

绿色/橙色 
或 
红色/橙色

闪烁 2 Hz 

--- “通过 LED 识别组件”激活 (p0124) 

注： 
这两种显示方法取决于通过 p0124 = 1 激活识别时 LED 的状态。 

 

表格 3- 24 ALM 模块中控制接口模块上 LED “POWER OK”的含义 

LED 颜色 状态 描述 

熄灭 直流母线电压 < 100 V，-X9:1/2 上的电压 < 12 V。 

亮起 组件准备运行 

POWER 
OK 

绿色 

闪烁 出现故障。如果在重新上电后 LED 仍闪烁，请联系西门子服务部

门。 
 



诊断  
3.1 通过 LED 进行的诊断 

 调试手册 
264 开机调试手册, (IH1), 01/2013, 6SL3097-4AF00-0RP3 

 

警告  
直流母线电压过高有电击危险 
不管“DC Link” LED 处于哪种状态，组件上始终都存在危险的直流母线电压。 
请注意组件上加贴的警示标签! 

 

3.1.2.10 装机装柜型 BLM 中的控制接口模块 

表格 3- 25 BLM 中控制接口模块上 LED “Ready”和“DC Link”的含义 

LED，状态 

Ready DC Link 

描述 

熄灭 熄灭 缺少电子电源或者超出了所允许的公差范围 

熄灭 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 

橙色 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 
直流母线电压上电。 

绿色 

红色 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 
直流母线电压太高。 

橙色 橙色 正在建立 DRIVE-CLiQ 通讯。 

红色 --- 该组件上至少存在一个故障。 

注： 
重新定义对应信息时，LED 的控制不受影响。 

绿色/红色

闪烁  
0.5 Hz 

--- 正在进行固件下载。 

绿色/红色

闪烁 2 Hz 
--- 固件下载已结束。 等待上电。 

绿色/橙色 
或 
红色/橙色

闪烁 2 Hz 

--- “通过 LED 识别组件”激活 (p0124) 

注： 
这两种显示方法取决于通过 p0124 = 1 激活识别时 LED 的状态。 
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表格 3- 26 BLM 模块中控制接口模块上 LED “POWER OK”的含义 

LED 颜色 状态 描述 

熄灭 直流母线电压 < 100 V，-X9:1/2 上的电压 < 12 V。 

亮起 组件准备运行 

POWER 
OK 

绿色 

闪烁 出现故障。如果在重新上电后 LED 仍闪烁，请联系西门子服务部

门。 
 

 

警告  
直流母线电压过高有电击危险 
不管“DC Link” LED 处于哪种状态，组件上始终都存在危险的直流母线电压。 
请注意组件上加贴的警示标签! 

 

3.1.2.11 装机装柜型 SLM 中的控制接口模块 

表格 3- 27 SLM 中控制接口模块上 LED “READY”和“DC LINK”的含义  

LED，状态 

READY DC LINK 

描述 

熄灭 熄灭 缺少电子电源或者超出了所允许的公差范围 

熄灭 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 

橙色 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 
直流母线电压上电。 

绿色 

红色 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 
直流母线电压太高。 

橙色 橙色 正在建立 DRIVE-CLiQ 通讯。 

红色 --- 该组件上至少存在一个故障。 

注： 
重新定义对应信息时，LED 的控制不受影响。 

闪烁 
0.5 Hz： 

绿色/红色 

--- 正在进行固件下载。 
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LED，状态 

READY DC LINK 

描述 

闪烁 2 
Hz： 

绿色/红色 

--- 固件下载已结束。 等待上电。 

闪烁 2 
Hz： 

绿色/橙色 
或 
红色/橙色 

--- “通过 LED 识别组件”激活 (p0124) 

注： 
这两种显示方法取决于通过 p0124 = 1 激活识别时 LED 的状态。 

 

表格 3- 28 SLM 模块中控制接口模块上 LED “POWER OK”的含义  

LED 颜色 状态 描述 

熄灭 直流母线电压 < 100 V，-X9:1/2 上的电压 < 12 V。 

亮起 组件准备运行 

POWER 
OK 

绿色 

闪烁 出现故障。如果在重新上电后 LED 仍闪烁，请联系西门子服务部

门。 
 

 

警告  
直流母线电压过高有电击危险 
不管“DC Link” LED 处于哪种状态，组件上始终都存在危险的直流母线电压。 
请注意组件上加贴的警示标签! 
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3.1.2.12 装机装柜型电机模块中的控制接口模块 

表格 3- 29 电机模块中控制接口板上 LED “Ready”和“DC Link”的含义 

LED，状态 

Ready DC Link 

描述 

熄灭 熄灭 缺少电子电源或者超出了所允许的公差范围 

熄灭 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 

橙色 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 
直流母线电压上电。 

绿色 

红色 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 
直流母线电压太高。 

橙色 橙色 正在建立 DRIVE-CLiQ 通讯。 

红色 --- 该组件上至少存在一个故障。 

注： 
重新定义对应信息时，LED 的控制不受影响。 

绿色/红色

闪烁 
0.5 Hz 

--- 正在进行固件下载。 

绿色/红色

闪烁 2 Hz 
--- 固件下载已结束。 等待上电。 

绿色/橙色 
或 
红色/橙色

闪烁 2 Hz 

--- “通过 LED 识别组件”激活 (p0124) 

提示： 

这两种颜色取决于由 p0124 = 1 激活时 LED 的状态。 

 

表格 3- 30 电机模块中控制接口板上 LED “POWER OK”的含义 

LED 颜色 状态 描述 

熄灭 直流母线电压 < 100 V，-X9:1/2 上的电压 < 12 V。 

亮起 组件准备运行 

POWER 
OK 

绿色 

闪烁 出现故障。如果在重新上电后 LED 仍闪烁，请联系西门子服务部

门。 
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警告  
直流母线电压过高有电击危险 
不管“DC Link” LED 处于哪种状态，组件上始终都存在危险的直流母线电压。 
请注意组件上加贴的警示标签! 

 

3.1.2.13 装机装柜型功率模块中的控制接口模块 

表格 3- 31 功率模块中控制接口模块上 LED “READY”和“DC LINK”的含义  

LED，状态 

READY DC LINK 

描述 

熄灭 熄灭 缺少电子电源或者超出了所允许的公差范围 

熄灭 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 

橙色 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 
直流母线电压上电。 

绿色 

红色 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 
直流母线电压太高。 

橙色 橙色 正在建立 DRIVE-CLiQ 通讯。 

红色 --- 该组件上至少存在一个故障。 

提示： 

LED 的控制与重新设置相应信息无关。 

闪烁 
0.5 Hz： 

绿色/红色 

--- 正在进行固件下载。 

闪烁 2 
Hz： 

绿色/红色 

--- 固件下载已结束。 等待上电。 

闪烁 2 
Hz： 

绿色/橙色 
或 
红色/橙色 

--- “通过 LED 识别组件”激活 (p0124) 

提示： 

这两种颜色取决于由 p0124 = 1 激活时 LED 的状态。 
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表格 3- 32 功率模块中控制接口模块 CIM 上 LED “POWER OK”的含义  

LED 颜色 状态 描述 

熄灭 直流母线电压 < 100 V，-X9:1/2 上的电压 < 12 V。 

亮起 组件准备运行 

POWER 
OK 

绿色 

闪烁 出现故障。如果在重新上电后 LED 仍闪烁，请联系西门子服务部门。

 

 

警告  
直流母线电压过高有电击危险 
不管“DC Link” LED 处于哪种状态，组件上始终都存在危险的直流母线电压。 
请注意组件上加贴的警示标签! 
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3.1.3 附加模块 

3.1.3.1 24 V 电源模块 

表格 3- 33 控制电源模块— LED 说明 

LED 颜色 状态 说明，原因 解决办法 

– 熄灭 无电子电源或者超出允许公差范围。 – READY 

绿色 持续亮 组件运行就绪。 – 

– 熄灭 无电子电源或者超出允许公差范围。 – 

橙色 持续亮 许可公差范围内的直流母线电压。 – 

DC LINK 

红色 持续亮 许可公差范围之外的直流母线电压 – 

3.1.3.2 机柜安装式编码器模块 SMC10 / SMC20 

表格 3- 34 机柜安装式编码器模块 10 / 20 （SMC10 / SMC20）， LED 的说明  

LED 颜色 状态 说明，原因 解决办法 

– 熄灭 无电子电源或者超出允许公差范围。 – 

绿色 持续亮 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 – 

橙色 持续亮 正在建立 DRIVE-CLiQ 通讯。 – 

红色 持续亮 该组件上至少存在一个故障。 

提示： 

LED 的控制与重新设置相应信息无关。 

消除并应答故障 

闪烁 0.5 
Hz 

正在进行固件下载。 – 绿色/红
色 

闪烁 2 
Hz 

固件下载已结束。 等待上电 执行上电 

RDY 
READY 

绿色/橙
色 

或 

红色/橙
色 

闪烁 “通过 LED 识别组件”激活(p0144)。 

提示： 

这两种颜色取决于由 p0144 = 1 激活时 LED 的状

态。 

– 
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3.1.3.3 机柜安装式编码器模块 SMC30 

表格 3- 35 机柜安装式编码器模块 SMC30 的 LED 的含义  

LED 颜色 状态 说明，原因 解决办法 

– 熄灭 无电子电源或者超出允许公差范围。 – 

绿色 持续亮 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 – 

橙色 持续亮 正在建立 DRIVE-CLiQ 通讯。 – 

红色 持续亮 该组件上至少存在一个故障。 

提示： 

LED 的控制与重新设置相应信息无关。 

消除并应答故障 

绿色/红
色 

闪烁 0.5 
Hz 

正在进行固件下载。 – 

绿色/红
色 

闪烁 2 
Hz 

固件下载已结束。 等待上电。 执行上电 

RDY 
READY 

绿色/橙
色 

或 

红色/橙
色 

闪烁 “通过 LED 识别组件”激活(p0144)。 

提示： 

这两种颜色取决于由 p0144 = 1 激活时 LED 的状

态。 

– 

– 熄灭 缺少电子电源或者超出了所允许的公差范围。 
电源电压 ≤ 5 V。 

– 输出 > 5 
V 

橙色 持续亮 存在编码器系统的电子电源。 
电源电压> 5 V。 

注意 

确保相连编码器的电源电压是 24 V。 预设置的 5 V 
编码器如果在 24 V 下运行，可能会导致编码器电子

器件损毁。 

– 
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3.1.3.4 机柜式编码器模块 SMC40 

表格 3- 36 机柜安装式编码器模块 SMC40 上 LED 的含义  

LED 颜色 状态 说明，原因 解决办法 

– 熄灭 缺少电子电源或者超出允许的公差范围。 – 

绿色 持续亮 组件运行就绪，正在进行周期性 DRIVE-CLiQ 通
讯。 

– 

橙色 持续亮 正在建立 DRIVE-CLiQ 通讯。 – 

红色 持续亮 该组件上至少存在一个故障。 

提示： 

LED 的控制与重新设置相应信息无关。 

消除并应答故障 

绿色/红
色 

闪烁 
2 Hz 

固件下载已结束。 等待上电。 执行上电 

RDY 
READY 

绿色/  
橙色 

或者 

红色/  
橙色 

闪烁 “通过 LED 识别组件”激活(p0144)。 

提示： 

这两种颜色取决于由 p0144 = 1 激活时 LED 的状

态。 

– 

每个通道中都有一个多功能 LED。 

3.1.3.5 CANopen 通讯板 CBC10 

表格 3- 37 以太网通讯板 CBC10 上的 LED 的含义  

LED 颜色 状态 说明，原因  解决办法 

– 不亮 无电子电源或者超出允许公差范围。 

通讯板损坏或未插入。 

– 

LED ON OPERATIONAL – 

LED 闪
烁 

PREOPERATIONAL 

无法建立 PDO 通讯 

– 

控制单元

上的 
 OPT 

绿色 

LED 闪
烁一次 

STOPPED 

只能进行 NMT 通讯 

– 
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LED 颜色 状态 说明，原因  解决办法 

LED ON BUS OFF 检查波特率 

检查布线 

LED 闪
烁一次 

ERROR PASSIVE MODE 

“error passive”故障计数器的值达到了 127。 在 
SINAMICS 驱动系统启动后，总线上没有其它激活

的 CAN 组件。 

检查波特率 

检查布线 

红色 

LED 闪
烁两次 

Error Control Event，出现了 Guard Event 检查与 CANopen 
主站的连接 

3.1.3.6 以太网通讯板 CBE20 

以太网通讯板 CBE20 上的 LED 的含义  

表格 3- 38 接口 X1400 端口 1-4 上各个 LED 的含义 

LED 颜色 状态 描述 

– 熄灭 缺少电子电源或者超出允许的公差范围（没有链接或错误链接）。 “Link”端
口 绿色 持续亮 在端口 x 上连接了另外的设备并且存在物理连接。 

– 熄灭 缺少电子电源或者超出允许的公差范围（没有数据活动）。 “Activity”
端口 黄色 闪烁 在端口 x 上正在接收或发送数据。 
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表格 3- 39 CBE20 上 LED“Sync”和“Fault”的含义 

LED 颜色 状态 描述 

– 熄灭 “Link Port”LED 变为绿色时： 
CBE20 正常运行，正在和配置的 IO 控制器交换数据。 

闪烁 • 响应监控时间已结束。 

• 通讯中断。 

• IP 地址错误。 

• 配置错误或没有配置 

• 参数设置错误 

• 设备名称错误或缺少设备名称 

• IO 控制系统不存在/已关闭，但以太网连接存在。 

• 其它 CBE20 故障 

Fault 

红色 

持续亮 CBE20 总线故障 

• 没有到子网/交换机的物理连接 

• 传输速度错误 

• 全双工传输没有激活 

– 熄灭 当“Link”端口的 LED 变绿时： 
控制单元的周期系统没有和 IRT 的周期同步。 生成了内部替代周期。 

闪烁 控制单元的周期系统已经和 IRT 的周期达到同步，正在进行数据交换。 

Sync 

绿色 

持续亮 任务系统和 MC-PLL 都与 IRT 周期同步。 

表格 3- 40 控制单元上 LED“OPT”的含义 

LED 颜色 状态 说明，原因 解决办法 

– 熄灭 无电子电源或者超出允许公差范围。 

通讯板损坏或未插入。 

– 

持续亮 通讯板准备就绪并且循环通讯开始。 – 绿色 

闪烁 
0.5 Hz 

通讯板已运行就绪，但还没有开始循环通讯。 
可能的原因： 

• 该组件上至少存在一个故障。 

• 通讯正在建立。 

– 

OPT 

红色 持续亮 经过 PROFINET 的循环通讯还未建立。 但可以进行

非循环通讯。 SINAMICS 等待参数化/配置报文 
– 
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LED 颜色 状态 说明，原因 解决办法 

闪烁 
0.5 Hz 

CBE20 的固件更新结束，带有错误。 
可能的原因： 

• CBE20 损坏。 

• 控制单元的存储卡损坏。 

CBE20 无法在该状态下使用。 

– 

闪烁 
2 Hz 

控制单元和 CBE20 之间的通讯出现异常。 
可能的原因： 

• 启动后拔出了通讯板。 

• 通讯板损坏 

正确插入通讯板，

必要时更换通讯

板。 

橙色 闪烁 
0.5 Hz 

正在进行固件更新。 – 

3.1.3.7 电压传感模块 VSM10 

表格 3- 41 电压传感模块 VSM10 上的 LED 的含义  

LED 颜色 状态 说明，原因 解决办法 

– 熄灭 无电子电源或者超出允许公差范围。 – 

绿色 持续亮 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 – 

橙色 持续亮 正在建立 DRIVE-CLiQ 通讯。 – 

红色 持续亮 该组件上至少存在一个故障。 

提示： 

LED 的控制与重新设置相应信息无关。 

消除并应答故障 

闪烁 0.5 
Hz 

正在进行固件下载。 – 绿色/红
色 

闪烁 2 
Hz 

固件下载已结束。等待上电 执行上电 

READY 

绿色/  
橙色 

或 

红色/  
橙色 

闪烁 “通过 LED 识别组件”激活(p0144)。 

提示： 

这两种颜色取决于由 p0144 = 1 激活时 LED 的状

态。 

– 
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3.1.3.8 DRIVE-CLiQ 集线器模块 DMC20 

表格 3- 42 DRIVE-CLiQ 集线器模块 DMC20 上的 LED 的含义  

LED 颜色 状态 说明，原因 解决办法 

– 熄灭 无电子电源或者超出允许公差范围。 – 

绿色 持续亮 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 – 

橙色 持续亮 正在建立 DRIVE-CLiQ 通讯。 – 

红色 持续亮 该组件上至少存在一个故障。 

提示： 

LED 的控制与重新设置相应信息无关。 

消除并应答故障 

闪烁 0.5 
Hz 

正在进行固件下载。 – 绿色/红
色 

闪烁 2 
Hz 

固件下载已结束。等待上电 执行上电 

READY 

绿色/  
橙色 

或 

红色/  
橙色 

闪烁 “通过 LED 识别组件”激活（p0154）。 

提示： 

这两种颜色取决于由 p0154 = 1 激活时 LED 的状

态。 

– 
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3.1.4 端子模块 

3.1.4.1 端子模块 TM15 

表格 3- 43 端子模块 TM15 上的 LED 的含义   

LED 颜色 状态 说明，原因 解决办法 

- 熄灭 缺少电子电源或者超出允许的公差范围。 – 

绿色 持续亮 组件运行就绪，正在进行周期性 DRIVE-CLiQ 通
讯。 

– 

橙色 持续亮 正在建立 DRIVE-CLiQ 通讯。 – 

红色 持续亮 该组件上至少存在一个故障。 

注： 
重新定义对应信息时，LED 的控制不受影响。 

消除并应答故障 

闪烁 0.5 
Hz 

正在进行固件下载。 – 绿色/红
色 

闪烁 2 Hz 固件下载已结束。 等待上电 执行上电 

READY 

绿色/橙
色 

或者 

红色/橙
色 

闪烁 “通过 LED 识别组件”激活（p0154）。 

提示： 
激活 p0154 = 1 时两种可能性取决于 LED 的状态。 

– 
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3.1.4.2 端子模块 TM31 

表格 3- 44 端子模块 TM31 上的 LED 的含义    

LED 颜色 状态 说明，原因 解决办法 

- 熄灭 缺少电子电源或者超出允许的公差范围。 – 

绿色 持续亮 组件运行就绪，正在进行周期性 DRIVE-CLiQ 通
讯。 

– 

橙色 持续亮 正在建立 DRIVE-CLiQ 通讯。 – 

红色 持续亮 该组件上至少存在一个故障。 

注： 
重新定义对应信息时，LED 的控制不受影响。 

消除并应答故障 

闪烁 0.5 
Hz 

正在进行固件下载。 – 绿色/红
色 

闪烁 2 Hz 固件下载已结束。 等待上电 执行上电 

READY 

绿色/  
橙色 

或者 

红色/  
橙色 

闪烁 “通过 LED 识别组件”激活（p0154）。 

提示： 
激活 p0154 = 1 时两种可能性取决于 LED 的状

态。 

– 

3.1.4.3 端子模块 TM120 

表格 3- 45 端子模块 TM120 的 LED 的含义    

LED 颜色 状态 说明，原因 解决办法 

- 熄灭 缺少电子电源或者超出允许的公差范围。 检查电源 

绿色 持续亮 组件准备运行并正在进行 DRIVE-CLiQ 循环通信。 - 

橙色 持续亮 正在建立 DRIVE-CLiQ 通讯。 - 

 

红色 

 

持续亮 

该组件上至少存在一个故障。 注： 
重新定义对应信息时，LED 的控制不受影响。 

消除并应答故障 

 

 

 

 

 

READY 
绿色/ 
红色 

闪烁 
0.5 Hz 

正在进行固件下载。 - 
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LED 颜色 状态 说明，原因 解决办法 

闪烁 
2 Hz 

固件下载已结束。等待上电 执行上电 

绿色/ 
橙色 
或 
红色/ 
橙色 

 

闪烁 
2 Hz 

“通过 LED 识别组件”激活（p0154）。 
提示： 
激活 p0154 = 1 时两种可能性取决于 LED 的状态。 

- 

3.1.4.4 端子模块 TM150 

表格 3- 46 端子模块 TM150 上的 LED 的含义  

LED 颜色 状态 说明，原因  解决办法 

– 熄灭 无电子电源或者超出允许公差范围。 检查电源 

绿色 持续亮 组件准备就绪并启动循环 DRIVE-CLiQ 通讯。 – 

橙色 持续亮 正在建立 DRIVE-CLiQ 通讯。 – 

 

红色 

 

持续亮 

该组件上至少存在一个故障。  

提示： 

LED 的控制与重新设置相应信息无关。 

消除并应答故障 

闪烁 
0.5 Hz 

正在进行固件下载。 – 绿色/ 
红色 

闪烁 
2 Hz 

固件下载已结束。 
等待重新上电。 

执行上电 

 

 

 

 

 

READY 

绿色/ 
橙色 
或 
红色/ 
橙色 

 

闪烁 
2 Hz 

“通过 LED 识别组件”激活（p0154）。 

提示： 

这两种颜色取决于由 p0154 = 1 激活时 LED 的状

态。 

– 
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3.1.4.5 端子模块 TM41 

表格 3- 47 端子模块 TM41 上的 LED 的含义   

LED 颜色 状态 说明，原因 解决办法 

- 熄灭 缺少电子电源或者超出允许的公差范围。 – 

绿色 持续亮 组件运行就绪，正在进行周期性 DRIVE-CLiQ 通
讯。 

– 

橙色 持续亮 正在建立 DRIVE-CLiQ 通讯。 – 

红色 持续亮 该组件上至少存在一个故障。 

注： 
重新定义对应信息时，LED 的控制不受影响。 

消除并应答故障 

闪烁 0.5 
Hz 

正在进行固件下载。 – 绿色/红
色 

闪烁 2 Hz 固件下载已结束。 等待上电。 执行上电 

READY 

绿色/ 橙
色 

或者 

红色/ 橙
色 

闪烁 “通过 LED 识别组件”激活（p0154）。 

提示： 
激活 p0154 = 1 时两种可能性取决于 LED 的状

态。 

– 

– 熄灭 已发现零脉冲，等待零脉冲输出；关闭 OR 组件。 – 

红色 持续亮 零脉冲未使能或者零脉冲查找。 – 

持续亮 在零脉冲处停止。 – 

Z 脉冲 

绿色 

闪烁 在每次虚拟旋转时输出零脉冲。 – 
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3.1.4.6 端子模块 TM54F 自 FW2.5 SP1 起 

表格 3- 48 端子模块 TM54F 上的 LED 的含义    

LED 颜色 状态 说明，原因 解决办法 

- 熄灭 缺少电子电源或者超出允许的公差范围。 – 

绿色 持续亮 组件运行就绪，正在进行周期性 DRIVE-CLiQ 通
讯。 

– 

橙色 持续亮 正在建立 DRIVE-CLiQ 通讯。 – 

红色 持续亮 部件出现至少一个故障。 
提示： 
LED 只受相关报告控制，不因更改设计而改变。 

消除并应答

故障 

闪烁 0.5 Hz 正在进行固件下载。 – 绿色/红色 

闪烁 2 Hz 固件下载已结束。 等待上电 执行上电 

READY 

绿色/ 橙色 

或者 

红色/ 橙色 

闪烁 “通过 LED 识别组件”激活（p0154）。 

提示： 
激活 p0154 = 1 时两种可能性取决于 LED 的状

态。 

– 

– 亮起 可以进行潜在故障检查的传感器电源运行正常。 – L1+, 
L2+,  红色 持续亮 可以进行潜在故障检查的传感器电源上有一个故

障。 
– 

– 亮起 传感器电源运行正常。  L3+ 

红色 持续亮 传感器电源上有一个故障。  

故障安全输入/双输入 

LED LED   – 

x x+1  常闭触点/常闭触点 1):(z = 0..9, x = 0, 2, ..18)  

– 红色 持续亮 输入端 x 和 x+1 上不同的信号状态  

– – – 输入端 x 上无信号并且输入端 x+1 上无信号  

 常闭触点/常开触点 1):(z = 0..9, x = 0, 2, ..18)  

– 红色 持续亮 输入端 x 和 x+1 上相同的信号状态  

– – – 输入端 x 上无信号但输入端 x+1 上有信号  

LED LED    

F_DI z 
(输入 x, 
(x+1)+, 
(x+1)-) 
 

x x+1  常闭触点/常闭触点 1):(z = 0..9, x = 0, 2, ..18)  
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LED 颜色 状态 说明，原因 解决办法 

绿色 绿色 持续亮 输入端 x 上有信号并且输入端 x+1 上有信号  

 常闭触点/常开触点 1):(z = 0..9, x = 0, 2, ..18)  

绿色 绿色 持续亮 输入端 x 上有信号但输入端 x+1 上无信号 – 
1)可以通过参数 p10040(TM54F) 分别设置输入端 x+1 (DI 1+, 3+, .. 19+)。 
 p10040 (TM54F) = 0: 输入 x+1 是常闭触点。 
p10040 (TM54F) = 1: 输入 x+1 是常开触点。 
 出厂设置： p10040 (TM54F) = 0，针对所有输入 x+1。 

单个数字量输入，非故障安全 

– 熄灭 数字量输入 x (x = 20..23)上无信号 – DI x 
 绿色 持续亮 数字量输入 x 上有信号 – 

带有相应回读通道的故障安全数字量输出 

F_DO y 
(0+..3+, 
0-..3-) 

绿色 持续亮 输出端 y (y=0 .. 3)输出一个信号 – 

在测试停止时用于输出 F_DO y (y = 0..3)的回读输入 DI 2y。 
LED 的状态也受外部线路的影响。 

DI 2y – 熄灭 两条输出线路 y+ 和 y- 其中一条上有信号，或者

输出 y 的两条线路上都有信号 
– 

 绿色 持续亮 两条输出线路 y+ 和 y- 上都没有信号 – 
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3.2 通过 STARTER 进行的诊断 
诊断功能可以在调试、故障查找、诊断和维修时，为调试和维修人员提供支持。  

前提条件 

● 调试工具 STARTER 在线运行。 

诊断功能 

调试工具 STARTER 可提供以下诊断功能： 

● 使用函数发生器进行信号设定 

● 使用轨迹功能进行信号记录  

● 使用测量功能进行控制响应的分析 

● 通过测量插口为外部测量设备器输出电压信号 

3.2.1 函数发生器 

函数发生器是调试工具 STARTER 的组成部分。 

函数发生器可以用于执行以下任务，例如：  

● 用于测量和优化控制环。 

● 用于比较所连接驱动的动态响应。 

● 设定简单的运行特性，无需编程。 

利用函数发生器可以生成不同波形的信号。  

输出信号可以在“模拟输出（r4818）”运行方式下通过 BICO 互连接入到控制环中。 

矢量控制时，该设定值还可根据所设置的运行方式，如作为转速设定值，扰动力矩或电流

设定值，接入到控制器结构中。 同时将自动排除上级控制环的影响。 
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属性 

● 伺服和矢量驱动下函数发生器的运行方式： 

– 模拟输出 

● 伺服驱动中函数发生器的运行方式： 

– 滤波器之后的转速设定值（转速设定值滤波器） 

– 滤波器之前的转速设定值（转速设定值滤波器） 

– 扰动力矩（电流设定值滤波器之后） 

– 滤波器之后的电流设定值（电流设定值滤波器） 

– 滤波器之前的电流设定值（电流设定值滤波器） 

● 可接入每台驱动器的拓扑。  

● 可任意设置以下信号波形： 

– 方波 

– 阶梯波 

– 三角波 

– 正弦波 

– PRBS（pseudo random binary signal：伪随机二进制信号，白噪声） 

● 每个信号都可能有偏移。 可设置一次启动来补偿偏移。 在补偿结束后开始生成信

号。 

● 可设置输出信号的最小值和最大值限制。 

函数发生器的接入点 

 

图 3-1 函数发生器上的接入点 
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其他信号波形 

函数发生器也可生成其他波形的信号。 

示例： 

如果信号为“三角波”，便可通过对“上限”进行相应的参数设置，产生被削去顶尖的三角

波。 

 

图 3-2 被削去顶尖的三角波 

函数发生器的参数设置和操作  

函数发生器通过 STARTER 操作和设置。 

 

图 3-3 函数发生器 

 

 说明 
有关参数设置和操作的其他信息可以参见“在线帮助”。  
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启用/停止函数发生器 
 

警告  
危险的轴运动引起的危险 
通过相应的函数发生器的参数设置（例如偏移），可以使电机“漂移”并运行到限位挡

块。 
函数发生器激活时，将不对驱动器的运动进行监控。  

 

启动函数发生器： 

1. 加载函数发生器。 

– 点击图标 。 

或 

– 在项目导航器中双击“ Drive” > “Drive_xy” > “Commissioning” > “Function 
generator”。 

2. 选择“Function generator as commissioning tool”。 

3. 选择运行方式，例如“Speed setpoint after filter”。 

4. 选择驱动，例如“SERVO_02”。 

5. 设置信号形状，例如“Rectangular”。 

6. 点击按钮“Assume control priority！”。 

7. 点击“Life sign monitoring”上的“Accept”按钮。 
（控制权按钮显示为黄色）。 

8. 点击图标 “Drive on”。 

9. 点击红色零旁边的三角形，启动函数发生器（按钮“Start FctGen”）。 

10. 通读指示信息“Note”，通过点击“Yes”进行确认。 

驱动启动，运行设置好的跟踪功能。 

此时可以进行跟踪记录。 

停止函数发生器： 

1. 点击按钮“FctGen inactive”。 

或 

2. 点击图标 “Drive off”停止驱动。 
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参数设置 

在调试工具“STARTER”中，可以按下功能栏中的符号 选择“Function Generator”设置窗

口。 

3.2.2 跟踪(Trace)功能 

3.2.2.1 单次跟踪 

使用跟踪功能，您可以根据触发条件按给定的时间段采集测量值。 也可以通过瞬间记录

采集测量值。 

在调试工具 STARTER 中可以通过参数设置窗口“跟踪”来进行跟踪功能的参数设置。 

调用参数设置窗口“跟踪” 

1. 在调试工具 STARTER 中点击图标 （设备跟踪-函数发生器）。 

这样就会显示参数设置窗口“跟踪”。 示例： 

 

图 3-4 跟踪(Trace)功能 
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跟踪功能的参数设置和操作  
 

 说明 
有关设置跟踪功能的参数和操作跟踪功能的详细信息请参见 STARTER 在线帮助中的“跟
踪、测量功能和自动控制器设置”一章。 

 

 

图 3-5 跟踪(Trace)功能 

当时间片从 < 4 ms 变为 ≥4 ms 时，设备时钟周期的显示以约 1 Hz 的频率闪烁 3 次（见

“属性”中的说明）。 时间片从 ≥ 4 ms 相反方向变为 < 4 ms 时，显示也会闪烁。 
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属性  

● 每个控制单元有两个相互独立的跟踪 

● 每个跟踪最多有 8 个记录通道 
单次跟踪使用超过 4 个通道时，设备时钟周期会自动从 0.125 ms（矢量控制时为 
0.250 ms）切换为 4 ms。 该操作可避免跟踪功能大幅影响 SINAMICS S120 的性

能。 

● 单次跟踪：  
SINAMICS S120 的设备时钟周期 
4 个通道以内： 0.125 ms（伺服控制）/0.250 ms（矢量控制） 
≥ 5 个通道：4 ms（伺服控制/矢量控制） 
上述跟踪周期可能更长。 

● 连续跟踪： 
 参数数据会不断写入存储器中，直到存储器写满。 后续参数数据随后会丢失。 
为避免出现这一情况，可以选择一个环形缓冲器。 在环形缓冲器激活时，当最后一个

跟踪参数存储完成后，调试工具 STARTER 会自动重新从头开始向跟踪存储器中写入

信息。 
SINAMICS S120 连续跟踪的设备时钟周期： 

– 4 个通道内：2 ms（伺服控制/矢量控制） 

– ≥ 5 个通道：4 ms（伺服控制/矢量控制） 
上述跟踪周期可能更长。 
当 4 ms 的时间片不可用时，需要转换为下一个更高的时间片。 

● 触发 

– 无触发（启用后立即开始记录） 

– 使用脉冲沿信号或电平触发 

● 调试工具 STARTER 

– 显示轴的比例可自动调整或手动设置 

– 通过光标进行信号测量 

● 可设置的跟踪周期： 是基准采样时间的整数倍 
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3.2.2.2 多次跟踪 

多次跟踪由多个单独的连续的跟踪组成。 多次跟踪可以用相同的配置（通道数、样本深

度、记录周期等）进行指定次数的跟踪，并将跟踪结果永久保存在驱动的存储卡上。 

不可以同时运行“连续跟踪”、“单次跟踪”和“多次跟踪”功能。 在配置错误时会输出报警

“A02097”。 但是次数设为 1 的多次跟踪的测量结果和单次跟踪功能没有区别。 
 

注意 
 

多次跟踪会缩短存储卡的寿命 
由于写访问会对存储介质造成损耗，因而多次跟踪可能会缩短存储卡的寿命。 

 

 说明 
整个系统的性能可能因正在进行的多次跟踪降低。 

 

前提条件 

只有当存储卡已插入且未被阻止时才可以执行多次跟踪。 在这种情况下，系统会发出报

警“A02098 多次跟踪不可存储”，报警值为“1”。  

执行多次跟踪 

激活多次跟踪 
 

 说明 
可单独为每个跟踪记录仪激活或设置多次跟踪。  

 

多次跟踪的激活和跟踪次数是由参数 p4840 来定义的。 设置 p4840 = 0 可取消激活多次

跟踪。  

设置 p4840 ≥ 1 可激活多次跟踪。 
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多次跟踪的过程 

1. 和传统的单次跟踪一样，多次跟踪由参数 p4700 启动。 

2. 在出现了触发器条件以及完整记录了跟踪数据后，多次跟踪功能会保存测量结果。 

3. 原先结束的单次跟踪由多次跟踪功能自动重新启动。 此时采用和之前相同的跟踪配置

（触发器条件、记录周期等）。 此时，之前的单次跟踪的记录缓冲器会清空。 

4. 所有后续的跟踪以同样的方式自动进行。 参数 r4841 中只会显示当前正在进行的跟踪

及其时滞（在 1 时启动）。 

跟踪状态 

可通过参数 r4705 读取相应的单次跟踪的状态。 多次跟踪无法先暂停然后继续。 多次跟

踪只能先终止然后重新启动。  

时间数据 

可通过两个参数为单次跟踪指定时间。 这两个参数分别显示在哪个时间点上满足了触发

器条件。  

● r4797 显示跟踪记录仪 0 的触发器时间点 

● r4798 显示跟踪记录仪 1 的触发器时间点 

3.2.2.3 StartUp 跟踪 

StartUp 跟踪由传统的包含所有跟踪配置（通道数、样本深度、记录周期等）的一个单次

跟踪组成。 在经过适当配置后，StartUp 跟踪会在驱动重启后自动激活。  

配置 StartUp 跟踪 

1. 设置所需的跟踪配置（例如：p4710，p4711…）。 

2. 设置参数 p4703[位 0] = 1 激活 StartUp 跟踪。 

驱动重启后会立即重新启动跟踪（无需用户操作）。 
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3.2.2.4 重要报警和参数一览 

重要报警和故障一览（参见 SINAMICS S120/S150 参数手册） 

 

• A02097 MTrace：多次跟踪未能激活 

• A02098 MTrace：未能保存 

 

重要参数一览（参见 SINAMICS S120/S150 参数手册） 

 

StartUp 跟踪 

• p4703 跟踪的选项 

多次跟踪 

• r4797 跟踪 0 触发器时间点 

• r4798 跟踪 1 触发器时间点 

• p4840 多次跟踪次数设置 

• r4841 多次跟踪的当前跟踪显示 
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3.2.3 测量功能 

测量功能用于驱动控制器的优化。 使用测量功能可以通过简单的参数设置封锁来自上级

控制环的影响，并分析各个驱动的动态响应。 为此，函数发生器与跟踪功能互联在一

起。 控制环将在某一位置上（例如转速设定值）被加上函数发生器的信号，在另一个位

置上（例如转速实际值）被跟踪功能记录下来。 完成测量功能的参数设置后，跟踪功能

也一并自动设置。 STARTER 会为跟踪功能预定义适合的运行方式。  

测量功能的参数设置和操作 

测量功能的参数设置和操作在调试工具 STARTER 中进行。 

 

图 3-6 “测量功能”初始画面 

 

 说明 
有关参数设置和操作的其他信息可以参见“在线帮助”。  
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测量功能 

● 转速控制器参考频率响应（转速设定值滤波器之后） 

● 转速控制器控制对象（电流设定值滤波器之后的励磁） 

● 转速控制器的干扰频率响应（电流设定值滤波器之后的干扰） 

● 转速控制器参考频率响应（转速设定值滤波器之前） 

● 转速控制器设定值阶跃（转速设定值滤波器之后） 

● 转速控制器干扰量阶跃（电流设定值滤波器之后的干扰） 

● 电流控制器参考频率响应（电流设定值滤波器之后） 

● 电流控制器设定值阶跃（电流设定值滤波器之后） 

启用/停止测量功能 
 

警告  
危险的轴运动引起的危险 
通过相应的测量功能的参数设置（例如偏移），可以使电机“漂移”并运行到限位挡块。  
测量功能激活时，将不对驱动器的运动进行监控。  

 

按以下方式启用测量功能： 

1. 建立测量功能启用的前提条件。 

2. 在项目树形图中选则驱动。 

3. 双击项目树形图中的“Drives” > “Commissioning” > “Measuring function”。 

4. 设置所需测量功能。 

5. 点击图标 “Download parameterization”将设置载入目标设备。 

6. 启用函数发生器（按钮“Start measuring function”）。 

按以下方式停止测量功能： 

测量功能运行一段时间，然后自动停止。 

1. 如果想立即停止，请点击按钮“Stop measuring function”。 
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参数设置 

在调试工具 STARTER 中，可点击工具栏中的图标 ，打开参数设置窗口“测量功能”： 

3.2.4 测量插口 

测量插口用于模拟信号的输出。 控制单元的每个测量插口可以输出任意一个可自由互联

的模拟信号。  
 

注意 
 

错误使用测量插口 
测量插口只能用于调试和维修。  
测量只能由经受过相应培训的专业人员执行。  

 

 
正视图 仰视图 

图 3-7 CU310-2 DP/PN 测量插口, CU320-2 DP/PN 测量插口  



诊断  
3.2 通过 STARTER 进行的诊断 

 调试手册 
296 开机调试手册, (IH1), 01/2013, 6SL3097-4AF00-0RP3 

测量插口的参数设置和操作 

测量功插口的参数设置和操作在调试工具 STARTER 中进行。 在项目窗口中点击 Control 
Unit > Inputs / outputs，打开测量插口的操作窗口。 在“Inputs / outputs”窗口中点击选项

卡“Measuring sockets”。 

 

图 3-8 “测量插口”初始画面 

 

 说明 
有关参数设置和操作的其他信息可以参见在线帮助。  
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属性 

● 分辨率： 8 位 

● 电压范围： 0 V 到 +4.98 V 

● 测量循环： 取决于测量信号 
（例如转速控制器周期为 125 μs 时的转速实际值） 

● 耐短路 

● 可设置比例 

● 可调整偏移 

● 可调整限制 

测量插口的信号流 

测量插口的信号流在功能图 8134 中有相关描述（参见 SINAMICS S120/S150 参数手

册）。  

通过测量插口可以输出哪些信号？  

通过测量插口输出的信号由相应的模拟输入源 p0771[0...2] 来确定。 

重要的测量信号（示例）： 

 

r0060 CO: 转速设定值滤波器之前的转速设定值 

r0063 CO: 转速实际值 

r0069[0...2] CO: 相电流实际值 

r0075 CO: 场电流设定值 

r0076 CO: 场电流实际值 

r0077 CO: 转矩电流的设定值 

r0078 CO: 转矩电流实际值 
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比例 

比例可以定义如何对测量信号进行处理。 为此必须用 2 点定义一条直线。 

示例： 

x1 / y1 = 0.0 % / 2.49 V x2 / y2 = 100.0 % / 4.98 V (默认设置) 

– 0.0 % 映射 2.49 V 

– 100.0 % 映射 4.98 V 

– 100.0 % 映射 0.00 V 

偏移 

偏移是额外加在要输出的信号上的。 这样要输出的信号就能显示在测量范围之内。 

限制 

● 限制 ON 

如果输出信号超出允许的测量范围，则会将信号限制为 4.98 V 或 0 V。 

● 限制 OFF 

如果输出信号超出允许的测量范围，会导致信号溢出。 溢出时，信号将会从 0 V 跳至 
4.98 V 或者从 4.98 V 跳至 0 V。 

通过测量插口输出测量值的示例 

在某一驱动上，转速实际值（r0063）通过测量插口 T1 输出。 

可以进行下列设置： 

1. 连接并设置测量设备。 

2. 互连信号（如使用 STARTER）。 

互连属于测量插口的模拟输入(CI)和需要进行输出的模拟输出(CO): 

CI: p0771[1] = CO: r0063 

3. 设置信号流（比例，偏移，限制）。 
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功能图（参见 SINAMICS S120/S150 参数手册） 

 

• 8134 诊断 - 测量插口 

重要参数一览（参见 SINAMICS S120/S150 参数手册） 

 

可调参数 

• p0771[0...2] CI: 测量插口信号源 

• p0777[0...2] 测量插口特性曲线值 x1 

• p0778[0...2] 测量插口特性曲线值 y1 

• p0779[0...2] 测量插口特性曲线值 x2 

• p0780[0...2] 测量插口特性曲线值 y2 

• p0783[0...2] 测量插口偏移 

• p0784[0...2] 测量插口限制 ON/OFF 

显示参数 

• r0772[0...2] 测量插口输出信号 

• r0774[0...2] 测量插口输出电压 

• r0786[0...2] 测量插口电压定标 
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3.3 诊断缓冲器 
在 SIMATIC S7 系列中已经实现了诊断缓冲器机制，通过它可以在自动化系统中将重要的

运行事件以日志的形式进行同步记录。但诊断缓冲器机制的可用性受控制单元的硬件型号

限制。  

诊断缓冲器位于非易失存储器中，这样就可以在对一个运行故障进行后续分析时读取之前

写入的相关数据（包括史前数据）。 

会记录在缓冲器中的重要事件有： 

● 故障 

● 启动状态（关机状态）中的重要变化和 DO 的局部启动 

● 调试过程 

● PROFIBUS/PROFINET 通讯的状态变化 

● 异常事件 

可在驱动设备属性（项目导航器中的图标 --> 鼠标右键）中通过选择 “Target device” > 
“Device diagnostics”调用诊断缓冲器中的记录。 

 

 说明 
STEP 7 正式版 
只有已经安装了 STEP7 正式版，才会在调试工具 STARTER 中显示设备诊断。 

 

诊断缓冲器收集的事件 

以下列出了为 SINAMICS 驱动设备定义的记录。 附加信息用 <> 标注。 

故障 

为每个可能 DO 编号都定义了一个记录。 故障代码和故障值作为附加信息记录。  

示例：  
故障 DO 5: 故障代码 1005 故障值 0x30012 
报警不在诊断缓冲器中记录。 广播发送的故障（向所有 DO 进行报告的故障）只在诊断

缓冲器中记录一次。 
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启动过程和启动状态变化 

对于启动过程，原则上只记录开始和结束。 当只能通过用户动作才能退出关机状态时

(r3988 = 1, 10, 200, 250, 325, 370, 800)，才会记录该启动状态（见 r3988）。 启动状态

和启动状态变化包括： 

● 上电 

● 启动时出错(r3988 = 1) 

● 启动时出现致命错误(r3988 = 10) 

● 等待首次调试(r3988 = 200) 

● 启动时拓扑出错(r3988 = 250) 

● 等待输入驱动类型(r3988 = 325) 

● 等待设置 p0009 = 0 (r3988 = 370) 

● 启动状态 r3988 = < 670 或 680 时的状态> 已达到 

● 启动完成，循环运行 

● 重新启动原因 < 0 = 内部原因; 1 = 热启动; 2 = 从已保存的文件启动; 3 = 下载之后启

动> 

● 驱动复位 p0972 = <模式> 

● DO <DO 编号> 局部启动已开始 

● DO <DO 编号> 局部启动已完成 

调试过程 

● 设备调试： 新状态 p0009 = < 新值 p0009 > 

● DO <DO 编号> 调试： 新状态 p0010 = < 新值 p0010 > 

● Ram2Rom DO <0 代表所有 DO> 已开始 

● Ram2Rom DO <0 代表所有 DO> 已完成 

● 项目下载已开始 

● DO <DO_编号> 已取消激活 

● DO <DO_编号> 重新激活 

● 组件 < 组件编号> 取消激活 
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● 组件 < 组件编号> 重新激活 

● 在固件升级后必须进行重新上电（DO <DO 号> 组件 < 组件编号 >） 

● 取消激活 DO <DO 号>并将 DO 设为不存在 

● 取消激活组件 < 组件编号> ，并将组件设为不存在 

通讯 (PROFIBUS, PROFINET, ...) 

● 循环数据交换 PZD <IF1 或 IF2> 已开始 

● 循环数据交换 PZD <IF1 或 IF2> 已完成 

● 在计时<天数> <毫秒数>条件下切换到 UTC 时间 

● 时间校正（调整），<校正值>秒数 

异常事件 

异常事件可在已有的 crash diagnostics（崩溃诊断）重新启动时获取。 异常事件总是第

一个记录到诊断缓冲器中，甚至在“上电”记录之前。 

● 异常事件“数据异常中断”地址： <程序计数器的内容> 

● 异常事件“浮点”地址： <程序计数器的内容> 

● 异常事件“预取异常中断”地址： <程序计数器的内容> 

● 异常事件类型 <类型编码> 信息： <信息取决于类型> 

时间戳的处理  

在成功执行了时钟同步（循环运行中）后，会将 UTC 时间用作时间戳。 该时间点之前

（上电并切换到 UTC 时间），所有记录都使用运行小时计数器。 此后的记录都会输入 
UTC 时间。 
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3.4 未调试轴的诊断 
参数 r0002 中会显示运行状态，以便您发现“电源模块”、“电机模块”“SERVO”和
“VECTOR”之类的未经调试的驱动对象。  

● r0002 “电源模块运行显示” = 35: 执行首次调试 

● r0002 “驱动运行显示” = 35: 执行首次调试 

如果 p3998[D]=0 出现在某一数据组中，则会显示参数 r0002 “驱动运行显示” = 35。 参数 
p3998 确定是否仍必须执行驱动的首次调试（0 = 是，2 = 否）。 

如果对所有数据组的电机参数和控制参数执行了计算且未出错（见 r3925 位 0=1），而且

编码器选择 p0400 没有设为 10100（识别编码器），则参数 p3998 会设置为 2。 

所有驱动数据组(DDS)都必须进行调试才能退出调试，这一状态可通过检查相关的参数来

确认（另见 SINAMICS S120/S150 参数手册中的 F07080）。 

电源模块 

如果电网电压和电网频率的设置合适，电源设备（带有 DRIVE-CLiQ 的调节型电源模

块、基本型电源模块和非调节型电源模块）可视为进行过了调试。 电网频率应使用缺省

值 50 Hz 或 60 Hz。 

电网电压 p0210 有可能需要按当前的电网进行调整。 

在进行了必要的电网电压调整，并将参数 p3900 “快速调试完成”设为 3 后，才能退出状态 
r0002 “电源模块运行显示” = 35。 

例如在 400 V 的设备上，电压 p0210 的缺省值为 400V。 这样虽然在所有 380 V 到 480 
V 的电网上都能接通设备，但却无法获得最佳的运行状态，而且还会报警（参见 
SINAMICS S120/S150 参数手册）。 
如果设备不在 400V 的电网下工作，则应调整额定电压 p0210。 这也可以在首次通电后

进行，方法是设置 p0010 = 1。 
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电机模块 

如果在每个驱动数据组(DDS)中相应的电机数据组和编码器数据组都填上了有效数据，则

驱动设备可被视为经过了调试：  

● 电机数据组 (MDS): 
p0131, p0300, p0301 等 (见 SINAMICS S120/S150 参数手册)  

● 编码器数据组 (EDS): 
p0141, p0142, p0400 等 (见 SINAMICS S120/S150 参数手册)  

在通过快速调试对电机数据和编码器数据进行了设置后 
(p0010 = 1 ->0)，应将 p3900 “快速调试完成” 设为大于 0 的值退出设置。 

如果调试不能通过快速调试进行，则应通过 p0010 = 3 (p0340[0...n] “自动计算电机/控制

参数” =1，在输入铭牌数据之后输入电机数据，然后通过 p0010 = 4 输入编码器数据。 

如果不满足上述条件，则在相应驱动的 r0002 中会显示 r0002 = 35: “执行首次调试”。 

此时系统不会考虑接通（脉冲使能）所需的 BICO 信号源是否已经设置或还处于值 0。 示
例： 

● p0840 “BI: ON/OFF1”或 

● p0864 “BI: 电源模块运行” 

如果在调试之后，参数 p0010 的全部 DDS 又重新设置为大于 0 的值，则在 r0002 中会

显示 r0002 = 46: “接通禁止 - 退出调试模式(p0009, p0010)”。 

这样驱动设备虽然经过了调试，但却无法进行脉冲使能。 

p0010 = 1 (快速调试) 的提示: 
p3900 > 0 (在 p0010 = 1 时) 的快速调试对所有已输入了电机数据和编码器数据的 DDS 
都有效。 

这表示，如果快速调试在执行第二次，第三次 ... 时，会覆盖或重新计算已经计算过的和

可能已由用户进行过调整的数据。 

因此某一特定 DDS 的后续调试应通过 p0010 = 3 和 p0010 = 4 有目标地进行（例如修改

电机），而不要通过 p0010 = 1。 
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示例 

下图以图表方式显示了未经调试的馈电设备和驱动设备的诊断。 其中假设了一个功率部

件(DO2)，并分别配置了两个 DDS, MDS 和 EDS。 DO1 代表 CU。 

设备调试已经执行。 

数据组的数量，属于 DO2 的组件都已进行了输入，并且也已经进行了数据组的分配。 

 

图 3-9 未调试轴的诊断 
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3.5 故障和报警信息 

3.5.1 故障和报警概述 

通过报告信息显示驱动设备各组件识别到的错误和状态。  

报告信息分为故障和报警。 
 

 说明 
各故障和报警详见 SINAMICS S120/S150 参数手册中的“故障和报警”一章。 在该手册的

“功能图” - “故障和报警”章节中还介绍了故障缓冲器，报警缓冲器，故障触发器和故障配

置。 
 

故障和报警的属性 

● 故障（代码 F01234）  

– 表示为 Fxxxxx。 

– 会导致故障响应。 

– 在消除原因后必须应答。 

– 通过控制单元和 LED RDY 显示状态。 

– 通过 PROFIBUS 状态信号 ZSW1.3（故障生效）显示状态。 

– 记录在故障缓冲器中。 

● 报警（代码 A56789）  

– 表示为 Axxxxx。 

– 对驱动设备不产生进一步影响。 

– 在消除原因后报警会自动复位。 不需要应答。 

– 通过 PROFIBUS 状态信号 ZSW1.7（报警生效）显示状态。 

– 记录在报警缓冲器中。 

● 故障和报警的通用属性 

– 可设置（例如，将故障改为报警，故障响应）。 

– 能根据报告信息触发。 
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– 报告可由外部信号触发。 

– 包含组件号，以指出发生故障的 SINAMICS 组件 

– 包含信息的诊断信息 

应答故障 

在故障和报警列表中规定了，应如何对每个故障在消除原因后进行应答。 

● 使用“POWER ON”应答故障 

– 对驱动设备执行断电/接通（POWER ON） 

– 按下控制单元上的 RESET 键 

● 使用“IMMEDIATELY”应答故障 

– 通过 PROFIBUS 控制信号 

STW1.7 (复位故障存储器): 0/1 脉冲沿 

设置 STW1.0 (ON/OFF1) = “0”和“1” 

– 通过外部输入信号 

BI 以及与数字输入的互联 

p2103 = “需要的信号源” 

p2104 = “需要的信号源” 

p2105 = “需要的信号源” 

涉及控制单元的所有驱动对象(DO) 

p2102 = “需要的信号源” 

● 使用“PULSE INHIBIT”应答故障 

– 故障只可在脉冲禁止 (r0899.11=0) 时应答。 

– 应答方式同 IMMEDIATELY 应答。 
 

 说明 
只有应答了所有当前存心的故障信息后，驱动才能恢复运行。  
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3.5.2 故障和报警缓冲器 
 

 说明 
每个驱动都有一个故障缓冲器和一个报警缓冲器。 在这两个缓冲器中记录了驱动和设备

的报告信息。  
在关闭控制单元时，以非易失性方式保存故障缓冲器，即在接通之后，故障缓冲器的历史

记录仍然存在。  
 

 说明 
故障/报警缓冲器中的记录会延时。 因此，当故障/报警缓冲器识别到变化(r0944, r2121)
并出现了“故障生效”/“报警生效”后，再从中读取信息。  
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故障缓冲器 

所出现的故障会按以下方式记录到故障缓冲器中：  

r0949[63] [I32]
r2133[63] [ Float]

r0945[0]

r0945[1]

r0945[7]

r0945[56]

r0945[57]

r0945[63]

r0945[8]

r0945[9]

r0945[15]

r0949[0] [I32]
r2133[0] [Float]

r0949[1] [I32]
r2133[1] [Float]

r0949[7] [I32]
r2133[7] [Float]

r0949[56] [I32]
r2133[56] [ Float]

r0949[57] [I32]
r2133[57] [ Float]

r0949[8] [I32]
r2133[8] [Float]

r0949[9] [I32]
r2133[9] [Float]

r0949[15] [I32]
r2133[15] [ Float]

r0948[0] [ms]
r2130[0] [ d]

r0948[1] [ms]
r2130[1] [ d]

r0948[7] [ms]
r2130[7] [ d]

r0948[56] [ms]
r2130[56] [d]

r0948[57] [ms]
r2130[57] [d]

r0948[63] [ms]
r2130[63] [d]

r0948[8] [ms]
r2130[8] [ d]

r0948[9] [ms]
r2130[9] [ d]

r0948[15] [ms]
r2130[15] [d]

r2109[0] [ ms]
r2136[0] [d]

r2109[1] [ ms]
r2136[1] [d]

r2109[7] [ ms]
r2136[7] [d]

r2109[56] [ms]
r2136[56] [d]

r2109[57] [ms]
r2136[57] [d]

r2109[63] [ms]
r2136[63] [d]

r2109[8] [ ms]
r2136[8] [d]

r2109[9] [ ms]
r2136[9] [d]

r2109[15] [ms]
r2136[15] [d]

r3115[63]

r3115[57]

r3115[56]

r3115[15]

r3115[9]

r3115[8]

r3115[7] <1>

r3115[7]

r3115[0]

<1>

r3122[0]

<1>

r3122[7]

r3122[7]

r3122[8]

r3122[9]

r3122[15]

r3122[56]

r3122[57]

r3122[63]

r3120[0]

r3120[7]

r3120[7]

r3120[8]

r3120[9]

r3120[15]

r3120[56]

r3120[57]

r3120[63]

 

图 3-10 故障缓冲器的结构 
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故障缓冲器的属性： 

● 一个新的故障事件由一个或多个故障组成并会记录在“当前故障事件”中。 

● 在缓冲器中按照发生的时间顺序进行排列。 

● 当出现了一个新的故障事件时，故障缓冲器会重新进行排列。 历史记录会在“已应答

的故障事件”中从 1 到 7 排列。 

● 只要在“当前故障事件”中对至少一个故障进行了原因消除和应答，故障缓冲器都会进

行重新排列。 未清除的故障仍会保留在“当前故障事件”中。 

● 如果“当前故障事件”中已记录了 8 个故障，那么当再出现一个新的故障时，参数下标 
7 中的故障会被新故障覆盖。 

● 故障缓冲器每修改一次，r0944 都会加一。 

● 发生故障时，可能会输出一个故障值(r0949)。 故障值可用于故障的精确诊断，含义见

故障描述。 

清零故障缓冲器 

● 清零所有驱动对象的故障缓冲器： 
p2147 = 1 --> 执行清零之后将自动设定 p2147 = 0。 

● 清零某个驱动对象的故障缓冲器： 
p0952 = 0 --> 该参数属于某个驱动对象。 

当出现下列事件时自动清零故障缓冲器： 

● 调整出厂设置 (p0009 = 30 和 p0976 = 1)。 

● 有结构性变化的下载 (例如驱动对象的数量改变)。 

● 加载其它参数值之后起动 (例如 p0976=10)。 

● 将固件升级到新版本。 
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报警缓冲器，历史报警 

报警缓冲器中的报警由报警代码、报警值和报警时间（收到，解决）组成。 历史报警占

用参数中靠后的下标([8...63])。  

 

图 3-11 报警缓冲器的结构 

所出现的报警会按以下方式记录到报警缓冲器中： 

在报警缓冲器中最多能显示 64 个报警： 

● 下标 0 .. 6: 显示最早的 7 个报警 

● 下标 7: 显示最新的一个报警 

在历史报警中最多能显示 56 个报警： 

● 下标 8: 显示最新的一个报警 

● 下标 9 .. 63: 显示最早的 55 个报警 
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报警缓冲器/历史报警的属性： 

● 报警在缓冲器中按照出现的时间顺序从 7 到 0 排列，在历史报警中为 8 到 63。 

● 如果报警缓冲器中已记录了 8 个报警，那么当出现一个新的报警时，已经解决的报警

会被转移到历史报警中。 

● 报警缓冲器每修改一次，r2121 都会加一。 

● 发生报警时，可能会输出一个报警值(r2124)。 报警值可用于报警的精确诊断，含义见

报警描述。 

报警缓冲器清零，下标 [0...7]： 

● 报警缓冲器下标[0...7]按以下方式复位： p2111 = 0 

3.5.3 报告信息的配置 

在驱动系统中故障和报警的属性已进行了永久性的定义。 

对于一些报告信息而言，可以在驱动系统所定义的框架内进行以下设置： 

 

修改报告类型（示例） 

选择报告信息 设置报告类型 

p2118[5] = 1001 p2119[5] = 1: 故障(F, Fault) 

  = 2: 报警 (A, Alarm) 

  = 3: 不报告(N, No Report) 

修改故障响应（示例） 

选择报告信息 设置故障响应 

p2100[3] = 1002 p2101[3] = 0: 无 

  = 1: OFF1 

  = 2: OFF2 

  = 3: OFF3 

  = 4: STOP1 (暂不可用) 

  = 5: STOP2 

  = 6: IASC/DC 制动 
内部电枢短路或直流制动 

  = 7: ENCODER (p0491) 
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修改应答（示例） 

选择报告信息 设置应答 

p2126[4] = 1003 p2127[4] = 1: 上电 

  = 2: 立即 

  = 3: 脉冲封锁 

每个驱动对象可以更改 19 个信息类型。 
 

 说明 
如果在驱动对象之间存在 BICO 互联连接，则所有互联连接的对象都必须进行配置。  
示例： 
TM31 与驱动 1 和 2 进行了 BICO 互联连接，F35207 需要改为报警。 

• p2118[n] = 35207 和 p2119[n] = 2 

• 在 TM31、驱动 1 和驱动 2 上也必须如此设置。 
 

 说明 
只能对列在加下标的参数中的报告信息进行需要的修改。 报告信息的所有其它设置都保

持出厂设置或者恢复为出厂设置。  
示例：  

• 可以修改列在 p2128[0...19] 下的报告信息的类型。 所有其它的报告信息都为出厂设

置。 

• F12345 的故障响应已通过 p2100[n] 进行了修改。 其应再次恢复为出厂设置 
(p2100[n] = 0)。 

 

根据报告信息触发 (示例)  

 

选择报告信息 触发信号 

p2128[0] = 1001 BO: r2129.0 

或 

p2128[1] = 1002 BO: r2129.1 
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 说明 
CO: r2129 的值可作为组触发器使用。 
CO: r2129 = 0 所选择的报告信息都未出现。 
CO: r2129 > 0 组触发器。 
至少出现了 1 个选中的报告信息。 
应检查各个二进制互联输出 BO: r2129。 

 

从外部触发报告信息 

如果相应的 BI 与输入信号进行了互联连接，那么故障 1，2 或 3 或者报警 1，2 或 3 可以

通过外部输入信号来触发。  

在从外部触发了控制单元驱动对象上的故障 1 到 3 之后，该故障也会出现在所有相关的

驱动对象上。 如果该外部故障在其它的驱动对象上触发，则只会出现在这一个驱动对象

上。 

 

BI: p2106 ––> 外部故障 1 ––> F07860(A) 

BI: p2107 ––> 外部故障 2 ––> F07861(A) 

BI: p2108 ––> 外部故障 3 ––> F07862(A) 

BI: p2112 ––> 外部报警 1 ––> A07850(F) 

BI: p2116 ––> 外部报警 2 ––> A07851(F) 

BI: p2117 ––> 外部报警 3 ––> A07852(F) 
 

 

 说明 
外部故障或报警由 1/0 信号触发。  
一般情况下，外部故障和报警都不是驱动内部报告信息。 因此，外部故障和报警的原因

应从驱动设备外部进行消除。  
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3.5.4 功能图与重要参数一览 

重要功能图一览（参见 SINAMICS S120/S150 参数手册）  

 

• 1750 一览 - 监控，故障，报警 

• 8060 诊断 - 故障缓冲器 

• 8065 诊断 - 报警缓冲器 

• 8070 诊断 - 故障/报警触发字 (r2129) 

• 8075 诊断 - 故障/报警配置 

• 8134 诊断 - 测量插口 

重要参数一览（参见 SINAMICS S120/S150 参数手册） 

 

• r0944 CO:记录故障缓冲器修改次数的计数器 

• p0952 故障计数器 

• p2100[0...19] 选择故障号，修改响应 

• r2139.0...12 CO/BO: 故障/报警 1 的状态字 

• r3120[0...63] 故障信息中包含的组件号 

• r3121[0...63] 报警信息中包含的组件号 

• r3122[0...63] 故障信息中包含的诊断属性 

• r3123[0...63] 报警信息中包含的诊断属性 



诊断  
3.5 故障和报警信息 

 调试手册 
316 开机调试手册, (IH1), 01/2013, 6SL3097-4AF00-0RP3 

3.5.5 故障信息的广播 

控制单元的故障传送  

驱动对象“控制单元”触发故障时，总是会假设该故障影响到了驱动的中央功能。 因此会将

这些故障传送至其他所有驱动对象（广播）。 故障响应对控制单元驱动对象生效，也对

其他所有驱动对象生效。 控制单元上 DCC 功能图中利用 DCC 功能块设置的故障也同样

会被广播发送。  

对于广播发送的控制单元故障，必须在该故障传送至的所有驱动对象上对其进行应答。 
这样一来会在控制单元上自动应答该故障。 也可在控制单元上应答驱动对象故障。  

报警不会由控制单元进行广播发送，即不会将其传送至其他驱动对象。 

示例 

驱动对象的故障仅会传送至驱动；即 TB30 上的故障会使驱动停止，而驱动上的故障则不

会使 TB30 停止。 

BICO 互联中故障信息的传送  

两个或多个驱动对象之间存在 BICO 互联时，故障信息会从控制单元、TB30、DMC20、
DME20、所有端子模块或 ENCODER-DO 这些类型的驱动对象传送给带闭环功能的驱动

对象，例如电源或电机模块。 这两个驱动对象类型组内部之间不会转送故障。 

此特性也适用于 DCC 图中上述驱动对象类型上借助 DCC STM 设置的故障。 



 诊断 
 3.5 故障和报警信息 

调试手册 
开机调试手册, (IH1), 01/2013, 6SL3097-4AF00-0RP3 317 

3.5.6 警告级 

故障和报警的警告级  

在之前的警告级“报警”和“故障”的循环报文中增加了区别性的警告信息。 

警告级从“单纯”的报警和故障中又延伸了 3 个细化的报告等级。 

该功能允许上级控制器（SIMATIC，SIMOTION，SINUMERIK 等）对驱动侧的警告信息

作出不同的控制响应。 

对于驱动而言，新状态的作用类似于报警，即驱动“不会”作出任何立即响应（就像以前的

“报警”警告级）。 

警告级信息在状态字 ZSW2 的位 5 - 6 (SINAMICS) 或位 11-12 (SIMODRIVE 611) 中进

行描述（另见： SINAMICS S120 功能手册，驱动功能，PROFIdrive 通讯的“循环通讯”
章节中的“ZSW2”）。 

ZSW2: 适用于 SINAMICS Interface Mode p2038=0 (功能图 2454) 

位 5 - 6 警告级“报警” 

= 0: 报警 (以前的警告级) 

= 1: 警告级 A 的报警 

= 2: 警告级 B 的报警 

= 3: 警告级 C 的报警 

ZSW2: 适用于 SIMODRIVE 611 Interface Mode p2038=1 (功能图 2453) 

位 11 - 12 警告级“报警” 

= 0: 报警 (以前的警告级) 

= 1: 警告级 A 的报警 

= 2: 警告级 B 的报警 

= 3: 警告级 C 的报警 

这些用于区分报警的属性隐含地分配给了相应的报警号。 对报警中现有警告级的响应是

通过用户程序在上级控制器中定义的。 
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警告级的说明 

● 警告级 A： 不限制驱动的当前运行 

– 例如，未激活测量系统时报警 

– 不妨碍当前的运行 

– 防止切换到有缺陷的测量系统 

● 警告级 B： 从时间上限制运行 

– 例如，预警温度： 如无进一步措施，将会关闭驱动 

– 在某一时间段后 -> 附加故障 

– 在超过关机阈值后 -> 附加故障 

● 警告级 C： 从功能上限制运行 

– 例如，降低电压极限/电流极限/转矩极限/转速极限(i2t) 

– 例如，以降低的精度/分辨率继续运行 

– 例如，不带编码器继续运行 
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3.6 编码器故障处理 
所出现的编码器故障可以根据其编码器通道，通过编码器接口(Gn_STW.15)或所属 DO 
的驱动接口，在 PROFIdrive 报文中分别进行应答。  

配置示例：双编码器系统 

● 编码器 G1 电机测量系统 

● 编码器 G2 直接测量系统 

示例： 全部编码器都报告编码器故障。 

● 故障会传输到编码器接口并从这里记录到 PROFIDRIVE 报文的编码器通道 n 中，将

会占用编码器状态字的位 15 (Gn_ZSW.15 = 1)。 

● 故障将会转送给驱动对象。 

● 电机测量系统的故障会将驱动对象设为故障(ZSW1 位 3)，这些故障还会通过驱动接口

进行报告。 在故障缓冲器 p0945 中会生成一条记录。 设置的故障响应将会从内部开

始。 

● 直接测量系统的故障会通过所属的驱动对象改设为“报警”并通过驱动接口进行报告

(ZSW1 位 7)。 在报警缓冲器 r2122 中会生成一条记录。 
不会启动任何驱动响应。 
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图 3-12 编码器的故障处理 

报警 A：  
如果对编码器故障进行应答，故障会立即取消。 
故障 F：  
驱动对象上的故障会一直存在，直到通过循环接口对其进行应答。 
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循环应答 

通过编码器接口应答(Gn_STW.15)   

可能出现以下响应： 

● 如故障不再存在，编码器将设为正常，编码器接口中的故障位被应答。 在应答之后编

码器模块的 RDY LED 显示为绿色。 
该功能适用于所有通过编码器接口连接的编码器，与测量系统的类型无关（不管是电

机编码器还是直接编码器）。 

● 如果故障仍然存在或出现了其它故障，则表明应答未成功，优先级最高的故障（可以

是同一个或另一个故障记录）将通过编码器接口传送。 
编码器模块的 RDY LED 仍然显示红色。 
该功能适用于所有通过编码器接口连接的编码器，与测量系统的类型无关（不管是电

机编码器还是直接编码器）。 

● 驱动对象不通过编码器接口进行记录。 当所设置的故障仍存在于驱动对象中时，那么

这时驱动也无法启动没有故障的编码器。 
驱动对象也要额外地通过驱动接口(复位故障存储器)进行应答。 

通过驱动接口应答(STW1.7 (循环) 或 p3981(非循环))  

可能出现以下响应： 

● 如故障不再存在，编码器将设为正常，驱动接口中的故障位被应答。 编码器模块的 
RDY LED 显示绿色。  
逻辑上属于该驱动的所有编码器上都会进行应答。 

● 如果故障仍然存在或出现了其它故障，则表明应答未成功，下一个优先级最高的故障

将通过驱动接口和相关的编码器接口传送。 

● 编码器模块的 RDY LED 仍然显示红色。 

● 已分配的编码器上的编码器接口未通过驱动接口上的应答被复位，所设置的故障仍然

存在。 

● 编码器接口必须额外地通过相应的编码器控制字 Gn_STW.15 进行应答。 
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附录 A
A.1 硬件组件的可用性 

表格 A- 1 自 2006 年 3 月起可订购的硬件组件 

号 硬件组件 订货号 版本 改版 

1 AC 驱动器 (CU320, PM340) 参见样本  新版 

2 SMC30 6SL3055-0AA00-5CA1  带 SSI 支持 

3 DMC20 6SL3055-0AA00-6AAx  新版 

4 TM41 6SL3055-0AA00-3PAx  新版 

5 SME120 
SME125 

6SL3055-0AA00-5JAx 
6SL3055-0AA00-5KAx 

 新版 

6 BOP20 6SL3055-0AA00-4BAx  新版 

7 CUA31 6SL3040-0PA00-0AAx  新版 

 

表格 A- 2 自 2007 年 8 月起可订购的硬件组件 

号 硬件组件 订货号 版本 改版 

1 TM54F 6SL3055-0AA00-3BAx  新版 

2 调节型接口模块（书本型） 6SL3100-0BExx-xABx  新版 

3 基本型电源模块（书本型） 6SL3130-1TExx-0AAx  新版 

4 DRIVE-CLiQ 编码器 6FX2001-5xDxx-0AAx  新版 

5 CUA31 
适用于通过 PROFIsafe 和 
TM54 的 Safety 扩展功能 

6SL3040-0PA00-0AA1  新版 

6 CUA32 6SL3040-0PA01-0AAx  新版 

7 SMC30 (宽度 30 mm) 6SL3055-0AA00-5CA2  新版 
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表格 A- 3 自 2008 年 10 月起可订购的硬件组件 

号 硬件组件 订货号 版本 改版 

1 TM31 6SL3055-0AA00-3AA1  新版 

2 TM41 6SL3055-0AA00-3PA1  新版 

3 DME20 6SL3055-0AA00-6ABx  新版 

4 SMC20 (宽度 30 mm) 6SL3055-0AA00-5BA2  新版 

5 调节型接口模块 16kW（书

本型） 
6SL3100-0BE21-6ABx  新版 

6 调节型接口模块 36kW（书

本型） 
6SL3100-0BE23-6ABx  新版 

7 紧凑型非调节型电源模块

（书本型） 
6SL3430-6TE21-6AAx  新版 

8 紧凑型电机模块（书本型） 6SL3420-1TE13-0AAx 
6SL3420-1TE15-0AAx 
6SL3420-1TE21-0AAx 
6SL3420-1TE21-8AAx 
6SL3420-2TE11-0AAx 
6SL3420-2TE13-0AAx 
6SL3420-2TE15-0AAx 

 新版 

9 液冷式功率模块（块型） 6SL3215-1SE23-0AAx 
6SL3215-1SE26-0AAx 
6SL3215-1SE27-5UAx 
6SL3215-1SE31-0UAx 
6SL3215-1SE31-1UAx 
6SL3215-1SE31-8UAx 

 新版 

10 用于 50 mm 组件的加固直

流母线排 
6SL3162-2DB00-0AAx  新版 

11 用于 100 mm 组件的加固直

流母线排 
6SL3162-2DD00-0AAx  新版 
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表格 A- 4 自 2009 年 11 月起可订购的硬件组件 

号 硬件组件 订货号 版本 改版 

1 控制单元 320-2DP 6SL3040-1MA00-0AA1 4.3 新版 

2 TM120 6SL3055-0AA00-3KA0 4.3 新版 

3 SMC10 (宽度 30 mm) 6SL3055-0AA00-5AA3 4.3 新版 

 

表格 A- 5 自 2011 年 1 月起可订购的硬件组件 

号 硬件组件 订货号 版本 改版 

1 控制单元 320-2PN 6SL3040-1MA01-0AA1 4.4 新版 

2 紧凑书本型制动模块 6SL3100-1AE23-5AA0 4.4 新版 

3 书本型 SLM，55kW 6TE25-5AAx 4.4 新版 

4 TM120，检测最多四个电机

温度传感器 
6SL3055-0AA00-3KAx 4.4 新版 

 

表格 A- 6 自 2011 年 4 月起可订购的硬件组件 

号 硬件组件 订货号 版本 改版 

1 S120 Combi 
3 轴型功率模块 

6SL3111-3VE21-6FA0 
6SL3111-3VE21-6EA0 
6SL3111-3VE22-0HA0 

4.4 新版 

2 S120 Combi 
4 轴型功率模块 

6SL3111-4VE21-6FA0 
6SL3111-4VE21-6EA0 
6SL3111-4VE22-0HA0 

4.4 新版 

3 S120 Combi  
单轴电机模块 

6SL3420-1TE13-0AA0 
6SL3420-1TE15-0AA0 
6SL3420-1TE21-0AA0 
6SL3420-1TE21-8AA0 

4.4 新版 

4 S120 Combi  
双轴电机模块 

6SL3420-2TE11-7AA0 
6SL3420-2TE13-0AA0 
6SL3420-2TE15-0AA0 

4.4 新版 

5 书本型制动模块 6SL3100-1AE31-0AB0 4.4 新版 
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表格 A- 7 自 2012 年 1 月起可订购的硬件组件 

号 硬件组件 订货号 版本 改版 

1 TM150，检测最多 12 个电

机温度传感器 
6SL3055- 0AA0-3LA0 4.5 新版 

2 CU310-2 PN 6SL3040-1LA00-0AA0 4.5 新版 

3 CU310-2 DP 6SL3040-1LA01-0AA0 4.5 新版 

 

表格 A- 8 自 2012 年第 4 季度起可订购的硬件组件 

号 硬件组件 订货号 版本 改版 

1 适配器模块 600 6SL3555-2BC10-0AA0 4.5 新版 

2 SINAMICS S120M 6SL3532-6DF71-0Rxx 
6SL3540-6DF71-0Rxx 
6SL3542-6DF71-0Rxx 
6SL3562-6DF71-0Rxx 
6SL3563-6DF71-0Rxx 

4.5 新版 

 

表格 A- 9 自 2013 年 1 月起可订购的硬件组件 

号 硬件组件 订货号 版本 改版 

1 书本型 3 倍过载至 18 A 6SL312x-xxxxx-xxx4 

50 mm 的电机模块和：  

3 A, 5 A, 9 A, 18 A, 2x3 A, 2x5 A, 
2x9 A 

4.6 新版 
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A.2 可用的软件功能 

表格 A- 10 固件版本 4.3 中的新功能 

号 软件功能 伺服 矢量 硬件组件 

1 支持 1FN6 电机系列 x - - 

-2 支持带星形/三角形转换功能的 DRIVE-CLIQ 电机 x - - 

3 通过编码器接口在每转有多个零脉冲的情况下回参考点 x - - 

4 对永磁同步电机的无编码器闭环控制可持续至转速为零 - x - 

5 “SINAMICS Link”：多个 SINAMICS S120 之间的直接通讯 x x - 

6 Safety Integrated： 

• SI 基本功能由 PROFIsafe 控制 

• 无编码器的 SLS，用于异步电机 

• 无编码器的 SBR，用于异步电机 

• SBR 的独立阈值参数： 
此前使用的是 SSM 的参数 p9546 

x x - 

7 驱动对象编码器： 

仅可通过驱动对象编码器直接读入编码器，之后由 
SIMOTION 通过外部编码器的 TO 进行检测。 

- x - 

8 支持新组件 

• CU320-2 

• TM120 

x x - 

9 Profisafe 的 GSDML 文件扩展 x x - 

10 接口 X140 上的 USS 协议 x x - 

11 允许将 V/f 诊断（p1317）作为常规运行方式 x - - 

12 以设定值为基准的负载率显示，取代此前以实际值为基准的

显示方式 
x x - 

13 从第 4 个轴（伺服/矢量）或第 7 个 V/f 轴开始要求性能许

可，此前是从负载率超过 50% 起开始要求 
x x - 
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号 软件功能 伺服 矢量 硬件组件 

14 编码器监控扩展，第 2 部分： 

• 公差带脉冲数量监控 

• 对方波编码器可进行脉冲沿检测转换 

• 脉冲编码器信号检测时设置零转速测量时间 

• 方波编码器实际值采集时的测量步骤切换 

• 编码器监控“LED-Check” 

x x - 

 

表格 A- 11 固件版本 4.4 中的新功能 

号 软件功能 伺服 矢量 硬件组件 

1 Safety Integrated 功能  

• SDI（Safe Direction），适用于带/无编码器的异步电机，

以及带编码器的同步电机 

• 无编码器安全集成功能的边界条件（异步电机）：仅适用

于书本型和模块型设备。 不适用于装机装柜型设备 

x x - 

2 通讯 

• 可通过参数写入 PROFINET 地址（例如用于在离线模式

中创建完整项目） 

• 用于 SINAMICS S 的 PROFINET 模块的共享设备： 
CU320-2 PN, CU310-2 PN 

x x - 

3 紧急回退（ESR，扩展停止和退回） x x - 

4 TM41： 脉冲编码器仿真时向下取整（传动系数；作为编码

器以及旋转变压器） 
x x - 

5 伺服控制和等时同步运行中更多可用的脉冲频率（3.2 / 5.33 / 
6.4 kHz） 

x - - 

6 装机装柜型：电流控制器（125 µs）在伺服控制中实现更高

转速（输出频率可达约 700 Hz） 
x - - 

7 故障信息的广播 x x - 
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表格 A- 12 固件版本 4.5 中的新功能 

号 软件功能 伺服 矢量 硬件组件 

1 支持新组件 CU310-2 x x 参见附录 A1 

2 支持新组件 TM150 x x - 

3 支持新组件 S120M x - - 

4 支持脉冲频率达 32 kHz 的高频主轴（电流控制器周期 31.25 
µs） 

x - - 

5 PROFINET： 支持 PROFIenergy 协议 x x - 

6 PROFINET： 改善共享设备可用性 x x - 

7 PROFINET： 最小可调节发送周期 250 µs x x - 

8 PROFINET： 带有 CU310-2 PN、CU320-2 PN 和 CU320-2
（配备 CBE20）的无脉冲介质冗余度 

x x - 

9 通过 CBE20 的以太网/IP 通讯扩展 x x - 

10 SINAMICS Link: 最小可调节发送周期 0.5 ms x x - 

11 无需上电即可设置 SINAMICS Link 连接 x x - 

12 写保护 x x - 

13 专有技术保护 x x - 

14 PEM 无编码器运行至 n = 0 rpm x x - 

15 独立于电流控制器周期的脉冲频率 
只适用于装机装柜型结构类型的功率部件 

- x - 

16 收发方向供电过程数据数量扩展至 10 个字 x x - 

Safety Integrated 功能 

17 通过端子和 PROFIsafe 的 CU310-2 安全功能 x x - 

18 速度限制和不带 PROFIsafe 或 TM54F 安全旋转方向的永久

激活 
x x - 

19 安全限制位置 (SLP) x x - 

20 通过 PROFIsafe 的安全限制位置的传输 x x - 

21 可调节的 SLS 限制 x x - 

22 新 PROFIsafe 报文 31、901、902 x x - 
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表格 A- 13 固件版本 4.6 中的新功能 

号 软件功能 伺服 矢量 硬件组件 

1 SINAMICS 集成网络服务器 

通过 Ethernet 将项目和固件下载到存储卡上 

通过网络服务器更新固件时的掉电安全性 

x x - 

2 更换部件具有专有技术保护：加密加载至文件系统 x x - 

3 调节型电源控制（装机装柜型）的可设带阻滤波器 x x - 

4 电流设定值滤波器 x - - 

5 简化的旋转测量 - x - 

6 在存储卡上备份冗余数据 x x - 

7 多次跟踪 x x - 

8 调整制动控制 x x - 

9 快速捕捉重启 - x - 

10 PROFIBUS 诊断报警 x x - 

11 DCC SINAMICS： 
SINAMICS DCB Studio 中所建 DCB 库支持 

x x - 

12 SMC40 (EnDat 2.2) x x - 

13 CANopen 扩展 x x - 

Safety Integrated 功能 

14 带 2 个 TTL/HTL 编码器的 Safety Integrated 扩展功能 x x - 

15 Safety：Safe Brake Test x x - 

16 Safety Info Channel x x - 
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A.3 缩略语目录 
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索引 

  

Ｂ 

BOP20 
驱动控制字, 237 
重要功能, 227, 238 

Ｄ 

DDS 
驱动数据组, 304 

DRIVE-CLiQ 
布线规则, 25 
诊断, 25 
检查连接, 25 

DRIVE-CLiQ 编码器, 150 

Ｅ 

EDS 
编码器数据组, 304 

EPOS 
绝对值编码器校准, 215 

Ｋ 

KTY 84, 160 

Ｌ 

LED 
16 kW 以上的非调节型电源模块, 258 
DRIVE-CLiQ 集线器模块 DMC20, 276 
书本型制动模块, 260 

功率模块, 268, 269 
电压监控模块 VSM10, 275 
电机模块, 259, 267 
机柜安装式编码器模块 SMC10, 270 
机柜安装式编码器模块 SMC20, 270 
机柜安装式编码器模块 SMC30, 271 
机柜式编码器模块 SMC40, 272 
非调节型电源模块, 265, 266 
非调节型电源模块 5 kW 和 10 kW, 257 
紧凑书本型电机模块, 262 
紧凑型非调节电源模块, 261 
调节型电源模块, 255, 263 
通讯板 CBC10, 272 
通讯板 CBE20, 273 
基本型电源模块, 256, 264, 265 
控制电源模块上, 270 
控制单元 CU310-2 DP, 249 
控制单元 CU320-2 DP, 244 
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